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Safety Guidelines

This manual contains notices you have to observe in order to ensure your personal safety, as well as to prevent
damage to property. The notices referring to your personal safety are highlighted in the manual by a safety alert
symbol, notices referring only to property damage have no safety alert symbol. These notices shown below are
graded according to the degree of danger.

| AADANGER

indicates that death or severe personal injury will result if proper precautions are not taken.

AAWARNING
indicates that death or severe personal injury may result if proper precautions are not taken.

A\CAUTION
with a safety alert symbol, indicates that minor personal injury can result if proper precautions are not taken.

CAUTION
without a safety alert symbol, indicates that property damage can result if proper precautions are not taken.

NOTICE

indicates that an unintended result or situation can occur if the corresponding information is not taken into
account.

If more than one degree of danger is present, the warning notice representing the highest degree of danger will
be used. A notice warning of injury to persons with a safety alert symbol may also include a warning relating to
property damage.

Qualified Personnel

The device/system may only be set up and used in conjunction with this documentation. Commissioning and
operation of a device/system may only be performed by qualified personnel. Within the context of the safety notes
in this documentation qualified persons are defined as persons who are authorized to commission, ground and
label devices, systems and circuits in accordance with established safety practices and standards.

Prescribed Usage

Trademarks

Note the following:

AAWARNING

This device may only be used for the applications described in the catalog or the technical description and only
in connection with devices or components from other manufacturers which have been approved or
recommended by Siemens. Correct, reliable operation of the product requires proper transport, storage,
positioning and assembly as well as careful operation and maintenance.

All names identified by ® are registered trademarks of the Siemens AG. The remaining trademarks in this
publication may be trademarks whose use by third parties for their own purposes could violate the rights of the
owner.

Disclaimer of Liability

We have reviewed the contents of this publication to ensure consistency with the hardware and software
described. Since variance cannot be precluded entirely, we cannot guarantee full consistency. However, the
information in this publication is reviewed regularly and any necessary corrections are included in subsequent
editions.

Siemens AG Order Number: 6AV6 691-1DR01-0AB0O Copyright © Siemens AG 2007.
Automation and Drives ® 09/2007 Technical data subject to change
Postfach 48 48

90437 NURNBERG

GERMANY
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Purpose of the operating instructions

These operating instructions provide information based on the requirements defined by DIN
8418 for mechanical engineering documentation. This information relates to the place of use,
transport, storage, mounting, use and maintenance.

These operating instructions are intended for:

e Users

® Commissioning engineers

® Service technicians

® Maintenance technicians

Please read the section "Safety instructions and general notes" carefully.

The help integrated in WinCC flexible, the WinCC flexible Information System, contains
detailed information. The information system contains instructions, examples and reference
information in electronic form.

Basic knowledge required

General knowledge of automation technology and process communication is needed to
understand the operating instructions.

It is also assumed that those using the manual have experience in using personal computers
and knowledge of Microsoft operating systems.

Scope of the operating instructions

The operating instructions apply to the HMI device MP 377 in conjunction with the software
package WinCC flexible.

Position in the information landscape

These operating instructions form part of the SIMATIC HMI documentation. The following
information provides you with an overview of the SIMATIC HMI information landscape.

User manuals
® WinCC flexible Micro

Describes basic principles of configuration using the WinCC flexible Micro Engineering
System.

® WinCC flexible Compact/ Standard/ Advanced

Describes basic principles of configuration using the WinCC flexible Compact
Engineering System/WinCC flexible Standard/WinCC flexible Advanced.
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WinCC flexible Runtime
Describes how to commission and operate your runtime project on a PC.
WinCC flexible Migration

Describes how to convert an existing ProTool project to WinCC flexible.

— Describes how to convert an existing WinCC project to WinCC flexible.

— Describes how to convert an existing ProTool project including a change of the HMI
device, for example from OP3 to OP 73 or from OP7 to OP 77B

— Describes how to convert an existing ProTool project including a change from a
graphics device to a Windows CE device.

Communication
— Communication Part 1 describes the connection of the HMI device to SIMATIC PLCs.

— Communication Part 2 describes the connection of the HMI device to third-party PLCs.

Operating instructions

Operating instructions for SIMATIC HMI devices
- OP73,0P77A,OP 77B

— TP 170micro, TP 170A, TP 170B, OP 170B
— OP 73micro, TP 177micro

- TP 177A, TP 177B, OP 177B

- TP 270, OP 270

- TP 277,0P 277

- MP270B

- MP 277

- MP 370

- MP 377

Operating instructions for mobile SIMATIC HMI devices
— Mobile Panel 177

— Mobile Panel 277

— Mobile Panel 277 IWLAN

— Mobile Panel 277F IWLAN

Operating instructions (compact) for SIMATIC HMI devices
- OP77B

— Mobile Panel 177

— Mobile Panel 277

Operating instructions for SIMATIC accessories
— Industrial USB Hub 4
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Getting Started
® WinCC flexible for first time users

Based on an example project, this is a step-by-step introduction to the basics of
configuring screens, alarms, recipes and screen navigation.

® WinCC flexible for power users

Based on an example project, this is a step-by-step introduction to the basics of
configuring logs, project reports, scripts, user management, multilingual projects and
integration in STEP 7.

® WinCC flexible options

Based on an example project, this is a step-by-step introduction to the basics of
configuring the WinCC flexible Sm@rtServices, Sm@rtAccess and OPC server options.

Online availability

Technical documentation on SIMATIC products and SIMATIC systems is available in PDF
format in various languages at the following addresses:

® SIMATIC Guide Technical Documentation in German:
"http://www.ad.siemens.de/simatic/portal/html_00/techdoku.htm"

e SIMATIC Guide for Technical Documentation in English:
"http://www.ad.siemens.de/simatic/portal/html_76/techdoku.htm"

Figures

The HMI device is sometimes shown as a photo in these operating instructions. The photos
used may contain slight variations from the condition in which the HMI device is supplied.

Conventions
Configuration and runtime software differ with regard to their names as follows:
® "WinCC flexible 2007" for example, refers to the configuration software.

The term "WinCC flexible" is used in a general context. The full name, for example
"WinCC flexible 2007", is always used when it is necessary to differentiate between
different versions of the configuration software.

o "WinCC flexible Runtime" refers to the runtime software that can run on HMI devices.

The following text notation will facilitate reading these operating instructions:

Notation Scope

"Add screen" e Terminology that appears in the user interface, for example
dialog names, tabs, buttons, menu entries

e Inputs required, for example limit values, tag values
e Path information

"File > Edit" Operational sequences, for example, menu commands, context
menu commands
<F1>, <Alt+P> Keyboard operation

MP 377 (WIinCC flexible)
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Please observe notes labeled as follows:

Note

Notes contain important information concerning the product, its use or a specific section of
the documentation to which you should pay particular attention.

Registered trademarks

Names labeled with a ® symbol are Registered trademarks of the Siemens AG. Other
names used in this documentation may be trademarks, the use of which by third parties for
their own purposes could violate the rights of the owner.

e HMI®

e SIMATIC®

e SIMATIC HMI®

e SIMATIC ProTool®

e SIMATIC WinCC®

e SIMATIC WinCC flexible®
e SIMATIC MP 377©

Representatives and offices

Training center

If you have further questions relating to the products described in this manual,
please contact your partner at your local Siemens office.

Find your contact partner at:

"http://www.siemens.com/automation/partner"

A guide to the technical documentation for the various SIMATIC products is available at:
"http://www.siemens.com/simatic-tech-doku-portal"

The online catalog and the online ordering system is available at:

"http://mall.automation.siemens.com"

To familiarize you with automation systems, we offer a variety of courses. Please contact
your regional training center, or our central training center in 90327 Nuremberg, Germany,
for details.

Phone: +49 (0)911 895-3200

Internet: "http://www.sitrain.com"
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Technical support

You can reach technical support for all A&D products at:

Support request form

"http://www.siemens.com/automation/support-request"”

on the web:

Phone: + 49 (0)180 5050 222
Fax: + 49 (0)180 5050 223

You will find more information on our technical support on the Internet at:

"http://www.siemens.com/automation/service"

Service & Support on the Internet

In addition to the printed manuals, we offer electronic documentation of all products. This
can be accessed online from:

"http://www.siemens.com/automation/service&support"

There you will find:

e Newsletter containing the latest information on Siemens products.

® The documents you need via our Search function in "Service & Support".
e A forum for the global exchange of information by users and specialists.
® You local Automation & Drives representative.

® Information about on-site services, repairs and spare parts.

® More information under the "Services" heading.

Recycling and disposal

Due to the low levels of pollutants in the HMI devices described in these Operating

Instructions, they can be recycled. For environment-friendly recycling and disposal of your

old equipment, contact a certified disposal facility for electronic scrap.
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Overview 1

1.1 Product overview

The Multi Panel MP 377 is an innovative further development of the 370 series.

Alongside the familiar 12" and 15" display sizes, a Multi Panel with 19" touch screen has also
been added to the range. The distinguishing feature of the HMI devices is that they satisfy
the ever increasing demands for technical innovations — especially as far as the display,
performance and extended applications are concerned.

The new Multi Panel MP 377 has a TFT display with 64 k colors and enhanced performance
levels over the previous devices. The new Multi Panel MP 377 is based on Microsoft
Windows CE 5.0. Compared with previous devices, its multimedia functionality has been
greatly extended. Integration of the Microsoft Media Player allows the MP 377 to play videos.
Internet Explorer 6.0 for pocket PCs is pre-installed on the HMI devices and extends the
ways in which web pages can be displayed. Word documents, Excel spreadsheets and PDF
documents can be displayed with Microsoft Viewer.

The user memory has been extended and a remanent maintenance-free message buffer
integrated. A remanent memory area for PLC data is provided to support WinAC MP 2007.

Thanks to the wide range of devices, you get to use the device that is suited to you. The
MP 377 offers a variety of application uses, high performance and a favorable
cost/performance ratio.

The HMI device has:

1 PROFIBUS interface

2 Ethernet ports for connection to PROFINET

2 USB 2.0 ports

1 slot for an SD memory card or multimedia card
1 CF card slot

1 TFT display with up to 64 k colors

The following extra software options have been added to the functions of the MP 377 as a
"multifunctional platform™:

e WinCC flexible/Sm@rtService
e WinCC flexible/Sm@rtAccess
® WinCC flexible/OPC server

o WinCC flexible/ProAgent

o WinCC flexible/Audit

e WinAC MP 2007

MP 377 (WIinCC flexible)
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Overview

1.2 Design of the MP 377 12" Touch HMI device

1.2 Design of the MP 377 12" Touch HMI device

Front view and side view

SIEMENS

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display/touch screen

Oblong holes for mounting clamps

Mounting seal

®©® e 0 0

Bottom view

0] Ports
® Oblong holes for mounting clamps

MP 377 (WinCC flexible)
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Overview
1.2 Design of the MP 377 12" Touch HM/ device

Rear view
©) Slot for an SD memory card or multimedia card
® Rating label
® Slot for a CF memory card
@ DIP switch
® Interface name
See also
Ports (Page 51)
MP 377 (WinCC flexible)
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Overview
1.3 Design of the MP 377 12" Key HM/ device

1.3 Design of the MP 377 12" Key HMI device

Front view and side view

1

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display

Oblong holes for a mounting clamp

Mounting seal

CECHCONCNC

Bottom view

©) Ports
® Oblong holes for a mounting clamp

MP 377 (WinCC flexible)
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Overview
1.3 Design of the MP 377 12" Key HM/ device

Rear view
0] Slot for an SD memory card or multimedia card
® Rating label
® Slot for a CF memory card
® DIP switch
® Interface name
See also
Ports (Page 51)
MP 377 (WinCC flexible)
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Overview

1.4 Design of the MP 377 15" Touch HMI device

1.4 Design of the MP 377 15" Touch HMI device

Front view and side view

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display/touch screen

Oblong holes for mounting clamps

Mounting seal

®©® e 0 0

Bottom view

©) Ports
@ Oblong holes for mounting clamps
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Overview
1.4 Design of the MP 377 15" Touch HM/ device

Rear view

_ ‘.‘
0003333322 EELECRO

Slot for an SD memory card or multimedia card
Rating label

Slot for a CF memory card
DIP switch
Interface name

CECHCONCNC

See also
Ports (Page 51)

MP 377 (WIinCC flexible)
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Overview

1.5 Design of the MP 377 19" Touch HMI device

1.5 Design of the MP 377 19" Touch HMI device

Front view and side view

Slot for an SD memory card or multimedia card
Slot for a CF memory card

Display/touch screen

Oblong holes for mounting clamps

CECHCONCNC

Mounting seal

Bottom view

0] Ports
® Oblong holes for mounting clamps
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Overview

1.5 Design of the MP 377 19" Touch HM/ device

Rear view
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) Slot for an SD memory card or multimedia card
® Rating label
® Slot for a CF memory card
@ DIP switch
® Interface name
See also
Ports
MP 377 (WinCC flexible)
Operating Instructions, 09/2007, 6AV6 691-1DR01- -
Everything for your HMI running

n?es@wcpas com
E‘! +86-15876525394

T
il

23



Overview

1.6 Supplementary pack and other accessories

1.6 Supplementary pack and other accessories

Accessory kit
The accessory kit contains the following:
® 1 terminal block for the power supply
® Mounting clamps for mounting the MP 377

Additional documents may be enclosed with the accessory kit.

RS 422-RS 232 converter

The converter is required for the connection of controllers of other manufacturers. Connect
the RS 422-RS 232 converter to the RS 422/RS 485 port. The converter converts the input
signals to RS-232 signals.

The converter is not part of the scope of delivery of the HMI device. The converter can be
ordered separately using order number 6AV6 671-8XE00-0AXO0.

90° elbow adapter
If space is limited, you can use an elbow adapter at the RS 422/RS 485 interface.

The adapter is not part of the scope of delivery of the HMI device. The adapter can be
ordered using order number 6AV6 671-8XD00-0XA0.

Protective foil

Protective foil is available for HMI devices with a touch screen. The protective foil is not part
of the scope of delivery of the HMI device.

The cover foil can be ordered using the following order numbers:

® For the MP 377 12" Touch, using order number 6AV6 574-1AD00-4CX0
® Forthe MP 377 15" Touch, using order number 6AV6 574-1AD00-4EXO
® Forthe MP 377 19" Touch, using order number 6AV7 672-1CE00-0AAQ

Memory card

Only use SD memory cards, CF memory cards or MultiMediaCards tested and approved by
Siemens AG.

SIMATIC PC USB FlashDrive

The SIMATIC PC USB FlashDrive is a mobile form of data storage with a high data
throughput, designed for industrial use.

You can find more information on the Internet at: "http://mall.automation.siemens.com"

MP 377 (WIinCC flexible)
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1.7 The HMI device in the operating process

1.7 The HMI device in the operating process

The HMI device is part of the operating process. The following two phases are key to the
way the HMI device is integrated in the operating process:

® Project design

® Process management

Project design
Visualization of the operating process is known as project design. Project design comprises:
® writing project data
® saving project data
® testing project data
® simulating project data

Project design is undertaken independently of the HMI device and results in a project. Once
this has been generated, the project can be transferred to the HMI device to control the
operating process.

:>

Configuring PC HMI device

Process management

Process management is marked by two-way communication between HMI device and
controller. This lays the foundations for operator control and monitoring.

m Control 1
Control 2
HMI device

The operator can intervene in the operating process on the HMI device for control purposes.
The controller in turn supplies the results of the operating process which are displayed on
the HMI device.

MP 377 (WIinCC flexible)
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1.8 Functional scope with WinCC flexible

1.8 Functional scope with WinCC flexible

The following tables show the objects that can be integrated in a project for an MP 377.

Note

The specified values are maximum values of the individual objects. Simultaneous use of
multiple objects with their maximum value can lead to problems in the active project.

Alarms

Object Specification MP 377

Alarms Number of discrete alarms 4,000
Number of analog alarms 200
Length of the alarm text 80 characters
Number of tags in an alarm Max. 8
LEDs Alarm line, Alarm

window, Alarm view

Acknowledge error alarm individually Yes
Acknowledge multiple error alarms 16 alarm groups
simultaneously (group acknowledgement)
Edit alarm Yes
Alarm indicator Yes

ALARM_S Display S7 alarms Yes

Alarm buffer, retentive Alarm buffer capacity 1,024 alarms
Simultaneously queued alarm events Max. 500
View alarm Yes
Delete alarm buffer Yes
Print alarms line by line Yes

Tags, values and lists

Object Specification MP 377

Tags Number 2,048

Limit value monitoring Input/Output Yes

Linear scaling Input/Output Yes

Text lists Number 500 "

Graphics lists Number 500 "

R The maximum total of text and graphics lists is 500.

MP 377 (WinCC flexible)
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1.8 Functional scope with WinCC flexible

Screens
Object Specification MP 377
Screens Number 500
Fields per screen 200
Tags per screen 400
Complex objects per screen (e.g. bars) 20
Template Yes
Recipes
Object Specification MP 377
Recipes Number 500
Data records per recipe 1,000
Entries per recipe 1,000
Recipe memory 128 KB
Memory location? e Memory card
e USB memory stick
e Network drive
R The number of recipe data records might be restricted by the capacity of the storage medium.
Logs
Note
The HMI devices are suitable for the logging of relatively small volumes of data.
Manage the data in several adjacent archives in a segmented circular log. The use of a large
circular log has a negative effect on performance.
Object Specification MP 377
Logs Number of logs 50
Number of partial logs in a segmented 400
circular log
Entries per log 10,000
Filing format CSV with ANSI character set
Memory location" e Memory card
e USB memory stick
o Network drive
n The number of entries in the log may be restricted by the capacity of the storage medium.
MP 377 (WinCC flexible)
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1.8 Functional scope with WinCC flexible

Safety
Object Specification MP 377
User view Number of user groups 50
Number of users 50
Number of authorizations 32
Infotexts
Object Specification MP 377
Infotexts Length (no. of characters) 320
(depending on font)
For alarms Yes
For screens Yes
For screen objects (for example for 1/O field, Yes
switch, button, invisible button)
Additional functions
Object Specification MP 377
Screen settings Calibrating the touch screen " Yes
Brightness setting Yes
Language change Number of languages 16
VBScript User-specific extension of the functionality Yes
Number of scripts 100
Graphic objects Vector and pixel graphics Yes
Trends Number 400
Task planner Number of tasks 48
Text objects Number 30,000
Direct keys PROFIBUS DP direct keys Yes
PROFINET IO direct keys Yes
g Only MP 377 Touch
MP 377 (WinCC flexible)
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1.9 Software options

1.9 Software options

The following software options are available for the MP 377:

MP 377 (WIinCC flexible)

WinCC flexible /Sm@rtService

The WiInCC flexible /Sm@rtService option enables you to access a remote HMI device or
PC via Ethernet.

WinCC flexible /Sm@rtAccess

The WinCC flexible /Sm@rtAccess option enables you to set up communication between
different HMI systems.

WinCC flexible /Audit

The WinCC flexible /Audit option extends the HMI device to include functions for
recording operations in an audit trail and electronic signature.

WinCC flexible /OPC-Server (OPC XML)

The WinCC flexible /OPC-Server option enables you to create communications to OPC-
capable applications from an HMI device or PC via Ethernet.

WinAC MP 2007
WInAC MP 2007 is PLC software capable of running on the MP 377.
WinCC flexible /ProAgent

The WinCC flexible /ProAgent option enables you to extend the HMI device to include
specific and high-speed process fault diagnostics.

Uninterruptible Power Supply (UPS) with USB support

When interfacing an uninterruptible power supply, the HMI device is shut down in a
controlled manner after a buffer time in the event of a power failure. The MP 377 supports
SITOP DC UPS modules connected via the USB port.

Microsoft Excel Viewer

Microsoft Excel Viewer enables you to view Excel documents.
Microsoft PDF Viewer

Microsoft PDF Viewer enables you to view PDF documents.
Microsoft Word Viewer

Microsoft Word Viewer enables you to view Word documents.
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1. 10 Communication

1.10 Communication

Number of connections
Connection MP 377
Number using a bus connection 6
Number of connections based on "SIMATIC HMI HTTP Protocol" 8

NOTICE

Communication faults with PROFINET 10

When you release PROFINET 10 in the HMI device's control panel, communication faults
may arise in the following cases:

e Use of PLCs from other manufacturers
e Use of SIMATIC 500/505 via NITP

Do not release PROFINET IO in the HMI device's control panel in the cases given.

PLCs

The following table shows the PLCs which can be used with the HMI devices and the
protocols or profiles which can be used.

PLC

Protocol

MP 377

SIMATIC S7

« PPI
e MPI "

+ PROFIBUS DP
+ PROFINET

Yes

SIMATIC S5

e PROFIBUS DP

Yes

SIMATIC 500/505

e NITP
e PROFIBUS DP

Yes

SIMATIC HMI HTTP Protocol

e HTTP/HTTPS (Ethernet)

Yes

Allen-Bradley

PLC series SLC500, SLC501, SLC502, SLC503,
SLC504, SLC505, MicroLogix and PLC5/11,
PLC5/20, PLC5/30, PLC5/40, PLC5/60, PLC5/80

e DF12956

e DH+ via KF2 module 3% 6)

e DH485 via KF3 module 4 5 8
e DH4854)6)

Yes

ControlLogix and CompactLogix PLC series
o Ethernet/IP

Yes

GE Fanuc Automation

PLC series 90-30, 90-70, VersaMax Micro
e SNP9

Yes

LG Industrial Systems
(Lucky Goldstar)/IMO

PLC series GLOFA GM (GM4, GM6 and GM7),
Series G4, G6 and G7

e Dedicated communication ©)

Yes

MP 377 (WIinCC flexible)
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1. 10 Communication

PLC Protocol MP 377
Mitsubishi Electric PLC series MELSEC FX and MELSEC FXO0 Yes

e FXO8

PLC series MELSEC FX0, FX1n, FX2n, AnA, Yes

AnN, AnS, AnU, QnA and QnAS
e Protocol 49

Modicon PLC series Modicon 984, TSX Quantum and Yes
(Schneider Automation) TSX Compact
e Modbus RTU9®)
PLC series Quantum, Momentum, Premium and Yes
Micro

PLC series Compact and 984 via Ethernet bridge
e Modbus TCP/IP (Ethernet)

OMRON PLC series SYSMAC C, SYSMAC CV, Yes
SYSMAC CS1, SYSMAC alpha and CP
e Hostlink/Multilink (SYSMAC Way)®

Telemecanique PLC series TSX 7 with P47 411, TSX 7 with Yes
P47/67/87/107 420, TSX 7 with P47/67/87/107
425, module TSX SCM 21.6 with the specified

TSX 7 CPUs, TSX 17 with module SCG 1161,
TSX 37 (Micro) and TSX 57 (Premium)

e Hostlink/Multilink (SYSMAC Way)®

g Not possible when connected to S7-212.

2) Applies to controllers SLC503, SLC504, SLC505, PLC5, MicroLogix.
3) Applies to controllers SLC504, PLC5 over DF1.

4) Applies to controllers SLC500 to SLC 505 and MicroLogix.

5) Only with converter RS 422-RS 232 6AV6 671-8XE00-0AX0 (option).
6) PROFINET IO must be locked.

MP 377 (WIinCC flexible)
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1. 10 Communication
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Safety instructions and approvals

2.1 Safety instructions

Working on the control cabinet

A warRnNG

Open equipment

The HMI device is an open equipment. This means that the HMI device may only be
mounted in housings or cabinets, whereby the device can be operated from the front panel.

Access to the housing or cabinet in which the HMI device is installed should only be
possible by means of a key or tool and only for trained and authorized personnel.

Dangerous voltage
Opening the cabinet will expose high voltage parts. Contact with these parts could be fatal.

Switch off the power supply to the cabinet before opening it.

Hazardous areas

When operating the HMI device in hazardous areas the following warning applies.

AWARN ING

Explosion Hazard

Do not disconnect while circuit is live unless area is known to be non-hazardous.
Substitution of components may impair suitability for Class |, Division 2 or Zone 2.

High frequency radiation

NOTICE

Unintentional operating situations

High-frequency radiation, for example from cellular phones, can lead to undesirable
operating situations.

Proper use

AWARN ING

Commissioning of the HMI device is forbidden until it has been absolutely ensured that the
machine in which the HMI device is to be installed complies with Directive 98/37/EC.

MP 377 (WIinCC flexible)
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Safety instructions and approvals

2.2 Standards, certificates and approvals

2.2 Standards, certificates and approvals

Certifications

CE approval

UL approval

34

A\ caution

The following overview shows possible approvals.

The HMI device itself is certified as shown on the rear panel labels.

C€

The HMI device meets the general and safety-related requirements of the following EC
directives and conforms to the harmonized European standards (EN) for programmable logic
controllers published in the official gazettes of the European Union:

e 89/336/EEC Electromagnetic Compatibility Directive (EMC Directive)

e 98/37/EG Directive of the European Parliament and Council of 22 June 1998 on the
approximation of the laws and administrative regulations of the Member States
concerning machinery

EC Declaration of Conformity

The EC Declarations of Conformity are available to the relevant authorities at the following
address:

Siemens Aktiengesellschaft
Automation & Drives

A&D AS RD ST PLC

PO Box 1963

D-92209 Amberg, Germany

@)

Underwriters Laboratories Inc., to
e UL 508 (Industrial Control Equipment)
® (CSA C22.2 No. 142 (Process Control Equipment)

or

MP 377 (WIinCC flexible)
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Safety instructions and approvals
2.2 Standards, certificates and approvals

@

HAZ. LOC.

Underwriters Laboratories Inc., to

e UL 508 (Industrial Control Equipment)

® (CSA C22.2 No. 142 (Process Control Equipment)
e UL 1604 (Hazardous Location)

® (CSA-213 (Hazardous Location)

Approved for use in

® (Class |, Division 2, Group A, B, C, D or

® (Class I, Zone 2, Group IIC or

® non-hazardous locations

FM Approval

APPROVED

Factory Mutual Research (FM) conforming to

® Approval Standard Class Number 3611, 3600, 3810
Approved for use in

e C(Class I, Division 2, Group A, B, C,D T4

® (Class |, Zone 2, Group IIC T4

Marking for Australia

0 N11/

The HMI device fulfills the requirements of standard AS/NZS 2064 (Class A).

IEC 61131

The HMI device satisfies the requirements and criteria conforming to IEC 61131-2,
Programmable Controllers, Part 2: Equipment requirements and tests.

MP 377 (WIinCC flexible)
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Safety instructions and approvals

2.3 Nofes about usage

2.3 Notes about usage

Use in industry

Residential use

The HMI device is designed for industrial use. For this reason, the following standards are
met:

® Requirements for emissions EN 61000-6-4: 2001
® Requirements for interference immunity EN 61000-6-2: 2001

If the HMI device is used in a residential area, you must take measures to achieve Limit
Class B conforming to EN 55011 for RF interference.

Suitable measures for achieving the required RF interference level for Limit Class B include
for example:

® |nstallation of the HMI device in grounded control cabinets
e Use of filters in electrical supply lines

Individual acceptance is required.

24 Electromagnetic compatibility

Introduction

The HMI device fulfills, among other things, the requirements of the EMC laws pertaining to
the European domestic market.

EMC-compliant installation of the HMI device

The EMC-compliant installation of the HMI device and the application of interference-proof
cable is the basis for interference-free operation. The "Directives for interference-free
installation of PLCs" and the "PROFIBUS Networks" manual also apply for the installation of
the HMI device.

Pulse-shaped interference

36

The following table shows the electromagnetic compatibility of modules with regard to pulse-
shaped interference. The precondition for electromagnetic compatibility is that the HMI
device meets the specifications and guidelines for electrical installation.

Pulse-shaped interference | Test voltage Degree of severity
Electrostatic discharge Air discharge: 8 kV 3
in accordance with Contact discharge: 6 kV
IEC 61000-4-2
MP 377 (WinCC flexible)
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Safety instructions and approvals

2.4 Electromagnetic compatibility

Pulse-shaped interference

Test voltage

Degree of severity

Bursts

(high-speed transient
interference)

in accordance with
IEC 61000-4-4

2 kV power supply cable
2 kV signal cable, > 30 m
1 kV signal cable, <30 m

3

High-power surge pulses in
to S7-300 PLC, Installation,

accordance with IEC 61000-4-5, external protective circuit required (refer
chapter “Lightning and overvoltage protection”).

DC voltage with protective elements

Asymmetrical coupling 2 kV power cable 3
DC voltage with protective elements
2 kV signal/data cable, > 30 m,
with protective elements as required

Symmetrical coupling 1 kV power cable 3

1 KV signal cable, > 30 m,

with protective elements as required

Sinusoidal interference

The following table shows the EMC behavior of the modules with respect to sinusoidal

electrical installation.

interference. This requires the HMI device to meet the specifications and directives for

Sinusoidal interference

Test values

Degree of severity

HF radiation (in
electromagnetic fields)
in accordance with
IEC 61000-4-3

80% amplitude modulation at 1 kHz 3
with 10 V/m in the range of 80 MHz to 1 GHz
with 3 V/m in the range 1.4 GHz to 2 GHz
with 1 V/m the range 2 GHz to 2.7 GHz

10 V/m with 50 % pulse modulation at 900 MHz
10 V/m with 50 % pulse modulation at 1.89 GHz

HF conductance on
cables and cable shields
in accordance with

IEC 61000-4-6

Test voltage 10 V, with 80% amplitude modulation 3
of 1 kHz in the 9 MHz to 80 MHz range

Emission of radio

interference

The following table shows the unwanted emissions from electromagnetic fields in
accordance with EN 55011, Limit Value Class A, Group 1, measured at a distance of 10 m.

From 30 to 230 MHz

<40 dB (V/m) quasi-peak

From 230 to 1000 MHz

<47 dB (V/m) quasi-peak

Additional measures

Before you connect an HMI device to the public network, ensure that it is compliant with Limit
Value Class B in accordance with EN 55022.

MP 377 (WIinCC flexible)
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Safety instructions and approvals

2.5 Transport and storage conditions

2.5

Transport and storage conditions

Mechanical and climatic transport and storage conditions

38

The transport and storage conditions of this HMI device exceed requirements in accordance
with IEC 61131-2. The following specifications apply to the transport and storage of an HMI
device in its original packing.

The climatic conditions comply with the following standards:

e |EC 60721-3-3, Class 3K7 for storage

e |EC 60721-3-2, Class 2K4 for transport

The mechanical conditions are compliant with IEC 60721-3-2, Class 2M2.

Type of condition Permitted range
Drop test (in transport package) <1m
Temperature From -20 °C to +60 °C
Atmospheric pressure From 1080 hPa to 660 hPa,
corresponds to an elevation —1000 to 3500 m
Relative humidity From 10 % to 90 %, without condensation
Sinusoidal vibration in accordance with 5Hz to 9 Hz: 3.5 mm
IEC 60068-2-6 9 Hz to 500 Hz: 9.8 m/s?2
Shock in accordance with IEC 60068-2-29 | 250 m/s2, 6 ms, 1000 shocks

NOTICE

Ensure that no condensation (dewing) develops on or inside the HMI device after
transporting it at low temperatures or after it has been exposed to extreme temperature
fluctuations.

The HMI device must have acquired room temperature before it is put into operation. Do
not expose the HMI device to direct radiation from a heater in order to warm it up. If dewing
has developed, wait approximately 4 hours until the HMI device has dried completely
before switching it on.

Proper transport and storage, installation and assembly as well as careful operation and
maintenance are required to ensure trouble-free and safe operation of the HMI device.

The warranty for the HMI device will be deemed void if these stipulations are not heeded.

MP 377 (WIinCC flexible)
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Planning application

3.1 Installation instructions

Mechanical and climatic conditions of use

The HMI device is designed for use in a location protected from the effects of the weather.
The conditions of use are compliant with requirements to DIN IEC 60721-3-3:

e (Class 3M3 (mechanical requirements)

® (Class 3K3 (climatic requirements)

Use with additional measures

The HMI device should not be used at the following locations unless additional measures are
taken:

® |n locations with a high degree of ionizing radiation

® |n locations with difficult operating conditions - for example due to:
— Corrosive vapors, gases, oils or chemicals
— Electrical or magnetic fields of high intensity

® |n systems that require special monitoring - for example:
— Elevators

— Systems in especially hazardous rooms

Mechanical ambient conditions

The mechanical ambient conditions for the HMI device are specified in the following table in
terms of sinusoidal vibration.

Frequency range in | Constant Occasional

Hz

10<f<58 Amplitude 0.0375 mm Amplitude 0.075 mm

58 <f<150 Constant acceleration 0.5 g Constant acceleration 1 g

Reducing vibrations

If the HMI device is subjected to greater shocks or vibrations, you must take appropriate
measures to reduce acceleration or amplitudes.

We recommend fitting the HMI device to vibration-absorbent material (on metal shock
absorbers, for example).

MP 377 (WIinCC flexible)
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Planning application

3.1 Installation instructions

Testing mechanical ambient conditi

ons

The following table provides information on the type and scope of tests for mechanical

ambient conditions.

Tested for

Test standard

Comments

Vibrations

Vibration test in accordance
with IEC 60068, part 2-6
(sinusoidal)

Type of vibration:

Transitional rate of the frequency:

1 octave/minute.

10 = f < 58,

constant amplitude 0.075 mm

58 <f< 150,

Constant acceleration 1 g

Vibration duration:

10 frequency cycles per axis in each of the three
mutually vertical axes.

Shock

Shock testing in accordance
with IEC 60068, Part 2-27

Type of shock: half-sine

Shock intensity:
Peak value 15 g, duration 11 ms

Direction of impact:
3 shocks in + directions in each of the three
mutually vertical axes

Climatic ambient conditions

The following table shows the climatic environmental conditions under which the HMI device

can be operated.

Ambient conditions

Permitted range

Comments

Temperature
e Vertical mounting

e Mounting at an angle

From 0 °C to 50 °C

MP 377 12" Key:
From 0 °C to 40 °C

MP 377 19" Touch:
From 0 °C to 35 °C

With MP 377 12" Touch and

With MP 377 15" Touch and

See the "Mounting positions and
type of fixation" section

Relative humidity

10 % to 90 %, no condensation

Atmospheric pressure 1080 hPa to 795 hPa

Corresponds to an elevation of —
1,000 to 2,000 m

Pollutant concentration | SO2: < 0.5 ppm;
Relative humidity < 60 %, no

condensation

Check: 10 cm3/m3; 10 days

H2S: < 0.1 ppm;

condensation

Relative humidity < 60 %, no

Check: 1 cm3/m3; 10 days

40
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Planning application
3.2 Mounting positions and type of fixation

3.2 Mounting positions and type of fixation

Mounting position
The HMI device is suitable for installation in:
® Mounting cabinets
® Control cabinets
e Control boards
e Consoles
In the following, all of these mounting options are referred to by the general term "cabinet".

The HMI device is self-ventilated and approved for vertical and inclined mounting in
stationary cabinets.

,/_‘|'+\~

Mounting position Deviation from the vertical
o Inclined < 35°
® Vertical 0°

A\ caution

Impermissible ambient temperatures

Do not operate the HMI device without auxiliary ventilation if the maximum permissible
ambient temperature is exceeded. The HMI device may otherwise get damaged and its
approvals and warranty will be void!

Mounting

Metal mounting clamps are provided for mounting. The mounting clamps hook into the
oblong holes on the HMI device.

=_

O] Threaded stud
® Hook

MP 377 (WIinCC flexible)

Operating Instructions, 09/2007, 6AV6 691-1DR01- C S@ 41
VICPA
-iom |

Ewery'thin? for your HMI running
B sales@vicpas.com

O +86-15876525394



Planning application

3.3 Preparations for mounting

3.3

Preparations for mounting

Select the mounting location of the HMI device

Points to observe when selecting the mounting location:

e Position the HMI device so that it is not subjected to direct sunlight.

® Position the HMI device such that it is ergonomically accessible for the user.

Choose a suitable mounting height.

e Ensure that the air vents of the HMI device are not covered as a result of the mounting.

® Observe the permissible mounting positions for the HMI device.

Degrees of protection

The protection ratings are only ensured if the mounting cut-out conforms to the following:

® Thickness of material at the mounting cut-out for protection classes IP65 or NEMA
4X/NEMA 12 (indoor use only): 2 mm to 6 mm

e Permitted deviation from plane at the mounting cut-out: < 0.5 mm

This condition must be fulfilled for the mounted HMI device.

® Permissible surface roughness in the area of the seal: < 120 pm (Rz 120)

Dimensions for the mounting cut-out

42

The following table shows the dimensions of the required mounting cut-out:

Mounting cut-out | MP 377 12" Touch MP 377 12" MP 377 15" Touch | MP 377 19" Touch
Key

Width 310" mm 450" mm 367" mm 449*' mm

Height 248*' mm 290*" mm 2891 mm 379" mm

HMI device depth, 72 mm 59 mm 72 mm 75 mm

not including front

panel

Everythin

for your HMI running
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Planning application

3.3 Preparations for mounting

Note
You can insert an MP 377 12" Key into the mounting cut-out of the following HMI devices:

MP 370 12" Key
MP 277 10" Key
MP 270 10" Key
OP 270 10"

You can insert an MP 377 12" Touch into the mounting cut-out of the following HMI devices:

MP 370 12" Touch
MP 277 10" Touch
MP 270 10" Touch
OP 270 10"

You can insert an MP 377 15" Touch into the mounting cut-out of the following HMI device:

MP 370 15" Touch

Maintaining clearances
The HMI device must be installed with the following clearances:

MP 377 (WIinCC flexible)

50 mm above and below the mounting cut-out respectively for ventilation

15 mm to the right and left of the mounting cut-out respectively for fitting the clamps for
mounting

At least 10 mm behind the rear panel of the HMI device

NOTICE

Ensure that the maximum ambient temperature is not exceeded when mounting the
device in a cabinet and especially in a closed enclosure.
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Planning application

3.4 Information on insulation tests, protection class and degree of profection

3.4 Information on insulation tests, protection class and degree of

protection

Test voltages

Insulation strength is demonstrated in the type test with the following test voltages in

accordance with IEC 61131-2:

circuits or ground

Circuits with a nominal voltage of Ue to other

Test voltage

<50V

500 VDC

Protection class

Protection Class | in accordance with IEC 60536, i.e. PE/ground terminal to profile rail

required!

Protection against foreign objects and water

Degree of protection in accordance
with IEC 60529

Description

Front When mounted:

o |P65

o NEMA 4X/NEMA 12 (indoor use only)
Rear IP20

Protection against touch with standard test fingers. There is
no protection against ingress by water.

The degree of protection provided by the front can only be guaranteed when the mounting
seal lies completely against the mounting cut-out.

3.5 Rated voltages

The following table shows the rated voltage and the corresponding tolerance range.

Nominal voltage

Tolerance range

+24 VDC

19.2 V10 28.8 V (=20 %, +20 %)

MP 377 (WIinCC flexible)
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Mounting and connecting 4

4.1 Checking the package contents

Check the package contents for visible signs of transport damage and for completeness.

NOTICE

Damaged parts
Do not mount parts found to be damaged upon delivery.

In the case of damaged parts, contact your Siemens representative.

The following is contained in the delivery:
e HMI device
® Accessory kit
The accessory kit contains the following:
— 1 terminal block for the power supply
— Mounting clamps for mounting the MP 377
Additional documents may be enclosed with the accessory kit.

Keep the supplied documentation in a safe place. The documentation belongs to the HMI
device and is required for subsequent commissioning.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.2 Mounting the HMI device

4.2 Mounting the HMI device

Requirements
All packaging components and protective foils should be removed from the HMI device.

To install the HMI device, you need the mounting clamps from the accessories. The
mounting seal must be fitted on the HMI device. If the mounting seal is damaged, order a
replacement seal. The mounting seal is part of the associated service pack.

To ensure the necessary degree of protection on the HMI device, the mounting clamps must
observe the positions listed below.

The following photo shows how positions 1 to 10 are counted.
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Mounting and connecting

Positioning the mounting clamps on the MP 377 12" Touch

The following figure shows the counting direction for the insertion of the mounting clamps.

D

"—\

4.2 Mounting the HM/ device

The following table shows the positioning of the mounting clamps on the MP 377 12" Touch.

Observe the counting direction.
Page Number of mounting Position 1 Position 2 Position 3
clamps
Top 3 2 11 20
Right 3 2 9 16
Bottom 3 2 11 20
Left 3 2 9 16

Positioning the mounting clamps on the MP 377 12" Key

A total of 10 mounting clamps are needed for mounting. Fit mounting clamps in all the cut-

outs.

MP 377 (WinCC flexible)
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Mounting and connecting

4.2 Mounting the HMI device

Positioning the mounting clamps on the MP 377 15" Touch
The following figure shows the counting direction for the insertion of the mounting clamps.
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The following table shows the positioning of the mounting clamps on the MP 377 15" Touch.
Observe the counting direction.

Page Number of Position 1 Position 2 Position 3 Position 4
mounting clamps

Top 4 2 9 17 24

Right 3 3 10 17 -

Bottom 4 2 9 17 24

Left 3 3 10 17 -

Positioning the mounting clamps on the MP 377 19" Touch
The positions of the mounting clamps are marked by stamps on the cut-outs.

The following diagram shows examples of these stamps.

o UERERNRLN

= H
L ﬁaaaaama 1\
mﬁmﬁnﬂunnuunnnnnﬁﬁﬁ4zu\
A0R0RRARAEARAAAAGRMAASE \
I |
0] Stamps identifying the position of a mounting clamp

A total of 18 mounting clamps are needed for mounting. Fit mounting clamps in all the
stamped cut-outs.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.2 Mounting the HM/ device

Procedure
NOTICE
Installation of the HMI device
Always mount the HMI device according to the instructions in this manual.
Risk of guaranteed level of protection not being met
If the mounting seal is damaged or protrudes beyond the HMI device, the level of protection
is not ensured.
Check the fit of the mounting seal.
Note
Tighten the mounting clamp set screws until the HMI device is flush with the surface of the
control cabinet. Alternatively, you can tighten the mounting clamps to a max. torque of
0.2 Nm.
Proceed as follows:
1. Check that the mounting seal is fitted on the HMI device.
Do not install the mounting seal turned inside out. This may cause leaks in the mounting
cut-out.
2. Insert the HMI device into the mounting cut-out from the front.
3. Insert a mounting clamp into the cut-out provided on the HMI device.
o
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4. Fix mounting clamp @ in place by tightening the set screw @.
5. Repeat steps 3 and 4 for all mounting clamps.
6. Check the fit of the mounting seal.
If necessary, repeat steps 1 to 6.
Result
The HMI device is mounted and the relevant level of protection is ensured at the front.
MP 377 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

4.3 Connecting the HMI device

431 Overview

Requirements

® The HMI device must be mounted according to the specifications of these operating
instructions.

e Always use shielded standard cables for the data cable.
For further information, refer to the SIMATIC HMI catalog ST 80.

Connection sequence
Connect the HMI device in the following sequence:
1. Equipotential bonding
2. Power supply

Perform a power-up test to ensure the power supply is connected with the correct
polarity.

3. PLC
4. Configuring PC as necessary

5. 1/Os as necessary

NOTICE

Connection sequence

Always follow the correct sequence for connecting the HMI device. Failure to do so may
result in damage to the HMI device.

Disconnect the HMI device by completing the above steps in reverse order.

Connecting the cables

When connecting the cables, ensure that the contact pins are not bent. Secure the
connectors with screws.

The pin assignment of the ports is described in the technical specifications.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

43.2 Ports
The following figure shows the ports of the HMI device MP 377.

Power supply connector
RS-422/RS-485 port X10 / IF1b
PROFINET, 2 ports X1 P1 and X1 P2
USB, ports X20 and X21

Line in and micro

@
®
®
O]
®
®

Connect PROFIBUS DP or MPI to the X10/ IF1b port.

You can affix the USB and PROFINET connecting cables to the rear panel of the HMI device
with cable ties.

Line out

See also
Design of the MP 377 12" Touch HMI device (Page 16)
Design of the MP 377 12" Key HMI device (Page 18)
Design of the MP 377 15" Touch HMI device (Page 20)
Design of the MP 377 19" Touch HMI device (Page 22)
MP 377 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

43.3 Connection of equipotential

Potential differences

Differences in potential between spatially separated system parts may occur. The
differences in potential can lead to high equalizing currents over the data cables and
therefore to the destruction of their ports. Equalizing currents may arise if the cable shielding
is terminated at both ends and grounded at different system parts.

Differences in potential may develop when a system is connected to different mains
supplies.

General requirements for equipotential bonding

Differences in potential must be reduced by means of equipotential bonding in order to
ensure trouble-free operation of the relevant components of the electronic system. The
following must therefore be observed when installing the equipotential bonding circuit:

52

The effectiveness of equipotential bonding increases as the impedance of the
equipotential bonding conductor decreases or as its cross-section increases.

If two parts of the system are connected to each other by means of shielded data cables,
and its shielding is connected at both ends with the grounding/protective grounding
conductor, then the impedance of the additionally-laid equipotential bonding may amount
to a maximum of 10% of the screened impedance.

The cross-section of a selected equipotential bonding conductor must be capable of
handling the maximum equalizing current. The best results in practical applications for
equipotential bonding between two cabinets have been achieved with a minimum
conductor cross-section of 16 mm>.

Use equipotential bonding conductors made of copper or galvanized steel. Establish a
large surface contact between the equipotential bonding conductors and the
grounding/protective conductor and protect these from corrosion.

Clamp the shielding of the data cable on the HMI device flush and near the equipotential
busbar using suitable cable clamps.

Route the equipotential bonding conductor and data cables in parallel with minimum
clearance between these.

NOTICE

Equipotential bonding conductor

Cable shielding is not suitable for equipotential bonding. Always use the prescribed
equipotential bonding conductors. The minimum cross-section of a conductor used for
equipotential bonding is 16 mm2. When you install MPI and PROFIBUS DP networks,
always use cables with a sufficient cross-section. The interface modules may otherwise

be damaged or destroyed.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Connection graphic

Chassis terminal on the HMI device, example

Equipotential bonding conductor cross-section: 4 mm2
Switching cabinet

Equipotential bonding conductor cross-section: min. 16 mm?2
Ground connection

Cable clip

Voltage bus

CHONONCNCNONONC)

Parallel routing of the equipotential bonding conductor and data cable

MP 377 (WIinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Power supply connection

434

Connection graphic

The following figure shows the connection between the power supply and HMI device.

MP 377 12" Touch

MP 377 12" Key

MP 377 15“ Touch

MP 377 19" Touch

Note when connecting

The plug-in terminal strip for connecting the power supply is contained in the accessories

pack. The plug-in terminal strip is designed for conductors with a maximum cross-section of

1.5 mm?2.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Connecting the plug-in terminal strip

NOTICE
Damage

Do not tighten the screws of the plug-in terminal strip if the latter is plugged into the HMI
device. The pressure from the screwdriver may otherwise damage the HMI device socket.

Only connect the wires when the plug-in terminal strip is withdrawn.

GND
+24V DC

Connect the plug-in terminal strip to the cables of the power supply as shown in the figure
above. Ensure that the lines are connected properly to the correct terminals. Refer to the
label for the contact pins on the rear of the HMI device.

Reverse polarity protection
The HMI device is equipped with a reverse polarity protection circuit.

Connecting the power supply

CAUTION

Safe electrical separation

Use only power supply units with safety isolation complying with IEC 60364-4-41 or
HD 384.04.41 (VDE 0100, Part 410), for example according to the PELV standard, for the
24 VDC supply.

The supply voltage must be within the specified voltage range. Malfunctions in the HMI
device may otherwise result.

Applies to non-isolated system design:

Connect the connection for GND 24 V from the 24 V power supply output to equipotential
bonding for uniform reference potential. For this purpose, choose a connecting point that is
as close as possible to the center.

See also
Uninterruptible power supply connection (Page 56)

MP 377 (WIinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

4.3.5 Uninterruptible power supply connection

Connection graphic

The following figure shows the connection between the uninterruptible power supply and
HMI device. The uninterruptible power supply is connected to the 24-V input and one of the
HMI device's USB ports.

When connected to the HMI device's USB port, the following uninterruptible power supplies
are supported:

SITOP DC UPS modules as of a rated power value of 6 A, e.g. 6EP1931-2DC42

Uninterruptible power supply (UPS)

[a¥]
|
- |
L l '
MP 377 12" Touch (]
e s s

MP 377 12" Key A e LT

|
MP 377 15" Touch ST ii—m]]ga :
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I
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Note
Observe all the notes relating to connecting a power supply.

See also
Power supply connection (Page 54)

MP 377 (WIinCC flexible)
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Mounting and connecting

4.3.6 PLC connection

Connection graphic

4.3 Connecting the HMI device

The following figure shows the connection between the PLC and HMI device.

PROFINET

MP 377 (WIinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

NOTICE

Approved cable

If you do not use approved cables to connect a SIMATIC S7 PLC, you may experience
functional problems.

Always use the approved cables to connect a SIMATIC S7 PLC.

Standard cables are available for the connection. You can find more information about this
on the Internet at: "http://mall.automation.siemens.com"

Connecting PROFINET

NOTICE

PROFINET IO direct keys
If you use PROFINET IO direct keys and the HMI device is not connected via a switch, you
may experience functional problems.

Connect the HMI device via switch. For detailed instructions regarding the installation of
PROFINET networks, please refer to the "PROFINET system description" manual.

Only connect the HMI device to public Ethernet networks using a switch or comparable
device.

MP 377 (WIinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

Configuring an RS-422/RS-485 port

A DIP switch S1 for the configuration of the RS-422/RS-485 port is located on the rear of the
HMI device.

In the factory state, the DIP switch is set for communication with the SIMATIC S7 PLC via
RS 485.

Note
Note the diagrams of the DIP switch settings on the back of the HMI device.

The following table shows the settings of the DIP switch. The transmitting and receiving
direction is switched internally with the RTS signal.

Communication | Switch setting Meaning
RS 485 4321 No RTS on connector,
ON e During data transfer between the PLC and HMI device

e During data transfer between the HMI device and PC
(delivery condition)

RTS on pin 4, same as PLC,

1
ON for example for commissioning

4321 RTS on pin 9, same as programming device,
ON for example for commissioning
RS 422 4321 RS-422 port is active.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Configuring PC connection

4.3.7

Connection graphic

The following figure shows the connection between the configuring PC and HMI device.

USB
PROFINET
RS 485

RS 485

RS 232

MP 377 12" Touch

MP 377 12" Key

MP 377 15" Touch
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MP 377 19" Touch

The ports are described in the specifications.

For RS-485-RS-232 conversion, you can order the PC/PPI cable from Siemens AG using

order number 6ES7 901-3CB30-0XA0.

MP 377 (WIinCC flexible)
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Mounting and connecting
4.3 Connecting the HMI device

Configuring a PC/PPI cable

Use the DIP switches to configure the transfer rate of the PC/PPI cable.

Note

If the connection fails during the operating system update, set the system to a lower bit rate.
If you wish to communicate at high bit rates, you must use a PC/PPI cable version 3 or later.
The version code is printed on the cable (for example "E-Stand 3" corresponds to version 3).

(O) DIP switch
@ LEDs

Set the DIP switches 1 to 3 to the same bit rate as in WinCC flexible. DIP switches 4 to 8
must be set to "0".

ST -

123456

@ DIP switch

The following bit rates can be set:

Bit rate in kbit/s DIP switch 1 DIP switch 2 DIP switch 3
115,2 1 1 0
57,6 1 1 1
38,4 0 0 0
19,2 0 0 1
9,6 0 1 0
4,8 0 1 1
2,4 1 0 0
1,2 1 0 1

In the figure, the bit rate is set to 115.2 kbit/s.

MP 377 (WinCC flexible)
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Mounting and connecting

4.3 Connecting the HMI device

Note when connecting

NOTICE
USB connection sequence

Observe the following sequence when connecting by USB:
1. HMI device

2. PC

USB Host-to-Host cable

Only use the driver for the USB host cable, which is included in the WinCC flexible
package. Never use the driver supplied with the USB Host-to-Host cable.

Note
Updating the operating system

If there is no serviceable HMI device image on the HMI device, you can only update the
operating system by restoring the factory setting. When restoring the factory settings,
connect the PC to the HMI device by PROFINET.

4.3.8 USB device connection
You can connect the following devices to the USB port of the HMI device:
e External mouse
e External keyboard
® Printer
® USB memory stick
® |ndustrial USB Hub 4
Industrial USB hub 4 can be obtained using order number 6AV6671-3AH00-0AXO.

Note when connecting

NOTICE
Functional problem with USB port

If you connect an external device with a 230-V power supply to the USB port without using
an non-insulated installation, you may experience functional problems.

Ensure a non-insulated installation.
Excessive rated load on port
A USB device with too high a power load may possibly cause functional problems.

Observe the values for the maximum load of the USB port. You will find the values in the
technical specifications.

See also
X20, X21 (USB) (Page 259)
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Mounting and connecting
4.3 Connecting the HMI device

Printer connection

4.3.9

Connection graphic

The following figure shows the connection between the printer and HMI device.
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Mounting and connecting

4.3 Connecting the HMI device

Note when connecting

4.3.10

64

NOTICE

Data exchange cables

If you use cables without a metallic netting shield between the HMI device and printer, you
may experience functional problems.

Only use cables with metal-braided shielding grounded at both ends for connecting the HMI
device and printer.

Note

Some printers may require the ASCII character set used in the project to also be defined on
the printer.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/\WW/view/en/11376409".

Observe the supplied printer documentation when you connect the printer.

Audio device connection

You can connect an active speaker or another audio amplifier to the HMI device's "Line Out"
port.

Note
The "Micro" and "Line In" ports are provided for future applications.

The microphone and audio source share one port.

MP 377 (WIinCC flexible)
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Mounting and connecting
4.4 Swifching on and testing the HM/ device

44 Switching on and testing the HMI device

Procedure
Proceed as follows:
1. Switch on the power supply.

The display lights up after power is switched on. A progress bar is displayed during
startup.

If the HMI device does not start, it is possible the wires on the terminal block have been
crossed. Check the connected wires and change the connections. The Loader is
displayed once the operating system has started.

Transfer

Skart

Contraol
Panel

Taskbar

The HMI device automatically switches to "Transfer" mode during initial startup under the
following conditions:

— No project is loaded on the device.
— At least one data channel has been configured.

During this process the following dialog appears:

Transfer ... .

Connecting ko hosk ...

Canecel

2. Press "Cancel" to stop the transfer.

Result

The Loader appears again.

MP 377 (WIinCC flexible)
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Mounting and connecting

4.4 Swifching on and testing the HMI device

Note

When restarting the system, a project may already be loaded on the HMI device. The project
will then start after an adjustable delay or when you press the "Start" button.

Use the relevant operating element to close the project.

Further information on this may be available in your plant documentation

Function test

Perform a function test following commissioning. The HMI device is fully functional when one
of the following states is indicated:

® The "Transfer" dialog is displayed.
® The Loader appears.

® A project is started.

Switching off the HMI device
Terminate the project at the HMI device before switching it off.
You have the following options for switching off the HMI device:
e Switch off the power supply.

® Disconnect the plug-in terminal strip on the HMI device.

See also
Configuring the data channel (Page 117)

MP 377 (WIinCC flexible)
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Operator controls and displays 5

5.1 Front operator controls

MP 377 Touch

SIEMENS

0] Display with touch screen

The MP 377 Touch is operated via the touch screen. All operating elements required for
operator input are displayed on the touch screen once the HMI device has started.

NOTICE

Unintentional action possible

Do not carry out several operations simultaneously. You may otherwise trigger an
unintentional action.

Always touch only one operating element on the screen
Damage to the touch screen possible

Never touch the touch screen with pointed or sharp objects. Avoid applying excessive
pressure to the touch screen with hard objects. Both these will substantially reduce the
useful life of the touch screen and even lead to total failure.

Always operate the HMI touch screen with your fingers or with a touch pen.

MP 377 (WinCC flexible)
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Operafor controls and displays

5. 1 Front operator controls

MP 377 12" Key

Function keys with LED
System keys - alphanumeric keys

Display
System keys — control keys
System keys - cursor keys

CECHCONCNC

The MP 377 12" Key is operated using the system keys and the function keys.

The function assigned to a specific function key is defined during configuration. The function
keys have no function prior to the project being opened.

NOTICE
Unintentional action possible

Do not carry out several operations simultaneously. You may otherwise trigger an
unintentional action.

Do not press more than two keys simultaneously
Damage to the keyboard possible

Using hard instruments to press the keys considerably reduces the service life of the key
mechanism.

Only use your fingers to operate the HMI device keys.

MP 377 (WinCC flexible)
68 ating Instructions, 09/2007, 6AV6 691-1DR01-0ABO

Everything for your HMI running
g sales@vicpas.com

£ +86-15876525394



Operafor controls and displays

5.2

Introduction

Procedure

See also

5.2 Inserting a memory card

Inserting a memory card

The following can be saved to the memory card of the HMI device:
® Backup of the HMI device

® Logs

® Recipes

® QOperating system

® Applications

e Other data such as video files, Word, Excel or PDF files

The memory card can be inserted during operation.

Note
The multimedia card of the SIMATIC S7 PLC cannot be used.

Proceed as follows:
1. Insert the memory card into the relevant slot.

When inserting the memory card, please note that it can only be inserted in the slot when
the front side of the memory card is visible.

e
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2. Check that the memory card is properly seated.

Securing memory card (Page 70)

MP 377 (WIinCC flexible)

Operating Instructions, 09/2007, 6AV6 691-1DR01-

69
VICPAS®

Everg,rt_hin? for your HMI running
B sales@vicpas.com

£ +86-15876525394



Operafor controls and displays
5.3 Securing memory card

5.3 Securing memory card

Introduction

The HMI device is designed for the tough conditions experienced in industry. Therefore use
the locking bracket to secure the memory card in its slot.

Requirements
A memory card has been inserted.

Procedure
Proceed as follows:

1. Loosely screw in the Torx screw @.
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2. Place the locking bracket @ against the memory card.

3. Tighten the cross-tip screw @.

Result
The memory card is secure.

MP 377 (WIinCC flexible)
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Operafor controls and displays
5.4 Unplugging the memory card

54 Unplugging the memory card

Introduction
The memory card can be unplugged during operation. Do not remove the memory card while
data is being accessed by an application, e.g. during backup or recipe transfer.

Procedure

NOTICE

Loss of data possible

The data on the memory card is lost if you attempt to remove it while the HMI device is
accessing its data.

Do not remove the memory card while data is being accessed. Observe the corresponding
alarms on the screen.

Proceed as follows:
1. Unplug the memory card from the memory card slot.

2. Store the memory card in a safe place.

MP 377 (WIinCC flexible)
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Operafor controls and displays
5.5 Labeling the function keys on the MP 377 12" Key

5.5 Labeling the function keys on the MP 377 12" Key

Introduction
You can label the function keys as required for your project. Use labeling strips to do so.

Note
Do not write on the keyboard to label the function keys.

Printing labeling strips

WinCC flexible comes with a range of labeling strip templates. You will find further
information regarding the location of the templates in the WinCC flexible Online Help.

Any printable and writable foil can be used as labeling strips. You can use transparency film,
the keyboard membrane of the HMI device is printed on the reverse side. Use transparent
foil so that the LEDs of the function keys can be seen.

Permitted thickness of the labeling strip: 0.13 mm. Paper should not be used as labeling
strips.

Dimensions of the labeling strip for the MP 377 12" Key

2 x45°

/ 17
’J 17,

9.4| 206 | 20.6 | 20.6 | 20.6 | 20.6 | 20.6 | 20.6
245

2 x45°

(=
—
— |
— |
—
— |

Area which can be written and printed on
17

J;U ] 17,
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Operafor controls and displays

Procedure

5.5 Labeling the function keys on the MP 377 12" Key

Proceed as follows:

1.

Edit and then print the template.
You can also print blank templates and label them manually.
Spray the labeling strips with fixing spray.

The fixing spray ensures that the text is water resistant and does not smear, and that the
printer ink on the keyboard membrane does not run.

Cut out the labeling strip.

Ensure that the corners are cut according to the diagram shown above as this makes it
easier to slide them into the slot.

Remove any existing labeling strips.

Note
Wait for the printed labeling strips to dry before you insert them.

. Slide the labeling strips @ into the slot @®.

Slide the labeling strips into the slot up to the stop.

The labeling strip will protrude approximately 3 cm from the slot. The template
dimensions for the labeling strips are designed so that the labeling is correctly placed for
the function keys. A means of securing the labeling strip is not necessary.

When mounting the HMI device, ensure that the labeling strips do not become jammed
between the mounting cut-out and the HMI device.

MP 377 (WIinCC flexible)
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Operafor controls and displays

5.5 Labeling the function keys on the MP 377 12" Key
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Configuring the operating system

6.1 Loader

Overview

The following figure shows the Loader. The header line contains details of the loader
version. These details are not shown in the following figure.

Transfer

Skart

Contraol
Panel

Taskbar

The Loader buttons have the following functions:
® Press the "Transfer" button to set the HMI device to "Transfer" mode.

The transfer mode can only be activated when at least one data channel has been
enabled for the transfer.

® Press the "Start" button to start the project on the HMI device.

If you do not perform an operation, the project on the HMI device will automatically start
after a delay.

® Press the "Control Panel" button to open the HMI device Control Panel.

You can change various settings in the Control Panel, for example the transfer settings.

MP 377 (WIinCC flexible)
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Configuring the operating system

6.1 Loader

Open Loader

® Press the "Taskbar" button to activate the taskbar with the Windows CE start menu open.

The following figure shows the open start menu.

Transfer

& Programs 1> ﬂ Command Prompt
fg Favorites 2 ﬁ Internet Explorer
| Documerits * | &Y Media Player

[ Settings ¥ | i Softkeyboard
ERun.. fj Windows Explorer
astart |Loader

¥ 09:19

Depending on the software installed, other symbols may be displayed in the desktop's status
bar.

The following options are available to open the Loader:
® The Loader appears briefly after starting the HMI device.
® The Loader appears when the project is closed.
If configured, use the relevant operating element to close the project.

For further information on this, refer to your plant documentation.

Key operation in the Loader

76

The following table shows the key combinations for navigating in the Loader.

Key combination Functions

Iz' IZ' The next or previous entry is selected.
}

ever] o The selected button is operated.
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Configuring the operating system

Key operation in the Windows CE interface

6.1 Loader

The following table shows the key combinations for navigating in the user interface.

Key combination

Functions

The taskbar is activated with the open Windows CE start menu.

. [+

The next active program is displayed.

+

The Task Manager is opened.

Key operation in the Explorer

The following table shows the key combinations for navigating in the Explorer.

Key combination

Functions

TAB

e Toggles the active window.
e Toggles between the Windows CE Desktop and the window.

F 4
N | + |HovE

Selects the first entry.

n

H
+

m

z

.

Selects the last entry.

>
@

9]
=1
T
[l
+
-

Selects everything, if the left LED of the key lights up

ALT

Activates the menu bar.

4]

Changes to the higher level.

>
=
4

Opens the context menu.

+

+
o] O
A =
H H
Y —

Displays the properties.

>
=
3

Password protection

You can protect the control panel and taskbar from unauthorized access. When password
protection is activated, the "password protect" message is displayed in the loader.

If the password is not entered, only the "Transfer" and "Start" buttons are operable.

Password protection prevents maloperation. This in turn increases security on the plant or
machine as the settings for the active project can only be changed by entering the password.

NOTICE
Loss of data possible

If the password is no longer available, you can only cancel password protection by updating
the operating system. All data on the HMI device will be deleted when you update the
operating system.

Back up the HMI device's data.
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Configuring the operating system

6.1 Loader

Internet Explorer
Internet Explorer for Windows CE is installed on the HMI device.

[File Edit view Favorites | ||| @[+ |@[&] a|&] x]

[I]Address I httpe ffsupport, autormation. siemens, cormnf W fllisapi diFfunc =cslib. csinfo2&ak tprim =998lang =en

SIEMENS

International > Automation and Drives Oeutsch| Francais| lta

Automation and Drives Home | Product Support | Applications & Tools | Services | Information | For|

Service & Support

Ipport news 5 ) 2B subscribe
= Driverdownload SIMATIC Flak Panel
=+ Measuring cvcles
= Special funchions: Axis pair collusion prokection (TES)
=+ Spedial functions: Cycle-Independent Path-3vnchronous Signal Qukput (TES)

Self-help

Search Product Support Documents

Browse Support Docume

Enter wour specific product information below ko quickly
extrack the latest related entries from our global database,

Go ko our global database and exp
FaZs, manuals, downloads and ap

Produck Mame or Park Mumber > Product Support

Search Text (key words)
| [Go]
4] | >
|http:waw.autc:math:un.siemens.cnmfmetafihdex_?ﬁ.htm | |—|—|— £ Internet

Far automation syskem interackion
questions, click below For applicatic

demonstration systems and more:

- Application & Tools ™

Note

Internet Explorer for Windows CE and the Internet Explorer version which can run on a PC
differ in terms of function.

Further information can be found on the Microsoft web pages.
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Configuring the operating system

Media Player

6.1 Loader

Media Player for Windows CE is installed on the HMI device. Media Player is used to e.g.

play video sequences for maintenance and servicing.

Media Player

File View Playback |aweb|

Media Player supports the following formats:

e WMA
* MPEG

Note

Media Player for Windows CE and the Media Player version which can run on a PC differ
in terms of function.

Further information can be found on the Microsoft web pages.
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Configuring the operating system

6.2 Viewer
6.2 Viewer

Introduction

You can use ProSave to install viewers for various data formats. You can tell which viewers
are installed by a symbol on the desktop and from the Start menu under "Programs".

The following viewers can be installed:

Viewer Icon
PDF Viewer @
Word Viewer
ik
S
Excel Viewer

Functional scope

The viewers can read and print the following file formats:

Viewer Readable file formats
PDF Viewer PDF

Word Viewer DOC, RTF

Excel Viewer XL*

All viewers share a Zoom function. The Excel Viewer also offers the following functions:

® Switch between spreadsheet tabs

® Split the spreadsheet

® Change line height and column width

80
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Configuring the operating system

6.3 Control Panel

6.3 Control Panel

6.3.1 Overview
The HMI device's Control Panel is similar to the control panel on a PC.

The Control Panel looks like this:

File view _ EIE

Backup/R... Certificates InputPanel  Internet Kevboard Mouse  Metwork and

Options Dial-up Co...
@ g i
® B
opP

» & 9 @
Metwark 1D Pazswiord Printer PROFINET Regional  S7-Transfer ScreenSaver

Settings Settings

H L. H 4

System Transfer LIPS yolume & WinCC
Sounds Intern...

The control panel can be used to modify the following settings:
® Date and time

® Screen saver

® Regional settings

® Transfer settings

® Network settings

e Delay time

® Password

6.3.2 Opening the Control Panel

Introduction
The HMI device Control Panel can be opened as follows:

® |ndependently of a running project
— Press the "Control panel" button in the loader.
— By calling up from the Windows CE start menu.

e \With active project

An operating element must be configured to open the control panel for this purpose.
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Configuring the operating system

6.3 Control Panel

Procedure — open the Control Panel via the Start menu

Result

6.3.3

Overview of functions

82

Proceed as follows:
1. Open the Windows CE start menu.

Procedure using the keys:

Select the + key combination.

Procedure using the touch screen:

Press the key twice on the alpha-numeric VDU keyboard.

2. Select "Settings > Control panel".

The control panel is opened.

Reference for functions

The following table shows the settings in the Control Panel.

Icon Functions Tab / entry
@ Saving and restoring with external storage device -

[ Importing, displaying and deleting certificates "Stores"
pﬂJ Setting the date and time "Date/Time"

)

Configuring the screen keyboard

:;" Changing the browser startup page and general browser settings | "General"
Changing connection and proxy server settings "Connection"
Changing cookie settings "Privacy"
Changing privacy settings "Advanced"

@ Setting the character repeat for the keyboard "Repeat”

%) Setting the double-click "Double-Click"

e Parameterizing the LAN connection "ERTEC400"

= Setting the IP address | "ERTEC400 Ethernet Driver' Settings" "IP Address"

Set name server "ERTEC400 Ethernet Driver' Settings"

"Name Servers"

IC
EE

Changing the logon data

"ldentification”

MP 377 (WIinCC flexible)
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Configuring the operating system

6.3 Confrol Pane/
Icon Functions Tab / entry
éo Backup registry information "Persistent Storage"
Changing monitor settings "Display"
Displaying information about the HMI device "Device"
Restarting the HMI device "Device"
Touch screen calibration ) "Touch"

Activate memory management "Memory Monitoring"

Changing password protection "Password Settings"

Changing the PROFINET 10 setting -

Changing regional settings "Regional Settings"

= Changing the print rti -
anging the printer properties
i)

Changing the number format "Number"
Changing the currency format "Currency"
Changing the time format "Time"
Changing the date format "Date"

ﬂl; Changing transfer settings "MPI"
Changing the PROFIBUS DP transfer settings "PROFIBUS"

@ Setting the screen saver -
Reducing the backlighting

?ﬁ Displaying the system information "General"
= Displaying memory information "Memory"

Setting the device name of the HMI device "Device Name"

= Configuring the data channel "Channel"
Ly Setting the delay time "Directories"
‘lljlliﬂ Setting the uninterruptible power supply "Configuration"

State of uninterruptible power supply "Current Status

lﬁ Setting operation feedback with key and touch screen operation | "Volume"
Setting operation feedback with key operation
Setting acoustic signal for inadvertent operations

Assigning sounds to events. "Sounds"

L] Changing e-mail settings? "Email"

R Only with MP 377 Touch

2) Additional tabs may appear in the "WIinCC flexible Internet Settings" dialog. This depends on
the options that have been enabled for network operation in the project.
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Configuring the operating system

6.3 Control Panel
6.3.4 Operating the Control Panel

6.3.4.1 Overview

Operator input options

The hardware of the HMI device determines, which of the following operator control options
are available:

® Touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements
by touching them with your finger. To double-click them, touch an operating element
twice in succession.

o HMI device keyboard

The operating elements shown in the dialogs are selected and operated using the keys of
the HMI device.

e External USB keyboard

o External USB mouse

Entries using an external keyboard

An external keyboard can be used to operate the Control Panel in exactly the same way as
the HMI device keyboard. Use the keys of the external keyboard which correspond to the
HMI device keys in the description.

Operator entries using an external mouse

An external mouse can be used to operate the Control Panel in exactly the same way as the
HMI device touch screen. Click the described operating elements with the mouse.

6.3.4.2 Operation using the touch screen

Introduction
The control panel is operated with the HMI device touch screen or a connected mouse.

Requirements
An active project has been terminated. The Loader appears.

MP 377 (WIinCC flexible)
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Configuring the operating system

Procedure

6.3 Control Panel

Proceed as follows to change settings in the Control Panel:

1.

Open the Control Panel with the "Control Panel" button.

2. To open the required dialog, double-click its symbol.
3.
4

. Make the necessary changes.

Change the tab as required.

Touch the corresponding input object.
— Use the screen keyboard of the HMI device to enter the new values in the text boxes.
— Touch a button to operate it.

— Touch the selection box to open a drop down list box. Touch the required entry from
the drop down list box.

— Touch the check box to activate or deactivate a check box.

— Touch a radio button to select it.
Confirm the selection with the OK| button or abort the entry with the | x| button.

The dialog closes.

Close the Control Panel with the "[x]" button.

The Loader appears.

Input with the screen keyboard

A screen keyboard is available for data input. The screen keyboard is displayed as soon as
you touch a text box. You can also call up the screen keyboard directly from the
Control Panel.

Display methods for the screen keyboard

You can change the display method for the screen keyboard and fix the position on the
screen. Confirm the entry with the button or abort the entry with the key. Either
action closes the screen keyboard.

MP 377 (WIinCC flexible)
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Configuring the operating system

6.3 Control Panel

® Alphanumerical screen keyboard

“[1lz2[3]as]e[7]e]o]o]-[=]«— [ _Ix]

—H|q|w|e|r|t|ylu|li|lo|lp|[]| ] Ins |Home| G
g |a|s|d|(flg|h|i|kK|P]:]"]|}\ 'l pel | End | ¥
tl\|z|x|c|v|b|n|m|,]|.|[/f]| © [&c]| mm| ¢

cl | R an acer | R o | & |

The alphanumerical keyboard is organized in the following two layers:

— Normal level

— Shift level

® Reduced screen keyboard

Changing the display of the screen keyboard

Key Functions

Switching between the numerical and alphanumerical keyboard

Switching between the normal level and Shift level of the alphanumerical screen
keyboard

BEIE

Switchover to special characters

Switching from full display to reduced display

Switching from reduced display to full display

Close the screen keyboard

< & |

6.3.4.3 Operation with the keyboard

Introduction
The Control Panel is operated with the system keys of the HMI device.

Requirements
An active project has been terminated. The Loader appears.
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Configuring the operating system

Procedure

6.3 Control Panel

Proceed as follows to change settings in the Control Panel:

1.
2.

9.

Open the Control Panel.

Select the "Control Panel" button in the loader using the cursor keys.

Press .

The Control Panel is opened.

Select the symbol of the required dialog with the cursor keys.

Press to open the dialog.

Change the tab as required.

Press until the name of the tab is selected. Now switch between the tabs using the

cursor keys.

Use the key to return to the input area.

Make the necessary changes.

To do this, highlight the corresponding input object using the key.

Use the system keys of the HMI device to enter the new values in the text boxes.
— To operate a button, select the button with the cursor keys and then press .

— Open the drop down list boxes with the key combination + Iz'
Select the required entry from the drop down list box using the cursor keys.

ENTER

Confirm the selected entry by pressing .

{1}
- Press to activate or deactivate a check box.

— Select a radio button from a group using the cursor keys.

Confirm your entries with or discard your entries with .
If you have selected an input object, you first have to complete entry.

The dialog closes.

10. Close the Control Panel.

Press the key to do this.

The control panel menu is opened.

11. Select the "Close" entry using the cursor keys.

12. Press .

MP 377 (WIinCC flexible)
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Configuring the operating system

6.3 Control Panel

Control keys
The following tables show the control keys used to select and operate the control panel.

® Select operating elements

Key Functions Description

IEHHI
SHIFT + Iiﬁi

IE“E' Cursor keys Selects the next operating element to the left, right,
above or below the current screen object.

EIIZI Navigates in the operating element.

Tabulator Selects the next/previous operating element in the
tab sequence.

® Using operating elements

Key Functions Description
Scroll back Scrolls back a page in a list.
HOME
4 Scroll to the beginning Scrolls to the beginning of a list.
N | 4 |Home
. Scroll forward Scrolls one page forward in a list.
END
Scroll to the end Scrolls to the end of a list.
.
nTER ENTER key e Operates a button.

e Accepts and ends an entry.

EsC Cancel e Deletes the characters of a value entry and
restores the original value.

¢ Closes the active dialog.

Delete characters Deletes the character to the right of the current
cursor position.
Delete characters Deletes the character to the left of the current cursor
position.
ar| | Iz' Open drop down list box | Opens a drop down list box.
JRY I Accept value Accepts the selected value in the drop down list box
+ without closing the list.
MP 377 (WinCC flexible)
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Configuring the operating system

6.3 Control Panel
Enter key combinations
Key Functions Purpose
Toggle key assignment Toggles the assignment for a key with multiple
assignment.
e NolLEDis lit

The number assignment is enabled. Pressing the
button once toggles to letter assignment.

e AnLEDis lit

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
between the left letter assignment, the right letter
assignment and the number assignment.

Toggle between upper- Used in key combinations, for example for entering
case and lower-case upper-case letters.

Switch to additional key Some of the keys contain a blue imprinted key
assignment assignment , for example the "%" character.

)
l I
=z T
I

Used in key combinations for the blue key
assignment.

General control function Used in key combinations

=
T
P

ALT General control function Used in key combinations
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Configuring the operafting system

6.4 Changing settings for operation

6.4 Changing settings for operation

6.4.1 Configuring the screen keyboard

Introduction

Requirements

Procedure

90

The details provided below will explain how the screen keyboard can be displayed and
positioned.

You have opened the "Siemens HMI Input Panel - Options" dialog with the "InputPanel"

icon.

Siemens HMI Input Panel - Options m

Position and Size
[ Shows Resize button

Currently closed...
| Open Input Panel ! @

Save current size and position...

‘ Save : @

® Check box for displaying the [ ] button in the screen keyboard
® Button for displaying the screen keyboard
® Button for saving the screen keyboard settings

Proceed as follows:

1. If you want to change the size of the screen keyboard, activate the "Show Resize Button"
check box.

The [ button is displayed in the screen keyboard awaiting opening.

2. If you want to prevent the size of the screen keyboard from being changed, deactivate the
"Show Resize Button" check box.

The [ button is removed from the screen keyboard awaiting opening.
3. Use the "Open Input Panel" button to open the screen keyboard.

4. If you want to switch between the numerical and alphanumerical screen keyboard, press

the [F] key.
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Configuring the operating system

6.4 Changing settings for operation

5. If you want to change the position of the screen keyboard, use the mouse pointer to
select a free space between the keys.

Release the mouse pointer when the required position has been reached.
6. If you want to increase or decrease the size of the keyboard screen, place your mouse
pointer over the button [].
Adapt the screen keyboard size by dragging it to size with the mouse pointer.
Release the mouse pointer when the required size has been reached.
If you want to save the settings, press the "Save" button.
10. Confirm your entries.

The dialog closes.

Result
The screen keyboard settings have been modified.

6.4.2 Setting the character repeat

Introduction

The details provided below will explain how to set the character repetition and the associated
delay for the keyboard and/or screen keyboard.

Requirements

You have opened the "Keyboard Properties" dialog with the "Keyboard" @ icon.

Keyboard Properties m

Fepeat l
|7 tnable character repeat
[ Repeat QEIaw Long Tivinnininainnn 1 Shgrt\
q « — — >
.

[ Repeat rake:  Slow Fast )

2A o )

Tap here and hold down a ke to

b6 b &

Check box for activating the character repeat

Slider control and buttons for the delay time before character repeat
Slider control and buttons for the rate of the character repeat

Test field

® e 0 0
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6.4 Changing settings for operation

Procedure

Result

92

Proceed as follows:

1.

If you want to enable character repetition, activate the "Enable character repeat" check
box.

If you want to change the delay, press a button or the slider in the "Repeat delay" group.

Moving the slider to the right will shorten the delay. Moving to the left will extend the
delay.

If you want to change the repeat rate, press a button or the slider in the "Repeat rate"
group.

Moving the slider to the right will shorten the repeat rate. Moving to the left will extend the
repeat rate.

Check the settings.
Procedure using the touch screen:
— Touch the test field.
The screen keyboard opens.
— Move the screen keyboard as needed.
Procedure using the keys:
— Select the test field.
Press an alphanumeric key and keep the key pressed down.

Check the implementation of the character repetition and the rate of the character
repetition in the test field.

6. If the settings are not perfect, correct them.

7. Confirm your entries.

The dialog closes.

The character repetition and delay are set.
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6.4 Changing settings for operation

6.4.3 Setting the double-click

Introduction

You can start applications in the Control Panel and in Windows CE with a double-click. A
double-click corresponds to two brief touches in sequence.

In the "Mouse Properties" dialog, make the following adjustments for touch screen operation
and operation with external mouse:

® |nterval between touch contacts on the touch screen

® |nterval between mouse clicks

Requirements

You have opened the "Mouse Properties" dialog with the "Mouse" %) icon.

Double-Click |

Double-click this grid to sek the double-click
sensitivity For both the speed and physical M

distance bebween clicks,

Dauble-click this icon ko test your double-click
settings. IF this icon doesn't change, adjust
wour settings using the grid abowe.

—®

@ Pattern
® Icon

Procedure
Proceed as follows:
1. Click the pattern twice.

After the second click, the colors of the pattern will be reversed and the white fields will
change to gray. The time before the second click is saved.

=

2. Check the double-click.

Click on the icon twice in succession to do this. If the double-click is recognized, the icon
is displayed as follows:

3. If the settings are not perfect, correct them.
To do this, repeat steps 1 to 2.
4. Confirm your entries.

The dialog closes.
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6.4 Changing settings for operation

Result

6.44 Calibrating the touch screen

Introduction

Requirements

94

The double-click adjustment is completed.

Depending on the mounting position and viewing angle, it is possible that parallax may occur
when operating the touch screen. In order to prevent any operating errors as a result,
calibrate the touch screen again in the startup phase or during runtime.

You have opened the "OP Properties" dialog "Touch" tab with the "OP" 4@ icon.

OP Properties

[ Persiskent Skorage I Display I Device |TDUCh

&

IF wour Windows CE device is not responding
propetly to your kaps, you may need to

recalibrate your screen,

To skart, kap Recalibrate,

Recalibrate
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6.4 Changing settings for operation

Procedure

Proceed as follows:
1. Click on the "Recalibrate" button.

The following dialog opens:

Carefully press and briefly hold stylus on the center of
the target. Repeat as the target moves around the screen.
+ @

2. Briefly touch the middle of the calibration crosshairs @.

The calibration crosshairs is then displayed at four more positions.
3. Briefly touch the middle of the calibration crosshairs for each position.

Once you have touched all the positions of the calibration crosshairs, the following dialog

appears:

New calibration settings have been measured.
Tape the screen to register saved data.
Wait for 30 seconds to cancel saved data and
keep the current setting.
Time limit: 30 sec

4. Touch the touch screen.

The calibration is saved. The "OP Properties" dialog, "Touch" tab is displayed again. If

you do not touch the touch screen within the time shown, your original setting will be

retained.
5. Close the dialog.

Result

The HMI device touch screen is calibrated.
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Configuring the operating system
6.5 Setting up password profection

6.5 Setting up password protection

Introduction
You can protect access to the Control Panel and the Windows CE taskbar with a password.

Requirements

You have opened the "Password Properties" dialog with the "Password" @ icon.

Password Properties m
Pazsword Settings |

Password
@ Passward: I
Canfirm passwaord: I

NOTICE

Password not available

If the password is no longer available, you will have to wait for the operating system to be
updated again.

e Change settings in the Control Panel

e Use the Windows CE taskbar

All data on the HMI device will be deleted when you update the operating system!

Therefore use the password to protect against loss.

Note

The following characters cannot be used in passwords:
e Blank

e Special characters *? . % /\'"

Procedure
Proceed as follows:
1. Enter a password in the "Password" text box.
2. Repeat the password entry in the "Confirm password" text box.
3. Confirm your entries.
The dialog closes.
Result

You cannot open the Control Panel or Windows CE taskbar without entering a password.
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Configuring the operating system

6.6 Canceling password protection

6.6 Canceling password protection

Requirements

You have opened the "Password Properties" dialog with the "Password" @ icon.

Password Properties m
Pazswiord Settings |

Password
Q@ Password: I
Zonfirm password: I

Procedure
Proceed as follows:
1. Delete the entries in the "Password" and "Confirm password" text boxes.
2. Confirm your entries.
The dialog closes.
Result

Password protection for the Control Panel and Windows CE taskbar is canceled and they
can be freely accessed.

6.7 Changing HMI device settings

6.7.1 Setting the date and time

Introduction

You can set the date and time on the HMI device. The HMI must be restarted in the following
cases:

® You have changed the time zone setting
® You have changed the "Daylight savings time currently in effect" check box setting.

MP 377 (WIinCC flexible)

Operating Instructions, 09/2007, 6AV6 691-1DR01- C S@ 97
VICPA
‘am |

Eve-rg,-'thin? for your HMI running
EJ sales@vicpas.com

O +86-15876525394



Configuring the operating system

6.7 Changing HMI device seltings

Requirements

Procedure

98

Yo

R

u have opened the "Date/Time Properties" dialog with the "Date/Time Properties" &x}

icon.

Datef/Time Properties m

Date/Time I

Time Zone I(GMT) Greenwich Mean Time : Dublin, Edinbl|z|'—

[El Februar 2007 3

&

MDMDEFSGS S m—_@
@

—®

Current Time

2930 31 1 2 3 04

5 6 7 & 9 10 11
1z 13 14 15 17 13
19 20 21 22 23 24 25
%272 1 2 3 4

5 6 7 & 9 1011 EPP"}"—I

E Daylight savings time
currently in efbect

®©® 000

Time zone selection box
Input field for the time

Date selection box

"Daylight savings" check box
Button for applying changes

Proceed as follows:

1.
2.

Select the appropriate time zone for the HMI device from the "Time Zone" selection field.
Touch the "Apply" button to confirm your entry.

The time of day shown in the "Current Time" field is adjusted correspondingly to the
selected time zone.

3. Set the date in the selection box.

4. Set the current time of day in the "Current Time" text box.

5. Confirm your input by clicking on the "Apply" button.

The values you have set are now in effect.

Note

The system does not automatically switch between winter and summer time.

If you want to switch from winter to summer time, activate the
"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is brought forward by one hour.

If you want to switch from summer to winter time, deactivate the
"Daylight savings time currently in effect" check box.

When you press the "Apply" button, the time is taken backward by one hour.
Confirm your entries.

The dialog closes.
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6.7 Changing HMI device settings

Result
The settings for the data and time of day have now been changed.

Internal clock
The HMI device has an internal buffered clock.

Synchronizing the date and time with the PLC

The date and time of the HMI device can be synchronized with the PLC if this has been
configured in the project and the PLC program.

Further information on this subject is available in the "WinCC flexible" system manual.

NOTICE

Time-dependent reactions

You have to synchronize the date and time when time-controlled responses are triggered in
the PLC by the HMI device.

6.7.2 Changing regional settings

Introduction

In different countries, for example, the date, time and decimal points are displayed
differently. You can adjust this display to meet the requirements of different regions.

The country-specific settings apply to the current project. If the project language is changed,
the country-specific settings are also changed.

Requirements
You have opened the "Regional and Language Settings" dialog with the

"Regional Settings" 5 icon.

Regional and Language Settings

Regional Settings | Murmber I CLrrency I Time I Date I

Marry programs have different
- | international settings, Regional
adjustrnents in date-, tirme-,
currency- and nurmbers-
corwentions for displaying and
sorting data can be achieved in
E changing those intermational

0] Region selection box
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Procedure
Proceed as follows:
1. Select the region from the selection box.

2. Change to the "Number", "Currency", "Time" and "Date" tabs and set the selection boxes
to the desired settings.

3. Confirm your entries.

The dialog closes.

Result
The HMI device's regional settings have been changed.

6.7.3 Backup registry information

Registry information and temporary data

You can install and uninstall your own programs on the HMI devices under Windows CE.
You must save the registry settings after installation or uninstallation.

You can save the following data to the flash memory:
® Registry Information

® Temporary files

Restoring the file system of a memory card

If memory cards are used, the file system on the memory card may become damaged,
perhaps due to a power failure. The HMI device detects the defective file system on start-up
or when the memory card is inserted. The HMI device can restore the file system
automatically or on request.
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Requirements

6.7 Changing HMI device settings

You have opened the "OP Properties", dialog "Persistant Storage" tab with the "OP" 4@

icon.

[

_ Persistent Storage | pisplay | DEW

Save ackual registry settings to flash,
System will skart with saved reqistry Save Reqgistry
sethings next time.

Save all files From bemporary memory
(e.q. the "\Program Files' directory) o Save Files
flash, The files will be restored during
syskem starbup, The Temp' direckory
will mot be saved.

gukomatically repair file syskem errors on storage
cards at swskem starbup and card insertion time

é@@@@g

® e 6

Procedure

Significance of the text:

Saves the current registry information to the flash memory. The HMI device loads the saved
registry information the next time it boots.

Button for saving registry information
Button for saving temporary files
Significance of the text:

Saves all the files in temporary storage to the flash memory (for example, from the "Program
Files" directory). These files are written back when the HMI device is started. The "\Temp"
directory is not saved.

Automatically restores the file system on the memory card when the HMI device starts up and
when a memory card is inserted.

Proceed as follows:

1. If you want the system to be restored automatically, activate the "Automatically repair file
system errors ..." check box.

If the check box is unchecked, the system is only restored once prompted to do so.

2. Click on the necessary buttons.

3. Confirm your entries.

The dialog closes.

Result

The HMI device uses the saved registry information the next time it starts. The temporary
files are copied back.
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6.7.4

Changing monitor settings

Requirements

Procedure

Result

6.7.5

Introduction

102

You have opened the "OP Properties", dialog "Display" tab with the "OP" 4@ icon.

OP Properties

Persiskent Storage

Device

Brightriess

Up DOWH

Proceed as follows:

1. If you want to increase the brightness, press the "UP" button.

2. If you want to decrease the brightness, press the "DOWN" button.
3. Confirm your entries.

The dialog closes.

The screen settings have been changed.

Setting the screen saver

You can set the following time intervals on the HMI device:
® For the automatic activation of the screen saver
® For the automatic reduction in the screen's backlighting

When you do not undertake an operation within the configured interval, the configured
function will be activated automatically.

The screen saver and the reduced screen backlighting functions are switched back off by
means of the following actions:

® By pressing any key

e By touching the touch screen

MP 377 (WIinCC flexible)
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6.7 Changing HMI device settings

The function associated to the key or button will not be executed by this.

NOTICE
Reduce backlighting

The brightness of the backlighting decreases incrementally during its operational life.

In order to not shorten the operational lifetime of the backlighting unnecessarily, activate
the backlighting reduction.

Activating the screen saver

Screen contents which remain unchanged for long periods can remain dimly visible in the
background. This effect is reversible.

Therefore activate the screen saver. When the screen saver is active, the backlighting is
also reduced.

Requirements

You have opened the "Screensaver" dialog with the "ScreenSaver" I!\ icon.

Screensaver m
Dim Backlight becomes active after Ia [ ¥] minutes @

Screensaver becomes active afker ID - minutes @
[ ) standard ) Blank Screen } @

Enker a0 to disable the function,
The rninirurn ke is 5 and the maximonm is 71582 minukes,

0] Time interval in minutes until backlighting is reduced
® Period of time in minutes before the screen saver is activated
® Radio buttons for the screensaver

Procedure
Proceed as follows:
1. Enter the interval in minutes after which the backlighting is to be reduced.
Entering "0" will deactivate the backlighting reduction.
2. Enter the number of minutes before the screen saver is to be activated.

The minimum time is 5 minutes and the maximum time is 71582 minutes. Entering "0"
disables the screen saver.

3. Select either the screen saver or an empty screen.
— If you want the screen saver to function, activate the "Standard" radio button.

— If you do not want the screen saver to function, activate the "Blank Screen" radio
button.

4. Confirm your entries.

The dialog closes.
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Result

The screen saver and the reduced backlighting for the HMI device is set.

6.7.6 Changing the printer properties

Introduction

Requirements

Procedure

104

The HMI device can print on local printers or network printers. You can print hardcopies and
reports on a network printer. Line printing of alarms is not possible on a network printer.

The list of current printers and required settings for HMI devices can be found on the Internet
under "http://support.automation.siemens.com/WW/view/de/11376409".

5
You have opened the "Printer Properties" dialog with the "Printer" icon.

Printer Language: |5l

Paort:

Metwork:

Paper Size:

® ®

Crrientation

@ Portrait O Landscape |_
[ Draft Mode [ calor

56 ol

Q

Selection field for the printer

Port selection box

Network address of the printer

Paper format selection box

Group orientation with radio buttons for print orientation
Print quality check box

CSNCNONCNCNONC)

Color printing check box

Proceed as follows:
1. Select a printer from the "Printer Language" selection box.
2. Select the port for the printer from the "Port" selection box.

3. If you wish to print via the network, enter the printer's network address in the "Network"
text box.

4. Select the paper format from the"Paper Size" selection box.
5. Activate a radio button in the "Orientation" group.
— "Portrait" for portrait

"Landscape" for landscape
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6.7 Changing HMI device settings

6. Select the print quality.
— Select the "Draft Mode" check box if you wish to print in draft mode.
— Deactivate the "Draft Mode" check box if you wish to print with higher quality.

7. If the printer selected can print in color and you wish it to do so, activate the "Color" check
box.

8. Confirm your entries.

The dialog closes.

Result

The settings for the printer have now been changed.
6.7.7 Enabling sound and setting sound volume
Introduction

You can activate an acoustic feedback for keyboard and touch screen operations. With each
touch or activation of a key, a sound is emitted.

Requirements

You have opened the "Volume & Sounds Properties" dialog, "Volume" tab with the

"Volume & Sounds" icon.

Volume & Sounds Properties m

Wolume | Sounds |

El Loud | Enable sounds for:
Ewents {warnings, beeps and syskem events)

?— Applications {program specific and all other sounds)

®

Motifications (alarms, appointments and reminders)

Enable clicks and taps
Hardware butkons @ Loud O Saoft
I:‘ Screen taps: @ Loud O Soft

©

@® @

Acoustic warnings and system events
Program-specific sounds

Notification sounds

Acoustic feedback when using keys
Acoustic feedback when using touch screen

®©@Oe 60600 0

Keys and controller for setting volume for the "Enable sounds for" group

Note

If you deactivate the settings under "Enable sounds for", no more acoustic signals will be
emitted during inadvertent operations.
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Procedure
Proceed as follows:
1. Activate the check boxes needed in the "Enable sounds for" group.
If no check boxes are activated, no acoustic feedback will be output.
2. If you want signaling for entries to be audible, activate the following check box:
— With key control: "Hardware buttons".
— With touch control: "Screen taps".
3. Use the "Loud" and "Soft" radio buttons to select between loud and quiet signaling.

4. If you want to change the volume for acoustic messages, use the controller or "Loud" and
"Soft" keys to do this.

5. Confirm your entries.

The dialog closes.

Result

The properties of the acoustic operation feedback are now set up.

6.7.8 Assigning sound to an event

Introduction

When acoustic feedback is activated, a sound is used to report an event. You can select the
sound to reflect the event.

Requirements

® A loudspeaker is connected to the HMI device.

® You have opened the "Volume & Sounds Properties”, dialog "Sound" tab with the

"Volume & Sounds" icon.

Volume & Sounds Properties m

Sour

Event Sound

o [ [ o] bl

Close Program

Scheme

¢ Critical Stop
%E Default Sound Idefault EI
Empty Recyde Bin
‘@5 Exclamnation

‘gave As...” Delete |
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6.7 Changing HMI device settings

Proceed as follows:

Procedure
1.
2.
3.
4.
Result

Select a suitable sound from the "Event" group.

The sound selected is displayed in the "Sound" group in the associated list box.

If you want to listen to the sound, press the " ™ |" button.

The sound is output by a loudspeaker connected to the HMI device. Use the L‘ button
to stop the output.

If you haven't managed to find a suitable sound, you can use the "Browse" button to
switch to a folder of your choice.

The sound selected is displayed in the "Sound" group in the associated list box.
Confirm your entries.

The dialog closes.

The sound is set for acoustic feedback on operations.

6.7.9 Restarting the HMI device

Introduction

The HMI device must be restarted in the following cases:
® You have activated or deactivated the PROFINET IO direct keys.

® You have changed the time zone setting

® You have changed the automatic daylight savings and standard setting

MP 377 (WIinCC flexible)

NOTICE

Data loss when the HMI device is restarted
All volatile data is lost when the HMI device is rebooted.

Check the following:
e The project on the HMI device is complete

¢ No data is being written to the flash memory
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Requirements

You have opened the "OP Properties", dialog "Device" tab with the "OP" { icon.

OP Properties

l Persiskent Skorage I Display

Device: MP 377 15" Touch
Image Yersion: V01.00,00,00_01.356
Bootloader Yersion: 0.2z

Bootloader Rel,Date: 22,2.2006

Flashsize: 64 MB
MaZ-Address: 03-00-06-29-d45-b5

Reboot : @

0] Button for restarting the HMI device

Procedure
1. If you want to restart the HMI device, press the "Reboot" button.

The following message is displayed:

ATTENTION!
@ If you execute this function, yvou lose all unsaved files, @

Please close all applications before rebooting.

Reboot now?

) If you run this function, all data which has not been backed up will be lost. Please close all
applications before restarting.

2. Confirm by clicking on Yes.

The HMI device restarts without delay. If you click on No, the message will be closed.
There will be no restart.

Result
The HMI device starts.
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6.7 Changing HMI device settings

6.7.10 Displaying information about the HMI device

Introduction

Requirements

See also

You will need the device-specific information if you contact A&D Technical Support.

You have opened the "OP Properties", dialog "Device" tab with the "OP" /J_P icon.

The following figure applies to the MP 377 15" Touch. The data displayed are device-specific
and may therefore deviate from that of your HMI device.

OP Properties

l Persiskent Skorage I Display

Device: MP 377 15" Touch —@

Image Yersion: V01.00,00,00_01.356 @

Bootloader Version: 022 @

Bootloader Rel,Date: 22,2.2006 @

Flashsize: 64 MB @

MaZ-Address: 03-00-06-29-d45-b5 @
Reboot : @

HMI device name

Version of the HMI device image

Version of the boot loader

Boot loader release date

Size of the internal flash memory in which the HMI device image and project are stored
MAC address of the HMI device

See "Restarting HMI device" chapter

CSNCONCONONCNONC)

The HMI device-specific information is displayed in the "Device" tab.

Note

The size of the internal flash memory does not correspond to the available working memory
for a project.

Restarting the HMI device (Page 107)
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6.7.11 Displaying system properties

Introduction

Requirements

The general system-specific information provides you with information about the processor,
operating system and memory.

)

You have opened the "System Properties", dialog "General" tab with the "System" -ﬁgv icon.

The data displayed are device-specific and may therefore deviate from that of your HMI
device.

System Properties m
General | Memary | Device Name |
System: Computer:
Microsoft@® WindowsE CE Processar Type: |Inte|, XScale-21341
Hetsiel S0 Expansion Slots: | El
@ 2004 Microsoft Corp. Al rights Mermary: 228036 KB RAM
reserved. This cormputer program is ) .
protected by LS, and international Registered to:
copyright lawes.

@ ®

0] Copyright to Microsoft Windows CE
® Details on processor and size of internal Flash memory

Displaying system properties

The system properties are displayed. This dialog is read-only. Close the dialog.

6.7.12 Displaying memory distribution

Introduction

110

The "Memory" system-specific information provides you with information about the
distribution and size of the memory in the HMI device.

NOTICE

"Memory" tab
Do not change the memory distribution in the "Memory" tab.

Applies for the usage of options:
An alteration to the memory distribution may be necessary. Please refer to the

accompanying documentation for further information.
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6.8 Setting storage location

Requirements

£

You have opened the "System Properties"”, dialog "Memory" tab with the "System" &2 icon.

General | Memory | Device Mame

Move slider to the left for more memory to run programs. Move slider to
the right for more storage room. Only unused RAM can be adjusted.

StDragE TN TR O T T T T T T T T T PP T R TN TR TR Ty Y Pmﬂ“
Memory ﬁiﬁ Memory
Allocated 16384KE Allocated 211740:B
In Use 100KE In Use 12344E

Procedure
1. Determine the HMI device's current memory structure
2. Close the dialog.

6.8 Setting storage location

Introduction

There are various storage locations available for storing the compressed source file of your
project. The following describes how you can set the storage location.

Requirements

=
You have opened the "Transfer Settings", dialog "Directories" tab with the "Transfer" g

icon.

Transfer Settings

Channel |-

Praject File
I'l,FIash'l,Simatic'l,

Project Backup
I'l,Storage Card MM\ Simatich,

Aukostart application:
Path: W ait [sec]:

I'l,FIash'l,Simatic'l,HmiRTm.exe |3 EI

©®

o Directory where the project file is saved
® Directory where the compressed source file of your project is saved
® Storage location and initialization file of the HMI device for process operation
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6.9 Setting the delay time

NOTICE

Settings under "Project File" and "Path”

The project may not open the next time the HMI device is started if changes are made in
the "Project File" and "Path" text boxes.

Do not change the entries in the "Project File" and "Path" text boxes.

Procedure
1. Select a memory location from the "Project Backup™ text box.

The external memory card or the location in the data network can be defined as the
storage location. During the next backup process, the project's source file is stored in the
specified location.

2. Confirm your entries.

The dialog closes.

Result
The storage location for the HMI device is now set.

6.9 Setting the delay time

Introduction

Once the HMI device has been switched on, a project can be started after a delay. The
Loader is displayed during the delay time.

Requirements

=
You have opened the "Transfer Settings", dialog "Directories” tab with the "Transfer" i

icon.

Transfer Settings

Project File
I'I,FIash'l,Simatic'l,

Project Backup
I'I,Storage Card MMCSimatich,

Autoskart application:
Path: Wit [sec]:

I'l,FIash'l,Simatic'l,HmiRTm.exe |3 EI
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Procedure

Result

See also

6.10

Introduction

6. 10 Setting the uninferruptible power supply

NOTICE

Settings under "Project File" and "Path"

The project may not open the next time the HMI device is started if changes are made in
the "Project File" and "Path" text boxes.

Do not change the entries in the "Project File" and "Path" text boxes.

1. Select the desired delay time in seconds from the "Wait [sec]" selection box.

With the value "0", the project starts immediately. It is then no longer possible to call the
Loader after switching on the HMI device. If you still wish to access the Loader, an
operating element must be configured to close the project.

2. Confirm your entries.

The dialog closes.

The delay time for the HMI device is now set.

Overview [(Page 142)

Setting the uninterruptible power supply

UPS monitoring is an option you load as an add-on with ProSave.

A UPS ensures that the HMI device is shut down in a controlled manner after a buffer time in
the event of a power failure. This avoids the loss of data.

The following uninterruptible power supplies are supported:
SITOP DC UPS modules as of a rated power value of 6 A, e.g. 6EP1931-2DC42

Connect the UPS to the 24-V input and a USB port. Configure the USB port for UPS
monitoring.
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6. 10 Setting the uninterruptible power supply

Requirements

M
You have opened the "UPS Properties”, dialog "Configuration" tab with the "UPS" _jfj icon.

Interface: USE

Battery mode

D Send "Shutdown” signals after | imr-l 5

Port disturbed

[send | Iﬂ after I min | g

COIOQ,

Text box for the time after which the "Battery mode activated" message is displayed
Check box for enabling battery mode
Text box for the time after which the "Faulty port" message is displayed

® e 00

Check box for the "Faulty port" message

Procedure
Proceed as follows:
1. If you want to enable battery mode, activate the "Battery mode" check box.
2. Enter the time for terminating applications in the "min" and "s" text boxes.

You will receive a message when UPS takes effect. Applications such as HMI Runtime
and WIinAC MP are then terminated depending on the time entered.

3. If the port to which the UPS is connected is faulty and you therefore want to receive a
message, activate the "Port disturbed" check box.

4. Select the message you want from the list box.

5. Enter the time after which the "Faulty port" message is displayed in the "min" and "s" text
boxes.

Result
Port monitoring for the UPS is set.

See also
State of uninterruptible power supply (Page 115)
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6. 11 State of uninferruptible power supply

6.11 State of uninterruptible power supply

Introduction
If you have connected a UPS to a USB port, you can display the monitoring state of this port.

Requirements
Moy

You have opened the "UPS Properties", dialog "Current status" tab with the "UPS" jj icon.

Corfiguation | Curtentstatus |

Current skakus:

UP3 programm is nok running. @

Update |

Mo current status available!

0] The "UPS program is not running. No current status available." message appears when the
UPS is not connected.

Procedure
Proceed as follows:
1. Installing the UPS monitoring software.
2. Connect the UPS.
3. If you want to update the monitoring state, press the "Update" button.

The message is changed according to the current setting. The message will remain
unchanged if no check boxes in the "Configuration" tab have been activated.

Result
The current monitoring state for the UPS is displayed.

See also
Setting the uninterruptible power supply (Page 113)
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6.12 Enabling PROFINET IO

6.12 Enabling PROFINET IO

PROFINET 10

If the HMI device is connected to the PLC via PROFINET, function keys or buttons, for
example, can be configured as PROFINET IO direct keys. If PROFINET IO direct keys are
used in the project, they must be enabled.

Note

If you enable PROFINET 10 direct keys, you cannot use the RS 422/RS 485 port for serial
communication.

PROFINET IO direct keys and PROFIBUS DP direct keys are mutually exclusive.

Requirements

You have opened the "PROFINET" dialog with the "PROFINET" ) icon.

®

[ PROFINET 10 enabled P

Device name: (max, 127 characters)

[MP-377-15-Zol-Touch — —@
MAC-Adress;  0B-D0-ab-ac-00-10 —@

® Activating or deactivating the PROFINET IO direct keys
@ Text box for the device name
® MAC address of the HMI device

NOTICE

Inconsistent device name

If the device name does not match the device name entered in the HW Config of STEP 7,
the direct keys do not work.

Use the device name from the HW Config of STEP 7. This device name does not
correspond to the device name used under Windows CE.
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6.13 Changing transfer settings

Within the ETHERNET data network, the device name must be unique and satisfy the DNS
conventions. These include:

® Restriction to 127 characters in total (letters, digits, hyphen or point)

® A name component within the device name, e.g. a string between two points, may not
exceed 63 characters.

® Special characters such as umlauts, brackets, underscores, slashes, spaces etc. are not
permitted. The hyphen is the one exception.

® The device name must not start or end with a the "-" character.
® The device name must not take the form n.n.n.n (n = 0 to 999).

® The device name must not start with the character sequence "port-xyz-" (x, y, z= 0 to 9).

Procedure
Proceed as follows:

1. If you want to enable the PROFINET 10 direct keys, activate the "PROFINET 10 enabled"
check box.

2. Enter the device name of the HMI device.
3. Confirm your entries.

The dialog closes.

Result
The PROFINET IO direct keys are enabled.

6.13 Changing transfer settings

6.13.1 Configuring the data channel

Introduction

If you block all data channels, the HMI device is protected against unintentional overwriting
of the project data and HMI device image.

Note

A project can only be transferred from the configuring PC to the HMI device when at least
one of the data channels is enabled on the HMI device.
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6.13 Changing transfer settings

Requirements
The "Transfer Settings" dialog, "Channel" tab has been opened with the

=g
"Transfer Settings" .5 icon.

Transfer Settings

Channel 1:
®

Serialivia R3232/PPI Mulki-Master Cable

[ Enable Channel [] Remote Control

Channel 2:
e @
ETHERMET

Enable Channel Remate Contraol Advanced @

0] Group for the data channel 1 (Channel 1)
® Group for the data channel 2 (Channel 2)
® Button for the "MPI/DP-Transfer Settings" and/or "Network and Dial-Up Connections" dialog

A warRniNG

Unintentional transfer mode

Unintentional transfer mode could cause unintentional actions to be triggered in the plant.

Ensure that the configuring PC does not inadvertently switch the HMI device to transfer
mode during the open project.

NOTICE

"Remote control" for "Channel 1"

If the "Remote Control" check box is activated during "Online" operating mode, the X10 port
cannot be used for communication.

The "Remote Control" check box must be deactivated for "Online" operating mode. Once
the serial transfer is complete, in the "Channel 1" group you must therefore deactivate the
"Remote Control" check box.

Transfer mode using "Channel 2"

When the project on the HMI device starts, transfer parameters, e.g. HMI device address,
for MPI/PROFIBUS DP are overwritten with the values from the project.

You can change the settings for the transfer via "Channel 2".

The following steps are required:

¢ Close the project.

e Change the settings on the HMI device.
e Then return to "Transfer" mode.

The next time the project is started on the HMI device, the settings will be overwritten by
the values from the project.
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Procedure

Result

See also

6.13 Changing transfer settings

Note

If the HMI device is in "Transfer" mode while changes are made to the transfer settings, the
settings only go into effect after the transfer function is restarted.

This may occur if the Control Panel is opened to change the transfer properties in an active
project.

Proceed as follows:

1. If you want to enable a data channel, activate the "Enable Channel" check box in the
"Channel 1" or "Channel 2" group.

In the "Channel 1" group, the RS-422/RS-485 port is enabled for the serial data transfer.
The network port is enabled in the "Channel 2" group.

2. If you want to enable the automatic transfer, activate the associated "Remote Control"
check box.

3. If you have enabled the data channel for "Channel 2", select the log from the selection
box.

4. Enter further parameters if required.
Applies to "MPI/PROFIBUS DP":

— Use the "Advanced" button to switch to the "S7-Transfer Settings" dialog. You can
change the settings for MPI/PROFIBUS DP there.

— Confirm your entries.
— The dialog "S7-Transfer Settings" is closed.
Applies to "ETHERNET":
— Use the "Advanced" button to change to "Network&Dial-Up Connections".
— Open the "ERTEC400" entry. You can change the TCP/IP settings there.
— Confirm your entries.
— Close "Network&Dial-Up Connections".
Applies to "USB":
— No settings are needed for "USB".
5. Confirm your entries.

The dialog closes.

The data channel is configured.

Overview (Page 142)

Backup and restore using WinCC flexible (Page 149)
Backup and restore using ProSave (Page 151)
Changing MPI/PROFIBUS DP settings (Page 120)
Changing the network configuration (Page 126)
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6.13 Changing transfer settings

6.13.2 Changing MPI/PROFIBUS DP settings

Introduction
The communication settings for MPI or PROFIBUS DP are defined in the HMI device project.

In the following cases, the transfer settings might have to be changed:
® The first time the project is transferred

e [f changes are made to the project but are only applied later

NOTICE
Transfer mode using MPI/PROFIBUS DP
The bus parameters are read from the project currently loaded on the HMI device.

The settings for MPI/PROFIBUS DP transfer can be modified. The following steps are
required:

¢ Close the project.
e Change the settings on the HMI device.
e Then return to "Transfer" mode.

The changed MP/PROFIBUS DP settings will be overwritten in the following cases:

e The project is started again
e A project is transferred and started

Transfer settings

If the HMI device is in "Transfer" mode while changes are made to the transfer settings,
the settings only go into effect after the transfer function is restarted.

Requirements

You have opened the "S7-Transfer Settings" dialog with the "S7-Transfer Settings" ﬁ.ﬂ icon.

S7-Transfer Settings m

W——@
—®

‘ Propetties. .. ——

©) Network selection
® Button for opening the properties dialog
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6.13 Changing transfer settings

Procedure
Proceed as follows:
1. Select a network.
2. Use the "Properties" button to open the "MPI" or "PROFIBUS" dialog.

MPI ok

Skation Parameters
[ Panel is the only master on the bus

Address: 1

)

@® ® |

Tirme-outk: 1s [l
Mekwork. Pararmeters

Transmission Fate: 187,5 kbitsis 5

Highest Station 126 =

PROFIBUS ok}

Skation Parameters
[ Panel is the only master on the bus

Address: 45

Time-out: 1s

@
= ®
Metwiork Parameters
Transmission Rake: 12 Mhikss = @
Highest Station Address: |16 [l @
Profile DF i 6
Eus Parameters.. ! 7
O] The HMI device is the only master on the bus.
® Bus address of the HMI device
® Time-out
@ Data transmission rate in total network
® Highest station address in the network
® Profile
@) Button for displaying the bus parameters

3. If there are several masters connected on the bus, deactivate the "Panel is the only
master on the bus" check box.

4. Enter the bus address for the HMI device in the "Address" text box.

NOTICE

The bus address in the "Address" text box must be unique throughout the
MPI/PROFIBUS DP network.

5. Select the transmission rate from the "Transmission Rate" text box.

6. Enter the highest station address on the bus in the "Highest Station Address" or "Highest
Station" text box.
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6.13 Changing transfer settings

Result

See also

122

7. Select the desired profile from the "Profile" selection box.

8. If you want to view the profile data, press the "Busparameter" button of the PROFIBUS

dialog.

The profile data are displayed. The "Profile" dialog is read-only.

NOTICE

network.

The bus parameters must be the same for all stations in the MPI/PROFIBUS DP

Tslot:

Min Tsdr:
Max Tsdr:
Teet:
Tqui:

Gap factor

Retry limit:

it
it
it
it
it

Trdy;
Tid1:
Tidz:

11 it
37 1Bt
150 tBit

9. Close the "Profile" dialog.

10. Confirm your entries.

The dialog closes.

The MPI/PROFIBUS DP settings of the HMI device have been changed.

Configuring the data channel (Page 117)
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6.14

6.14.1

Introduction

Addressing

6. 14 Configuring network operation

Configuring network operation

Overview of network operation

You can connect the HMI device to a PROFINET network via the Ethernet port.

NOTICE
The HMI device can only be used in PROFINET networks.

The HMI device only has client functionality in the PC network. This means that users can
access files of a node with TCP/IP server functionality from the HMI device via the network.
However, you cannot, for example, access data on the HMI device from a PC via the
network.

Note

Information on communication using SIMATIC S7 via PROFINET is provided in the
"WinCC flexible communication" user manual.

The connection to a network offers, for example, the following options:

® Printing via a network printer

® Saving, exporting and importing of recipe data records on or from a server
® Setting up of message and data archives

e Transferring a project

® Saving data

Within a PROFINET network, computers are usually addressed using computer names.
These computer names are translated from a DNS or WINS server to TCP/IP addresses.
This is why a DNS or WINS server is needed for addressing via computer names when the
HMI device is in a PROFINET network.

The corresponding servers are generally available in PROFINET networks.

Note
The use of TCP/IP addresses to address PCs is not supported by the operating system.

Consult your network administrator if you have questions in this regard.
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6. 14 Configuring network operation

Printing via a network printer

The HMI device's operating system does not support line by line alarm logging via a network
printer. All other printing functions, for example hardcopy or logs are available without
restriction via the network.

Preparation

Before beginning the configuration, request the following network parameters from your
network administrator.

® Does the network use DHCP for dynamic assignment of network addresses?
If not, get a new TCP/IP network address for the HMI device.

o Which TCP/IP address does the default gateway have?

o |f a DNS network is used, what are the addresses of the name server?

e [f a WINS network is used, what are the addresses of the name server?

General procedure for configuring the network

The HMI device must be configured prior to network operation. The configuration is basically
divided into the following steps:

Proceed as follows:

1. Enter the computer name of the HMI device.
2. Configure the network address.

3. Set the logon information.
4

. Save the settings.
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6. 14 Configuring network operation

6.14.2 Setting the device name of the HMI device

Introduction
The HMI device uses the device name to identify itself in the communication network.

Requirements

£

You have opened the "System Properties”, dialog "Device Name" tab with the "System" &7

icon.

System Properties m

These settings are used to identify your Windows CE device to
other cormputers.
Please type a name (without any spaces) and a short description.

Device name: s MEERE)

@
Device description: [HMI Device —_@

0] Device name of the HMI device
® Description for the HMI device (optional)

Note

To activate the network functions, enter a unique computer name in the "Device name" text
box.

Procedure
Proceed as follows:
1. Enter the device name for the HMI device in the "Device name" text box.
2. If necessary, enter a description for the HMI device in the "Device description" text box.
3. Confirm your entries.
The dialog closes.
Result

The device name for the HMI device is now set.
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6. 14 Configuring network operation

6.14.3 Changing the network configuration

Introduction

Requirements

Procedure

126

You can change the network settings for the LAN connection under "Network&Dial-
Up Connections".

You have opened the following display using the "Network&Dial-Up Connections" ‘! icon.

EE

File Edit view Advanced || Bl
o|
A
-—I-l

ERTEC400

[

Proceed as follows:
1. Open the "ERTEC400" entry.
The "ERTEC400 Ethernet Driver' Settings" dialog is opened.

"ERTEC400 Ethernet Driver’ Settings o] x |

IP Address |'Name Sarvers |

An IP address can be (") Obtain an IP address via DHCP
autornatically assigned to this ;
computer, If your network
does not autornatically assign

IF addresses, ask your network IP Address: 85108 26 258

i

administrator for an address, Subret Mask: 55 255 255 .0
and then type it in the space
provided, Default Gateway: III

2. If you need automatic issuing of addresses, select the "Obtain an IP address via DHCP"
radio button.

3. If you need manual issuing of addresses, select the "Specify an IP address" radio button.

4. If you have selected manual issuing of addresses, enter the corresponding addresses in
the "IP Address", "Subnet Mask" text boxes and if necessary in "Default Gateway".

5. If a name server is used in the network, change to the "Name Servers" tab.

"ERTEC400 Ethernet Driver’ Settings o] x |

| 1P Address | Name Servers |

MName server addresses may be  Primary DINS: D
autornatically assigned if DHCP

is enabled on this adapter, Secondary DMS: III
You can specfy additional

WINS ar DRS resolvers in the Reinaty b III

6. Enter the respective addresses in the text boxes.
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6. 14 Configuring network operation

7. Confirm your entries.
The dialog closes.
8. Close the "Network&Dial-Up Connections" display.

The Control Panel is displayed again.

Result
The LAN connection parameters for the HMI device have been changed.

See also
Configuring the data channel (Page 117)

6.14.4 Changing the logon data

Introduction

Windows CE uses this information to gain access to the network resources. Enter the user
name, password and domain you have received from your administrator.

Requirements

]
You have opened the "Network ID" dialog with the "Network ID" =&, icon.

Network ID m
Identification |

Windows CE uses this Usar name: |
information to gain access to
retwork resources, Enter the  Password: |
Liser name, password, and
domain provided by your Darnain: |
retwork administrator,

Procedure
Proceed as follows:
1. Enter the user name in the "User name" text box.
2. Enter your password in the "Password" text box.
3. Enter the domain name in the "Domain" text box.
4. Confirm your entries.

The dialog closes.
Result

The logon information has now been set.
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6. 14 Configuring network operation

6.14.5 Changing e-mail settings

Requirements
You have opened the "WIinCC flexible Internet Settings" dialog with the
"WinCC Internet Settings" icon.

WinCC flexible Internet Settings m

SMTP server ﬁ
@ IJse the default of the project file e

Ol L L e
RE

Sender: |5irnatic HMI Dewvice —4@
Authentication: | —4@

0] Setting the SMTP server

® Name for the sender
® E-mail account
Note

Additional tabs may appear in the "WinCC flexible Internet Settings" dialog. This depends on
the options that have been enabled for network operation in the project.

Procedure
Proceed as follows:
1. Specify the SMTP server.
— Activate the "Use the default of the project file" radio button if you want to use the
SMTP server configured in the project.
— Deactivate the "Use the default of the project file" radio button if you do not want to
use the SMTP server configured in the project. Specify the required SMTP server.
2. Enter the name for the sender in the "Sender" text box.
3. Enter the e-mail account for your e-mail in the "Authentication" text box.
Some e-mail providers only allow you to send mail if you specify the e-mail account. The
"Authentication” text box can remain empty if your e-mail provider allows you to send mail
without checking the account.
4. Confirm your entries.
The dialog closes.
Result

The e-mail settings have been changed.
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6. 14 Configuring network operation
6.14.6 Changing Internet settings
6.14.6.1  Changing general Internet settings

Requirements

You have opened the "Internet Options", dialog "General" tab with the "Internet Options" i"

icon.

Internet Options m

G3eneral |C0nnecti0n I Privacy Iﬁdvanced I

Start Page: Ihttp:ﬂwww.siemens.cumfautnmatinn

Search Page: Ihttp:ﬂwww.siemens.cumfautumatiunfservice

User Agent: (requires browser restart): IDefauIt (windows CE) El
Cache Size (in KB): |512 |Clear Cache | |Clear Histuryl
Note

Do not change the settings in the "User Agent" field.

Procedure

Proceed as follows:
Enter the homepage for the Internet browser in the "Start Page" text box.
Enter the address of the required search engine in the "Search Page" text box.
Enter the required cache memory size in the "Cache" text box.
If you want to delete the cache memory, press the "Clear Cache" button.

If you want to delete the history, press the "Clear History" button.

I

Confirm your entries.

The dialog closes.

Result
The general parameters for the Internet browser have been set.
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6. 14 Configuring network operation

6.14.6.2 Setting the proxy server

Requirements

Procedure

You have opened the "Internet Options", dialog "Connection" tab with the

"Internet Options" ) icon.

Internet Options m
- Connectian |Pri\tacy | sdvanced |
[[]Use L&N (no autodial)  Autodial name: | El
Network

|:| #rcess the Internet using a proxy server:

Address: I Paort: IBEI

|:| Bypass prowy server for local addresses

Proceed as follows:
1. Select the "Use LAN (no autodial)" check box.

2. If you are using a proxy server, in the "Network" group, activate the
"Access the Internet using a proxy server" check box.

Specify the address of the proxy server and the port.

3. If you want to bypass the proxy server for local addresses, activate the
"Bypass proxy server for local addresses" check box.

4. Confirm your entries.

The dialog closes.

6.14.6.3 Changing privacy settings

Cookies and encryption

130

Cookies are pieces of information sent by a web server to a browser. In the event of
subsequent access to the web server, the cookies are sent back. This enables information to
be stored between the accesses.

In order to ensure a high level of privacy, data are sent via the Internet in encrypted form.
Common encryption protocols include SSL and TLS. You can activate or deactivate the
usage of encryption protocols.

The required settings can be obtained from your network administrator.
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Requirements

6. 14 Configuring network operation

You have opened the "Internet Options" dialog, "Privacy" tab with the "Internet Options" i"

icon.

Internet Options

| General | Connection | Privacy | advanced |

CX E3

Cookies

First-party Cookigs Third-party Cookies

: () Bccept
) Block { ) Black
) Prompt @ Prompt

Ahways allow session cookies

Procedure
Proceed as follows:

1. Select the required cookie behavior by means of the radio buttons.

"Accept”

Cookies are stored without request.
- "Block"

Cookies will not be stored.
- "Prompt"

Cookies will be stored on request.

2. If you want allow cookies which are restricted to a single session, activate the

"Always allow session cookies" check box.

3. Change to the "Advanced" tab.

Internet Options

[General I Connection I Privacy | Advanced |

CX E3

m_'@.;"
Use S5L 2.0
Use S5L 3.0
Use TLS 1.0

warn if changing between secure and not secure mode

4. Activate the required encryption protocol.
5. Confirm your entries.

The dialog closes.

Result
The logon information has now been set.
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6. 14 Configuring network operation

6.14.6.4 Importing and deleting certificates

Overview

You can import, view and delete certificates that have been imported for the HMI device. The
certificates differ in the following ways:

e (Certificates that you trust

® Own certificates

® Other certificates

You can import additional certificates and delete certificates that are not required.

The required settings can be obtained from your network administrator.

Requirements

You have opened the "Certificates" dialog with the "Certificates" icon.

Stares |

Class 2 Public Prirnary Certification Authority E
Class 3 Public Prirnary Certification Authority
Entrust.net Certification authority (2048) l
Entrust.net Secure Server Certification Authorit
Lists the cettificates Equifax Secure Certificate Authority

trusted by you GlobalSign Root C& E|

Import.. || View.. || Remove |

Procedure
Proceed as follows:
1. Select the type of certificate from the selection box:
"Trusted Authorities"
"My Certificates"
"Other Certificates"
2. If required, start the importing process with the "Import" button.
A dialog with source details will open.
3. If required, delete certificates with the "Remove" button.
Mark the desired certificate.
4. If you want to list the properties of the certificate marked, press the "View" button.
5. Confirm your entries.
The dialog closes.
Result

The changes to the certificates have been undertaken.
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6. 15 Saving to external storage device (backup)

6.15 Saving to external storage device (backup)

Introduction

A backup involves copying the operating system, applications and data from the internal in
flash memory of the HMI device to an external storage device.

The following external storage devices are possible:
e External memory

e USB memory stick

Requirements

e The HMI device features an external storage device with sufficient free space.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup [ Restore

all other application rust be ended before
starting <BACKUP= or <RESTORE:=.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

Procedure - using a memory card for the first time

NOTICE

Loss of data possible

The first time you use a memory card the HMI device will request that you format the card.

Save a backup copy of memory card data to a PC before formatting.

Proceed as follows:

1. Cancel the formatting procedure by pressing "ESC".
Remove the memory card from the HMI device.
Save a backup copy of vital data to a PC.

Insert the memory card into the HMI device.

o > wDn

Format the memory card on the HMI device.
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6.15 Saving to external storage device (backup)

Procedure

Result

134

Proceed as follows:

1.

Press the "BACKUP" button to open the "Select Storage Card" dialog.

The "--- no storage card available ---" message appears if there is no external memory in
the HMI device or if this memory is defective. Insert an external memory or a different
one.

2. Select the external memory for backup from the "Please select a Storage Card" list box.
3. Click on the "Start Backup" button.

The HMI device checks the external memory.

If the "This storage card..." message appears, an external memory with a greater memory
capacity is needed. Acknowledge this message. Backup is aborted. Insert an external
memory with a greater memory capacity and restart the backup process.

If the "You may have an old backup on the storage card. Do you want to delete it?"
message appears, there is already a backup on the external memory. If you do not want
to overwrite the backup, press the "No" button. Otherwise click on the "Yes" button.

Several messages are displayed in sequence during the backup process:
— Saving registry data
— Copy files

A progress bar shows the status of the backup process. When the backup process is
completed, the following message is displayed:

"The operation completed successfully."

. Acknowledge this message.

The dialog closes.

The HMI device data is now saved on the external memory.
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6. 16 Restoring from external sforage device

6.16 Restoring from external storage device

Introduction

A restore operation deletes the old data from flash memory of the HMI device on
confirmation. The data stored on the external memory is then copied to the internal flash
Flash memory.

Requirements

® The external memory holding the backed up data is inserted in the HMI device.

® You have opened the "Backup/Restore" dialog with the "Backup/Restore" @ icon.

Backup f Restore

&l ather application must be ended before
starting <BACKUP= or <RESTORE:=.

Backup (to storage card)

BACKUP

Restore (from storage card)

RESTORE

NOTICE

Loss of data possible

All data on the HMI device will be deleted during a restore operation. License keys are
deleted after counter-inquiry.

Back up the HMI device's data before restoring if required.
External memory with data backup

If several external memories with data backups are plugged in, the data cannot be
restored.

Remove the external memory with the data backups not needed.
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Configuring the operating system

6. 16 Restoring from external storage device

Procedure
Proceed as follows:
1. Press the "RESTORE" button to open the "Storage Card" dialog.

Storage Card m

Storage Card with Backup detected:
--- no storage card available - @

Dl one Storage Card containing Backup is allowed.
Mo Storage Card detected, please insert Storage @
Card and press <Refreshiz.

| Cancel |

) No storage card available

Start Hestore

® Only one storage card containing backup is allowed. No storage card detected. Insert a
storage card and press the "Refresh" button.

2. Select the external memory with the backup from the "Storage Card with Backup
detected" selection box.

The "--- no storage card available ---" message appears if there is no external memory in
the HMI device or if this memory is defective.

3. If the --- no storage card available --- message appears, press the "Cancel" button.
Restoring is then aborted.
— Insert a memory card or a different one.
— Click on the "Refresh" button.
The content of the selection box will be changed.

— Select the external memory with the backup from the "Storage Card with Backup
detected" selection box.

4. Click on the "Start Restore" button.
Restoring is started.
5. The data to be restored is checked.
The following messages are displayed in sequence during the check.
"Starting Restore"
"Checking data"
When the data has been checked, the following message is displayed:

"You are starting RESTORE now. All files (except files on storage cards) and the registry
will be erased. Are you sure?"

The message means that the restore process can be started. All files files except those
located on the external memory will be deleted. Tab entries are also deleted. Are you
sure?
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Configuring the operating system

6.17 Activate memory management

If you do not want to allow the data to be deleted from the HMI device, abort the restore
process by pressing the "ESC" button.

Start to restore the data by selecting "Yes".

The following messages are displayed in sequence during the restore:
"Deleting files on flash”
"Restore CE Image"

A progress bar shows the status of the restore process.

When restore is completed, the following message is displayed:

"Restore succesfully finished. Press ok, remove your storage card and reboot your
device."

8. Remove the external memory.

9. Acknowledge this message.

Result

The HMI device starts.

The data from the external memory is now on the HMI device.

Note
Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.

6.17 Activate memory management

Memory management

Provided the memory management is activated, the HMI device will automatically close the
project if the memory needs reorganizing during an active project.

The project is shut down and the HMI device will display a message. You have to restart the
project.

NOTICE

Memory management

of the project.
Active memory management from the "OP Properties" dialog.

If you do not activate memory management, undefined states can occur during the runtime

MP 377 (WIinCC flexible)

Operating Instructions, 09/2007, 6AV6 691-1DR01- C S@ 137
VICPAS
VICPAS" g

Everg,-'thin? for your HMI running
B sales@vicpas.com

O +86-15876525394



Configuring the operating system
6.17 Activate memory management

Requirements

You have opened the "OP Properties", dialog "Memory Monitoring" tab with the "OP" 4@

icon.

OP Properties

| Displsy | Device | Touch | Memory Monitoring

Maximurm used memary: 5%

Current used memary: S%

D Shut dowwn HMI Runkine if memory is running low,

49@@

0] Maximum memory used since the HMI device was last switched on
® Percentage of memory currently used
® Activate memory management

Procedure
Proceed as follows:
1. If you want to enable memory management, activate the check box.
If memory management is active and there is not enough working memory, the
SIMATIC HMI runtime and therefore the current project will be closed.
2. Confirm your entries.
The dialog closes.
Result

Memory management is activated.
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Commissioning a project 7

7.1 Overview

Configuration phase

A project — the process image of the working process — is produced during configuration to
visualize automated working processes. The process displays for the project contain
displays for values and messages which provide information about process statuses. The
process control phase follows the configuration phase.

Process control phase

The project must be transferred to the HMI device if it is to be used in process control.
Another precondition for process control is that the HMI device is connected online to a
controller. Current working processes - operating and observing - can then be subject to
process control.

Transferring the project to the HMI device
You can transfer a project to an HMI device as follows:
® Transfer from the configuring PC
® Restore from a PC using ProSave

In this case, an archived project is transferred from a PC to the HMI device. The
configuration software need not be installed on this PC.

Commissioning and recommissioning
Initial and re-start-ups differ in the following respects:
® \When the HMI device is commissioned there is no project at first.
The HMI device is also in this state after the operating system has been updated.

® \When recommissioning, any project already on the HMI device is replaced.
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Commissioning a project

7.2 Operating modes

7.2 Operating modes

Operating modes
The HMI device may be in the following operating modes:
e Offline
® Online
® Transfer

"Offline mode" and "Online mode" can be set on both the configuring PC and the HMI
device. To set these modes on the HMI device, use a corresponding operating element of
the project.

Changing the operating mode

The configuration engineer must have configured an appropriate operating element to allow
a change of the operating mode on the HMI device during ongoing operation.

Further information on this may be available in your plant documentation

"Offline" operating mode

In this mode, there is no communication between the HMI device and PLC. Although the
HMI device can be operated, it cannot exchange data with the PLC.

"Online" operating mode

In this mode, the HMI device and PLC communicate. You can operate the plant on the HMI
device according to your system configuration.

"Transfer" mode

In this mode, you can transfer a project from the configuring PC to the HMI device or backup
and restore HMI device data, for example.

The following options are available for setting "Transfer" mode on the HMI device:
® \When the HMI device starts up

Start "Transfer" mode manually in the HMI device Loader.
e During ongoing operation

Start the "Transfer" mode manually within the project using an operating element. The
HMI device toggles to "Transfer" mode when automatic mode is set and a transfer is
initiated on the configuring PC.

See also
Backup and restore using WinCC flexible (Page 149)

Backup and restore using ProSave (Page 151)
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Commissioning a project

7.3

Using existing projects

7.3 Using existing projects

The following table shows how you can reuse existing projects, while observing the screen
size:

HMI device in the existing project

New HMI device

MP 370 12" Touch

MP 377 12" Touch

MP 370 12" Key

MP 377 12" Key

MP 370 15" Touch

MP 377 15" Touch

The following cases are possible:

1. Project exists in ProTool

Migrate the project to WinCC flexible and subsequently carry out an HMI device switch.

Project exists in WinCC flexible

Carry out an HMI device switch in WinCC flexible.

If you migrate existing projects from HMI devices with a different screen size, images which

have already been configured are converted during the migration.

Further information on the subject can be found in the WinCC flexible Online Help or in the
"WinCC flexible Migration" manual.

74 Data

Overview

transmission options

The following table shows the options for data transfer between the MP 377 and the
configuring PC.

Type Data channel MP 377

Backup Serial " Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes

Restoring Serial » Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes

Updating the operating system Serial 1) Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes
PROFINET with restore to Yes
factory setting
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7.5 Transfer

See also

Type Data channel MP 377
Transferring a project Serial » Yes
MPI/PROFIBUS DP Yes
uUsB 2 Yes
PROFINET Yes
Installing or removing an option Serial 1) Yes
MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes
License key transferring or Serial » Yes
transferring back MPI/PROFIBUS DP Yes
USB Yes
PROFINET Yes

R Applies when PC/PPI cable 6ES7 901-3CB30-0XA0 is used
2) You must not connect the HMI device to a USB 2.0 hub.

Overview (Page 142)
Backup and restore using WinCC flexible (Page 149)

Backup and restore using ProSave (Page 151)

7.5 Transfer

7.51 Overview

Transfer

Backtransfer

142

Transfer the executable project from the configuring PC to the HMI device.
You can start the "Transfer" mode manually or automatically on the HMI device.

Transferred data is written directly to the internal flash memory on the HMI device. For the
transfer, you use a data channel which you have to configure before starting a transfer.

You have the option to transfer the compressed project file together with the runtime project
to the HMI device. If necessary, the compressed project file can be transferred back to the
configuring PC and edited.

The HMI device must be equipped with an external memory card to which the compressed
project file can be saved.

MP 377 (WIinCC flexible)

C S@ ating Instructions, 09/2007, 6AV6 691-1DR01-0ABO
VICPAS
‘:om _|

Everg,-'thin? for your HMI running
B sales@vicpas.com

O +86-15876525394



Commissioning a project

7.5 Transfer

NOTICE

Compressed project file

WinCC flexible does not check whether the compressed project file stored on the HMI
device corresponds to the existing runtime project.

See also
Setting the delay time (Page 112)
Configuring the data channel (Page 117)
Data transmission options (Page 141)

7.5.2 Starting manual transfer

Introduction

You can manually switch the HMI device to "Transfer" mode as follows:
® With a configured operating element during ongoing operation.
® In the Loader of the HMI device.

Requirements
® The project "*.hmi" is opened in WinCC flexible.
e The HMI device is connected to a configuring PC.
® The data channel is configured on the HMI device.

® The HMI device is in "Transfer" mode.

Procedure
Proceed as follows:

1. On the configuring PC, select the "Transfer settings" command in the menu "Project >
Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the
HMI device:

Select the "Enable backtransfer" check box.
6. Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The project is transferred to
the HMI device. If the connection is not available or is defective, an error message is
displayed on the configuring PC.
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7.5 Transfer

Result
When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

753 Starting automatic transfer

Introduction

Requirements

144

If automatic transfer is activated, the HMI device automatically changes into "Transfer" mode
during operations as soon as a transfer starts on the configuring PC connected.

Note

With automatic transfer, the HMI device only changes into "Transfer" mode when the project
is running on the HMI device.

Automatic transfer is particularly suited for the test phase of a new project since transfer is
completed without interfering with the HMI device.

NOTICE

If the automatic transfer has been activated on the HMI device and a transfer is initiated on
the configuring PC, the project currently running is automatically stopped. The HMI device
then automatically switches to "Transfer" mode.

After the commissioning phase, deactivate the automatic transfer so that the HMI device
cannot be inadvertently switched to transfer mode. The transfer mode can trigger
unintentional actions in the device.

You can issue a password in the control panel to restrict access to the transfer settings and
thus avoid unauthorized modifications.

® The project *.hmi is opened in WinCC flexible.

® The HMI device is connected to a configuring PC.

® The data channel is configured on the HMI device.

® The automatic transfer is activated in the data channel for the transfer.

® The project is started on the HMI device.
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Commissioning a project

Procedure

7.5 Transfer

Proceed as follows:

1.

On the configuring PC, select the "Transfer settings" command in the menu "Project >
Transfer" in WinCC flexible.

The "Select devices for transfer" dialog opens.

2. Select the HMI device in the left area of the dialog.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Set the transfer parameters in the right area of the dialog.

5. If you wish to transfer the compressed project file together with the runtime project to the

Result

HMI device:

Select the "Enable backtransfer" check box.

. Start transfer in WinCC flexible with "Transfer".

The configuring PC checks the connection to the HMI device. The HMI device shuts
down the current project and automatically switches to "Transfer" mode The project is
transferred to the HMI device. If the connection is not available or is defective, an error
message is displayed on the configuring PC.

When the transfer is completed successfully, the project can be found on the HMI device.
The transferred project is then started automatically.

754 Starting backtransfer

Requirements

MP 377 (WIinCC flexible)

No project is open in WinCC flexible.

The HMI device is connected to a configuring PC.
The data channel is configured on the HMI device.
The HMI device is in "Transfer" mode.

The memory card containing the compressed project file is inserted into the HMI device.
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Commissioning a project

7.5 Transfer

Procedure

Result

7.5.5

Introduction

146

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Transfer" > "Backtransfer" command in the "Project" menu.

The "Backtransfer" dialog opens.
Click "OK" to start the backtransfer process.

The configuring PC checks the connection to the HMI device. The compressed project file
is transferred back from the HMI device to the configuring PC. If the connection is not
available or is defective, an error message is displayed on the configuring PC.

After successful backtransfer, the project is opened on the configuring PC in WinCC flexible.

Testing a project

There are two options to test a project:

Test the project on the configuring PC

You can test a project at a configuring PC, using a simulator. For detailed information,
refer to the "WinCC flexible" user manual and to the WinCC flexible Online Help.

Offline testing of the project on the HMI device

Offline testing means that communication between the HMI device and PLC is down
while the test is being carried out.

Online testing of the project on the HMI device

Online testing means that the HMI device and PLC communicate with each other during
testing.

Perform the tests, starting with the "Offline test", followed by the "Online test".

Note

You should always test the project on the HMI device on which the project will be used.
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Commissioning a project

7.5 Transfer

Check the following:

1. Check the correct layout of the screens

2. Check the screen navigation

3. Check the input objects

4. Enter the tag values

The test increases the certainty that the project will run error-free on the HMI device.

Requirements for offline testing

Procedure

® The project has been transferred to the HMI device.

o The HMI device is in "Offline" mode.

In "Offline" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags, therefore, are not updated.

Test the operating elements and visualization of the project as far as possible without
connecting to the PLC.

Requirements for online testing

Procedure

® The project has been transferred to the HMI device.

® The HMI device is in "Online" mode.

In "Online" mode, you can test individual project functions on the HMI device without them
being affected by the PLC. PLC tags are updated in this case.

You have the option to test all communication-dependent functions, for example alarms, etc.

Test the operating elements and views of the project.
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Commissioning a project

7.6 Backup and restore

7.6 Backup and restore

7.6.1 Overview

Backup and restore

You can back up and restore the following data found in the internal flash memory of the HMI
device with a PC:

® Project and HMI device image
® Password list
® Recipe data

® |License keys

Note
When using WinAC MP, the transfer parameters are not backed up!

Use one of the following tools for backup and restore:
e WinCC flexible

® ProSave

Note
Alternatively, use the control panel to back up to an external memory device.

General information

NOTICE

Power failure

If a complete restore operation is interrupted due to power failure on the HMI device, the
operating system of the HMI device may be deleted! In this case, you have to reset the HMI
device to its factory settings.

Compatibility conflict

If a message is output on the HMI device warning of a compatibility conflict during the
restore operation, the operating system must be updated.

See also

Saving to external storage device (backup) (Page 133)
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Commissioning a project
7.6 Backup and restore

7.6.2 Backup and restore using WinCC flexible

Requirements
® No project is open on the configuring PC in WinCC flexible.
® The HMI device is connected to this configuring PC.

® The data channel is configured on the HMI device.

Procedure for backup
Proceed as follows:

1. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

4. Close the dialog with "OK".

5. Select the "Backup" command in the menu "Project > Transfer" in WinCC flexible.
The "Backup Settings" dialog opens.

6. Select the data to be backed up.

7. Select a destination folder and a file name for the "*.psb" backup file.

8. Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

9. Start the backup operation in WinCC flexible with "OK" on the configuring PC.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

Result
The system outputs a message when the backup is completed.
The relevant data is now backed up on the configuring PC.
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7.6 Backup and restore

Procedure for restore

Proceed as follows:

1.

o a ko N

Result

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.
Set the connection parameters.

Close the dialog with "OK".

Select the "Restore" command in the menu "Project > Transfer" in WinCC flexible.
The "Restore Settings" dialog opens.

Select the "*.psb" backup file to be restored from the "Open" field.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

. Start the restore operation in WinCC flexible with "OK" on the configuring PC.

If there are license keys both on the HMI device and in the backup, a dialog will appear.
Use this dialog to establish whether you want to overwrite the license keys or abort the
restore process.

— If necessary, abort the backup and first back up the HMI device's license keys.
— Then restart the restore process.
Follow the instructions in WinCC flexible.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the configuring PC is
now on the HMI device.

See also

Transferring and transferring back license keys (Page 163)

Configuring the data channel (Page 117)

Operating modes (Page 140)

Data transmission options (Page 141)
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7.6 Backup and restore

7.6.3 Backup and restore using ProSave

Requirements

o The HMI device is connected to a PC on which ProSave is installed.

® The data channel is configured on the HMI device.

Procedure for backup
Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.
Select the type of connection between the HMI device and the PC.

Set the connection parameters.

4. Select the data to be backed up in the "Backup" tab.

5. Select a destination folder and a file name for the "*.psb" backup file.

6. Set "Transfer" mode on the HMI device.

Result

If automatic transfer mode is enabled on the HMI device, the HMI device automatically
sets "Transfer" mode when a backup is initiated.

Start the backup operation in ProSave with "Start Backup".
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

The system outputs a message when the backup is completed.

The relevant data is now backed up on the PC.
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7.6 Backup and restore

Procedure for restore
Proceed as follows:

1.

o~ e

Result

From the Windows Start menu, start ProSave on the PC.

Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC.
Set the connection parameters.

Select the "*.psb" backup file to be restored from the "Restore" tab.

You can see the HMI device for which the backup file was created and the type of backup
data the file contains.

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when a restore operation is initiated.

. Start the restore operation in ProSave on the PC with "Start Restore".

If there are license keys both on the HMI device and in the backup, a dialog will appear.
Use this dialog to establish whether you want to overwrite the license keys or abort the
restore process.

— If necessary, abort the backup and first back up the HMI device's license keys.
— Then restart the restore process.
Follow the instructions in ProSave.

A status view opens to indicate the progress of the operation.

When the restore is successfully completed, the data backed up on the PC is now on the
HMI device.

See also

Configuring the data channel (Page 117)

Operating modes (Page 140)

Data transmission options (Page 141)

Transferring and transferring back license keys (Page 163)
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7.7 Updating the operating system

7.7 Updating the operating system

7.71 Overview

Updating the operating system

A compatibility conflict may occur when transferring a project to the HMI device. This is
caused by different versions of the configuration software used and the HMI device image
available on the HMI device. If there are different versions, the transfer is aborted. A
message indicating a compatibility conflict is displayed on the configuring PC.

There are two ways to match the versions:

® Update the HMI device image if the project was created with the most recent version of
the configuration software

e Transfer a matching version of the HMI device image if you do not want to adapt the
project for the HMI device to the most recent version of the configuration software for the
project

NOTICE
Data loss

All data on the HMI device, such as the project and licenses, will be deleted when you
update the operating system.

Note
Calibrating the touch screen

After the update, you may have to re-calibrate the touch-screen.

7.7.2 Resetting factory settings

In ProSave or WinCC flexible, you can update the operating system with or without resetting
to factory settings.

e Updating the operating system without resetting to factory settings

First, switch into "Transfer" mode on the HMI device or use the automatic transfer
function if the project is active. Then start the operating system update in ProSave or
WinCC flexible.

® Updating the operating system with resetting to factory settings

NOTICE

Loss of license keys

The license keys on the HMI device will be deleted when resetting to factory settings.
The license keys on the HMI device will be retained when updating the operating system
without resetting to factory settings.
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7.7 Updating the operating system

NOTICE

Data channels

When resetting to factory settings, all data channel parameters are reset. The transfer
can only be started following reconfiguration of the data channels.

Note

You have to perform an operating system update with reset to factory settings if the HMI
device does not yet have an operating system or if the HMI device's operating system is
corrupt.

First, start the operating system update in ProSave or WinCC flexible and switch the
power on the HMI device off and on again when prompted.

7.7.3 Updating the operating system using WinCC flexible

Requirements

Procedure

154

No project is open on the configuring PC in WinCC flexible.
The HMI device is connected to this configuring PC.

The data channel is configured on the HMI device.

Proceed as follows:

1.

N o o R~ Db

On the configuring PC, select the "Communication settings" command from the "Projekt >
Transfer" menu in WinCC flexible.

The "Communication Settings" dialog opens.

Select the type of HMI device.

Select the type of connection between the HMI device and the configuring PC.

Set the connection parameters.

Close the dialog with "OK".

In WIinCC flexible, select the command "OS Update" from the "Projekt > Transfer" menu.
In "Image path", select the HMI device image file "*.img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

Switch into "Transfer" mode on the HMI device.

If you have activated automatic transfer mode for the HMI device, the device
automatically switches to "Transfer" mode when an update is initiated.
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Commissioning a project
7.7 Updating the operating system

9. In WinCC flexible, select "Update OS" on the configuring PC to run the operating system
update.

10. Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.

7.74 Updating the operating system using ProSave

Requirements
® The HMI device is connected to a PC on which ProSave is installed.

® The data channel is configured on the HMI device.

Procedure
Proceed as follows:
1. From the Windows Start menu, start ProSave on the PC.
2. Select the HMI device type in the "General" tab.
3. Select the type of connection between the HMI device and the PC.
4. Set the connection parameters.
5. Select the "OS Update" tab.
6. In "Image path", select the HMI device image file "*.img".
The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.
In the output area, you are provided information on the version of the HMI device image
file after it is opened.
7. Switch into "Transfer" mode on the HMI device.
If you have activated automatic transfer mode for the HMI device, the device
automatically switches to "Transfer" mode when an update is initiated.
8. Select "Update OS" n the PC to run the operating system update.
9. Follow the instructions in ProSave.
During the operating system update a status view opens to indicate progress.
Result

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device.
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Commissioning a project

7.7 Updating the operating system

7.75 Resetting to factory settings with WinCC flexible

Requirements
® No project is open on the configuring PC in WinCC flexible.

The HMI device is connected to this configuring PC.

Have the MAC address of your HMI device's Ethernet port to hand.
— The MAC address is displayed briefly when the HMI device is turned on.
— The MAC address is displayed in the "PROFINET" dialog in the control panel.

Procedure - setting PC interface
1. Select "Start > Control Panel > Set PG/PC interface".
2. Select "STONLINE (STEP7) -> TCP/IP" from the "Application access point" area.

3. Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.

4. Confirm your entries.

Procedure - Restoring factory settings
Proceed as follows:
1. Turn off the power supply to the HMI device.

2. On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

3. Select the HMI device type from the "General" tab, and select "Ethernet" from the
"Connection" area.

4. Enter an IP address.

Note
Possible address conflicts with incorrect IP address

Do not use a dynamic IP configuration for "Reset to factory settings".

Define an IP address which the HMI device is going to receive from the configuration
station during the update process.

If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset to factory settings".
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Commissioning a project

7.7 Updating the operating system
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Confirm your entries.

In WinCC flexible, select the command "OS Update" in the "Project > Transfer" menu.

Activate the "Reset to factory settings" check box.

A text box opens where you can enter the MAC address.

Enter the HMI device's MAC address in the text box.

In "Image path", select the HMI device image file "*.img

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

10. In WIinCC flexible, select "Update OS" on the configuring PC to run the operating system

update.

11. Follow the instructions in WinCC flexible.

During the operating system update a status view opens to indicate progress.

Result

A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device. The factory settings are

reset.

Note

Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.
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Commissioning a project

7.7 Updating the operating system

7.7.6 Resetting to factory settings with ProSave

Requirements

The HMI device is connected to a PC on which ProSave is installed.

Have the MAC address of your HMI device's Ethernet port to hand.

— The MAC address is displayed briefly when the HMI device is turned on.

— The MAC address is displayed in the "PROFINET" dialog in the control panel.

Procedure - setting PC interface

1.
2.
3.

Select "Start > Control Panel > Set PG/PC interface".
Select "S7TONLINE (STEP7) -> TCP/IP" from the "Application access point" area.

Select the interface which is connected to the HMI device from the "Interface
parameterization used" area.

Confirm your entries.

Procedure - Restoring factory settings

Proceed as follows:

1.
2.
3.

4.
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Turn off the power supply to the HMI device.
From the Windows Start menu, start ProSave on the PC.

Select the HMI device type from the "General" tab, and select "Ethernet" from the
"Connection" area.

Enter an IP address.

Note
Possible address conflicts with incorrect IP address
Do not use a dynamic IP configuration for "Reset to factory settings".

Define an IP address which the HMI device is going to receive from the configuration
station during the update process.

If the HMI device has already been used with WinCC flexible or ProSave you can use the
existing IP address for "Reset to factory settings".
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7.7 Updating the operating system
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Change to the "OS Update" tab.

Activate the "Reset to factory settings" check box.

A text box opens where you can enter the MAC address.
Enter the HMI device's MAC address in the text box.
In "Image path”, select the HMI device image file ".img".

The HMI device image files are available under "WinCC flexible Images" in the
WinCC flexible installation folder or on the WinCC flexible installation CD.

In the output area, you are provided information on the version of the HMI device image
file after it is opened.

9. Select "Update OS" on the PC to start the "Reset to factory settings" process.
10. Follow the instructions in ProSave.

During the operating system update a status view opens to indicate progress.

Result
A message is displayed when the operating system update is successfully completed.

This operation has deleted the project data from the HMI device. The factory settings are
reset.

Note
Calibrating the touch screen

After the reset, you may have to recalibrate the touch screen.
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Commissioning a project

7.8 Installing and removing opfions

7.8

7.8.1

Installing and removing options

Overview

Installing and removing options

7.8.2

You can install options on the HMI device, for example, additional programs developed
especially for the HMI device.

You can also remove the option from the HMI device again.

Note
License key

A license key may be needed to run an option. The license key unlocks the option for use.

Installing and removing options using WinCC flexible

Requirements

No project is open on the configuring PC in WinCC flexible.
The HMI device is connected to this configuring PC.

The data channel is configured on the HMI device.

Procedure for installing an option

160

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set

N o o &

the connection parameters.

Close the dialog with "OK".

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Select the desired option under "Available options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in WinCC flexible on the configuring PC with the ">>"
button.

Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the installation.
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Commissioning a project

Result

7.8 Installing and removing opfions

The option has now been installed on the HMI device.

Procedure for removing an option

Proceed as follows:

1.

On the configuring PC, select the "Communication settings" command in the menu
"Project > Transfer" in WinCC flexible.

The "Communication Settings" dialog opens.

2. Select the type of HMI device.

3. Select the type of connection between the HMI device and the configuring PC, then set

© N o o &

Result

the connection parameters.

Close the dialog with "OK",

Select the "Options" command in the menu "Project > Transfer" in WinCC flexible.
Press the "Device status" button to update the display.

Select the desired option under "Installed options".

Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

. Start the removal of the option in WinCC flexible on the configuring PC with the "<<"

button.
Follow the instructions in WinCC flexible.

A status display appears indicating the progress of the removal.

The option has now been removed on the HMI device.
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Commissioning a project

7.8 Installing and removing opfions

7.8.3 Installing and removing options using ProSave

Requirements

The HMI device is connected to a PC on which ProSave is installed.

The data channel is configured on the HMI device.

Procedure for installing an option

Proceed as follows:

1.
2.
3.

From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC, then set the
connection parameters.

4. Select the "Options" tab.

5. Select the desired option under "Available options".

6. Set "Transfer" mode on the HMI device.

Result

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the installation of an option is initiated.

Start the installation of the option in ProSave with the ">>" button.
Follow the instructions in ProSave.

A status display appears indicating the progress of the installation.

The option has now been installed on the HMI device.

Procedure for removing an option

Proceed as follows:

1.
2.

N o a &
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From the Windows Start menu, start ProSave on the PC.
Select the HMI device type in the "General" tab.

Select the type of connection between the HMI device and the PC, then set the
connection parameters.

Select the "Options" tab.

Press the "Device status" button to update the display.
Select the desired option under "Installed options".
Set "Transfer" mode on the HMI device.

If automatic transfer mode is enabled on the HMI device, the device automatically sets
"Transfer" mode when the removal of an option is initiated.

. Start the removal of the option in ProSave with the "<<" button.

Follow the instructions in ProSave.

A status display appears indicating the progress of the removal.
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7.9 Transferring and transferring back license keys

Result

The option has now been removed on the HMI device.
7.9 Transferring and transferring back license keys
7.91 Overview

Transferring and transferring back license keys

With the purchase of an optional package, you obtain a specific user license with an
associated license key. Once you have installed an option, transfer a license key to the HMI
device. The license key unlocks an option for use.

You can also transfer back the license key from the HMI device to the storage location.

Note
You only transfer license keys with the Automation License Manager or WinCC flexible.

7.9.2 Transferring and transferring back license keys

Requirements

When transferring or transferring back using WinCC flexible:
No project is open on the configuring PC in WinCC flexible.
The HMI device is connected to this configuring PC.

The data channel is configured on the HMI device.

The storage location and the license key awaiting transfer are ready.

Procedure for transferring a license key

MP 377 (WIinCC flexible)

Proceed as follows:
1. Switch to "Transfer" mode on the HMI device.

2. When transferring using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring using the Automation License Manager:

Start the Automation License Manager via the Windows Start menu.

. In the Automation License Manager, select the command "Connect HMI device" in the

menu "Edit > Connect target system".

The "Connect Target System" dialog opens.
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7.9 Transferring and transferring back license keys

Result

N o o &

Under "Device Type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.

Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the source drive.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the HMI device in
the left window.

The license keys are then transferred to the HMI device.

The license key is transferred from the storage location to the HMI device.

Procedure for transferring a license key back

Result

164

Proceed as follows:

1.
2.

N o o &

Switch to "Transfer" mode on the HMI device.
When transferring back using WinCC flexible:

Select the "License Keys" command in the menu "Project > Transfer". The
Automation License Manager opens.

When transferring back using the Automation License Manager:
Start the Automation License Manager via the Windows Start menu.

In the Automation License Manager, select the command "Connect HMI device" in the
menu "Edit > Connect target system".

The "Connect Target System" dialog opens.

Under "Device Type", select the appropriate HMI device type.
Select the type of connection from the "Connection" box.

Set the connection parameters.

Select "OK".

The connection to the HMI device is established. The connected HMI device is displayed
in the left window of the Automation License Manager.

In the left window, select the HMI device.
The right window displays the available license keys.

Drag one or more license keys from the right window and drop them on the destination
drive in the left window.

The license keys are transferred back to the storage location.

The license key is transferred back from the HMI device to the storage location.
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Operating a project

8.1 Overview

Configuration and process control phase

HMI devices can be used to operate and monitor tasks in process and production
automation. The plant screens on the HMI devices are used to provide a clear overview of
the active processes.

The HMI device project, which includes the plant screens, is created during the configuration
phase. The configuration engineer defines which tasks the HMI device has in the process
and defines the following in detail:

e \Which process data is displayed on the individual HMI device
e Which plant components are controlled by this HMI device

The configuration engineer stores this information in the project's screens. The project is
transferred to the HMI device during commissioning.

After transfer to the HMI device, current processes can be operated and monitored in the
project's screens. The screens enable you to observe, for example, operational states,
current process data and faults in a plant. Operating elements which are used to operate the
process, for example buttons, I/O fields and alarm windows, are displayed in the screens.

Operator input options

The hardware of the HMI device determines which of the following operator control options
are available:

® Touch screen

The operating elements shown in the dialogs are touch-sensitive. Touch objects are
basically operated in the same way as mechanical keys. You activate operating elements
by touching them with your finger. To double-click them, touch an operating element
twice in succession.

® HMI device keyboard

The operating elements shown in the screens are selected and operated using the keys
of the HMI device.

e External keyboard, connected via USB

® External mouse, connected via USB
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Operating a project

8.1 Overview

A\ caution

Do not use any pointed or sharp objects when operating the touch screen. Otherwise
this may damage the plastic membrane of the touch screen.

The following provides instructions for operating a project with the touch screen and the
keyboard.

Operating a project with an external keyboard

An external keyboard can be used to operate a project in exactly the same way as with the
HMI keyboard or screen keyboard.

Note

The function keys of the external keyboard are disabled.

Use the other keys of the external keyboard, which correspond to the HMI device keys in the
description.

Operating a project with an external mouse

An external mouse can be used to operate a project in exactly the same way as with the HMI
touch screen. Click the described operating elements with the mouse.

Unintentional actions

A\ caution

Do not carry out several operations simultaneously. You may otherwise trigger
unintentional actions.

e With touch control:

Always touch only one operating element on the screen
o With key control:

Do not press more than two keys simultaneously

Observing the plant documentation

Some operations with the project may require in-depth knowledge about the specific plant on
the part of the operator. Proceed with caution, for example, when you use jog mode. Further
information on this may be available in your plant documentation.

Operation feedback from operating elements

The HMI device provides operation feedback as soon as it detects that an operating element
has been selected. This operation feedback is independent of any communication with the
PLC. Therefore, this operation feedback does not indicate whether the relevant action is
actually executed or not.
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Operating a project
8.1 Overview

Optical feedback from operating elements

The operating element receives the focus and is selected. The configuration engineer can
also configure the selection of an operating element so that it deviates from the standard.
Further information on this may be available in your plant documentation.

The type of optical feedback depends on the operating element:
e Buttons

The HMI device outputs different views of the "Pressed" and "Unpressed" states,
provided the configuration engineer has configured a 3D effect:

"Pressed" state:

"Unpressed" state:

The configuration engineer determines the appearance of a selected field, for example,
line width and color for the focus.

® |nvisible buttons

By default, invisible buttons are not displayed as pressed when they are touched. No
optical operation feedback is provided in this case.

The configuration engineer may, however, configure invisible buttons so that their outline
appears as lines when touched. This outline remains visible until you select another
operating element.

e |/O fields

When you select an 1/O field, the content of the I/O field is displayed against a colored
background. With touch operation, a screen keyboard is displayed for the entering of
values.

Acoustic feedback from operating elements

As soon as the HMI device detects a touch of the touch screen or that a key has been
pressed, an acoustic signal is issued. You can activate or deactivate this acoustic operation
feedback.

Note

The acoustic feedback is only possible if you interact with the project directly on the touch
screen or press one of the keys of the HMI device. If you use an external mouse or keyboard
for interaction, no acoustic signal is issued.

Acoustic signal for inadvertent operations

If you try to enter an invalid character, the HMI device issues an acoustic signal in
accordance with the setting.
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Operating a project
8.2 Direct keys

8.2 Direct keys

Introduction
Direct keys on the HMI device are used to set bits in the 1/0 area of a SIMATIC S7.
Direct keys enable operations with short reaction times that are, for example, a jog mode
requirement.
NOTICE
Direct keys are still active when the HMI device is in "offline" mode.
NOTICE
If you operate a function key with direct key functionality in a running project, the direct key
function is always executed, independent of the current screen contents.
Note
You can only use direct keys when there is a connection via PROFIBUS DP or
PROFINET 10O.
Direct keys result in additional basic load on the HMI device.
Direct keys

The following objects can be configured as a direct key:
e Buttons

® Function keys

You can also define image numbers in the case of HMI devices with touch operation. In this
way, the project engineer can configure the direct keys on an image-specific basis.

Further information on configuring direct keys can be found in the
"WinCC flexible Communication" system manual.
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Operating a project
8.3 Setting the project language

8.3 Setting the project language

Introduction

The HMI device supports multilingual projects. You must have configured a corresponding

operating element which lets you change the language setting on the HMI device during
runtime.

The project always starts with the language set in the previous session.

Requirements
® The required language for the project must be available on the HMI device.

® The language switching function must be logically linked to a configured operating
element such as a button.

Selecting a language

You can change project languages at any time. Language-specific objects are immediately
output to the screen in the new language when you switch languages.

The following options are available for switching the language:
® A configured operating element switches from one language to the next in a list
® A configured operating element directly sets the desired language

Further information on this may be available in your plant documentation

8.4 Entries using the touch screen

8.4.1 Overview

Screen keyboard

When you touch an operating element requiring entry on the HMI device touch screen, a
screen keyboard appears. The screen keyboard is displayed in the following cases:

® An |/O field is selected for input
e A password must be entered for accessing a password-protected function
The screen keyboard is automatically hidden again when input is complete.

Based on the configuration of the operating element, the system displays different screen
keyboards for entering numerical or alphanumerical values.

Note

The screen keyboard display is independent of the configured project language.
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Operating a project

8.4 Entries using the fouch screen

General procedure
The operating elements of a screen are operated by touching the touch screen.
Proceed as follows:
1. Touch the desired operating element within the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:

— /O field: Enter numerical, alphanumeric or symbolic values in the 1/O field
— Symbolic I/O field: Select an entry from the drop down list box

— Slider control: Move the slider control

Procedure for text boxes

Values are entered in the project text boxes. Based on your configuration, the values are
saved to tags and transferred, for example, to the PLC.

Proceed as follows:
1. Touch the desired text box within the screen.
The screen keyboard opens.

Depending on your configuration, you can enter values in the text box in the following
manner:

— Numerical values, for example decimal numbers, hexadecimal numbers, binary values
— Alphanumerical values, for example digits and letters
— Date/time

2. Enter the value.

3. Confirm your entry with -<— |or discard your entry with the button ESC |
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Operating a project

8.4 Entries using the fouch screen
8.4.2 Entering and editing numerical values

Numerical screen keyboard

When you touch an operating element for numerical input on the HMI-device touch screen,
the numerical screen keyboard appears. This is the case, for example, for a text box. The
screen keyboard is automatically hidden again when input is complete.

7| 8|9l [EL

4 516 el | Ins
123‘J

U- ESC| | —»

|Num Help

Figure 8-1 Numerical screen keyboard

Note
Opened screen keyboard
When the screen keyboard is open, PLC job 51, "Select Screen" has no function.

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Binary

® Hexadecimal

Note
Entry of hexadecimal values

When you enter values in hexadecimal format, the alphanumerical screen keyboard
opens.

Limit value test of numerical values

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

Decimal places for numerical values

The configuration engineer can define the number of decimal places for a numerical text box.
The number of decimal places is checked when you enter a value in this type of I/O field.

® Decimal places in excess of the limit are ignored

e Empty decimal places are filled with "0"
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Operating a project

8.4 Entries using the fouch screen

Procedure

Numerical values can be entered character-by-character via the buttons on the numerical
screen keyboard.

Proceed as follows:
1. Touch the desired operating element within the screen.

The numerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

The keys with for example the letters G to Z are available to enter a hexadecimal value;
however, the characters are not entered. Depending on the settings, the HMI device
issues an acoustic signal.

You have the following options to enter a value:

— The selected value is deleted when you enter the first character. Completely reenter
the value.

- Usethe €— | and — | keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the == | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The el | key deletes the character positioned to the right of the cursor. If the value is
selected, use this key to delete the selected part of the value.

— Use the HE|P| key to display the infotext of the I/O field.

This button is only enabled if infotext has been configured for the input object or the
current screen.

3. Usethe == | key to confirm your entry or cancel it with ESC | Either action closes the
screen keyboard.

Result

You have changed the numerical value or entered a new one.
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Operating a project
8.4 Entries using the fouch screen

8.4.3 Entering and editing alphanumerical values

Alphanumerical screen keyboard

When you touch an operating element for numerical input on the HMI-device touch screen,
the alphanumerical screen keyboard appears. This is the case, for example, for a text box.
The screen keyboard is automatically hidden again when input is complete.
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Figure 8-2  Alphanumerical screen keyboard, normal level

Note

Opened screen keyboard

When the screen keyboard is open, PLC job 51, "Select Screen" has no function.
Language change

Language change in the project has no influence on the alphanumerical screen keyboard.
The entry of Cyrillic or Asian chracters is therefore not possible.

Keyboard levels
The alphanumerical screen keyboard has various levels.
o Normal level
® Shift level

If you change the levels with key | the key assignments change.

Procedure

Alphanumerical values can be entered character-by-character via the buttons on the
alphanumerical screen keyboard.

Proceed as follows:
1. Touch the desired operating element within the screen.

The alphanumerical screen keyboard opens. The existing value is displayed in the screen
keyboard and is selected.

2. Enter the value.

You have the following options to enter a value:
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Operating a project

8.4 Entries using the fouch screen

— The selected value is deleted when you enter the first character. Completely reenter
the value.

- Usethe €— | and — | keys to move the cursor within the current value. You can

now edit the characters of the current value or add characters.

Use the == | key to delete the character to the left of the cursor. If the value is

selected, use this key to delete the selected part of the value.

The el | key deletes the character positioned to the right of the cursor. If the value is
selected, use this key to delete the selected part of the value.

- Usingkey T | it is possible to switch between the keyboard levels of the screen

keyboard. On switchover, the key assignments of the screen keyboard change.

— Usethe HE|P| key to display the infotext of the I/O field.

This button is only enabled if infotext has been configured for the input object or the
current screen.

3. Usethe == | key to confirm your entry or cancel it with ESC | Either action closes the
screen keyboard.

Result

You have changed the alphanumeric value or entered a new one.

844 Entering the date and time

Entering the date and time

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

MP 377 (WIinCC flexible)

174 C S@ ating Instructions, 09/2007, 6AV6 691-1DR01-0ABO
VICPAS
ViCPAS gy

Everg,-'thin? for your HMI running
B sales@vicpas.com

O +86-15876525394



Operating a project

8.4 Entries using the fouch screen

8.45 Entering symbolic values

Drop down list box

Operating elements for entering symbolic values offer you a list from which you can select
the input values. When you touch a symbolic I/O field on the HMI device touch screen, the
following drop down list box opens.

Figure 8-3  Symbolic I/O field after touch, example

Procedure
Proceed as follows:

1. Touch the required operating element.

The drop down list box of the operating element opens. Select -] and x| to scroll in the
drop down list box.
2. Touch the required entry in the drop down list box.

The selected entry is accepted as an entry.

Result
You have changed the symbolic value or entered a new one.
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Operating a project

8.4 Entries using the fouch screen

8.4.6 Displaying infotext

Purpose

The configuration engineer uses infotext to provide additional information and operating
instructions. The configuration engineer can configure infotext on screens and operating
elements.

The infotext of an I/O field may contain, for example, information on the value to be entered.

Enter termperature setpoint for Tank_1
{Range 40...80 =C)

Figure 8-4  Infotext for an I/O field, example

Opening infotext for operating elements
1. Touch the required operating element.

The screen keyboard opens. You can see from the appearance of the Hﬂ'Pl key whether
infotext has been configured for the operating element or the current screen.

2. Touch the HE'Pl key on the screen keyboard.

The infotext for the operating element is displayed. If there is no infotext for the selected
screen object, the infotext for the current screen is displayed, if it has been configured.

You can scroll through the contents of long infotext with ~|and «|.

Note
Switching between displayed infotext

The configuration engineer can configure infotext for an I/O field and the associated
screen. You can switch between two infotexts by touching the infotext window.

3. Close the displayed infotext by pressing .

Alternative procedure

Depending on your configuration, infotext can also be called via a configured operating
element.

Further information on this may be available in your plant documentation
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Operating a project

8.5 Entries using the keys

8.5 Entries using the keys

8.5.1 Control keys

Introduction

The following tables show the control keys with which you operate the project. You will also
find detailed descriptions under the individual operating elements.

Select operating elements

Key Functions Description
Tabulator Selects the next/previous operating element in the

tab sequence.

EIEI Cursor keys Selects the next operating element to the left, right,
above or below the current screen object.

IZIEI Navigates in the operating element.

Using operating elements

A

ey Functions Description

Position the cursor Positions the cursor within an operating element,
for example in the I/O field.

+

+

<MY

=

+

Scroll back Scrolls back a page in a list.

HOME

4 Scroll to the beginning Scrolls to the beginning of a list.
N | + |Home

Scroll forward Scrolls one page forward in a list.

END

Scroll to the end Scrolls to the end of a list.
N | 4+ | eno

ENTER Enter key e Operates buttons.

e Accepts and ends an entry.

e Opens a drop down list box.

e Toggles within a text box between character
mode and normal mode.

In character mode, a single character is
selected. In this mode, you can advance in the
character set using the cursor keys.
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Operating a project

8.5 Entries using the keys

Key

Functions

Description

Cancel

e Deletes the characters of a value entry and
restores the original value.

¢ Closes the active dialog.

Delete characters

Deletes the character to the right of the current
cursor position.

Delete characters

Deletes the character to the left of the current
cursor position.

+

Open drop down list box

Opens a drop down list box.

CTRL ENTER
+

Accept value

Accepts the selected value in the drop down list
box without closing the list.

Enter key combinations

Key

Functions

Purpose

Toggle key assignment

Switches over key assignment of keys with multiple
assignment.

e No LEDis lit:
The number assignment is enabled. Pressing
the button once toggles to letter assignment.
e AnLED s lit:

The left or right letter assignment is enabled.

Each time the key is pressed, the system toggles
between the left letter assignment, the right letter
assignment and the number assignment.

Toggle between upper-case
and lower-case

Used in key combinations, for example for entering
upper-case letters.

[
ul =
= il

2

Switch to additional key
assignment

Some of the keys contain a blue imprinted key
assignment , for example the "%" character.

Used in key combinations for the blue key
assignment.

General control function

Used in key combinations

General control function

Used in key combinations

Acknowledge alarms

Key

Functions

Description

ACK

Acknowledge

Acknowledges the currently displayed fault alarm
or all the alarms of an alarm group as group
acknowledgment.

The LED lights up as long as unacknowledged fault
alarms are active.
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Operating a project

8.5 Entries using the keys

Displaying infotext

Key Functions Description

Displaying infotext Opens a window with the configured infotext at the
selected object, for example alarm or 1/O field. If an
infotext exists for the selected object, the LED lights up.

Multi-key operation

Unwanted actions may be triggered, if the operator unintentionally actuates a key
combination.

A\ caution

Unintentional actions

In "Online" mode, simultaneous operation of more than two keys may cause unintentional
actions in the plant.

Never press more than two keys simultaneously.

8.5.2 Example: enter characters using the alphanumeric keyboard

Using the same keys of the alphanumeric keyboard you can enter up to six different
characters. The entry result depends on the combination of the keys pressed.

The values "5", "M", "m", "N", "n" and "%" are entered using the same key of the

keyboard. You can use the keys , and to switch between the different
assignments.

The following table shows the entry options using the key .

Key Key Key Result
No LED is lit Not relevant Not pressed 5
Left LED is illuminated. Not pressed Not pressed m
Left LED is illuminated. Pressed Not pressed M
Right LED is illuminated. Not pressed Not pressed n
Right LED is illuminated. Pressed Not pressed N
Not relevant Not relevant Pressed %
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Operating a project

8.5 Entries using the keys
8.5.3 Function keys

Function keys

Function key assignment is defined during configuration. The configuration engineer can
assign function keys globally and locally.

Function keys with global function assignment

A globally assigned function key always triggers the same action on the HMI device or in the
PLC irrespective of the screen displayed. Such an action could be, for example, the
activation of a screen or the closure of an alarm window.

Function keys with local function assignment

A function key with local function assignment is screen-specific and is therefore only
effective within the active screen.

The function assigned locally to a function key can vary from screen to screen.

The function key of a screen can be assigned one function only, either a global or local one.
The local assignment function takes priority over the global setting.

The configuration engineer can assign function keys in such a way that you can operate
operating elements with function keys, for example, the alarm view, trend view, recipe view
or Status Force.

8.54 General procedures

Introduction
The control keys and function keys of the HMI device are available for key control

General procedure
The operating elements of a screen are operated using the control keys of the HMI device.

Proceed as follows:

1. Continue to press the key or the cursor keys until the required operating element is

selected on the screen.

2. Depending on the operating element, perform further actions. Detailed descriptions can
be found under the respective operating element.

Examples:
— 1/O field: Enter numerical, alphanumeric or symbolic values in the 1/O field

— Slider control: Move the slider control

3. Confirm the operation with the key or abort the operation with the key .
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Operating a project
8.5 Entries using the keys

8.5.5 Entering and editing numerical values

Formats for numerical values
You can enter values in numerical text boxes based on the following formats:
® Decimal
® Hexadecimal

® Binary

Limit value test of numerical values

Tags can be assigned limit values. If you enter a value that lies outside of this limit, it will not
be accepted, for example, 80 with a limit value of 78. In this case the HMI device will deliver
a system alarm, if an alarm window is configured. The original value is displayed again.

Procedure

Numerical and alphanumerical values can be entered in character mode using the system
keys.

Proceed as follows:

1. Select the desired text box within the screen with .

The existing value is selected in the text box.
2. Enter the value using the numerical keypad.
You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
canceled. Move the cursor in the existing value. You can now edit the characters of

the current value or add characters.

The key deletes the character positioned to the right of the cursor. Use the

key to delete the character to the left of the cursor.

To enter the hexadecimal characters "A" to "F", switch the numerical keypad to letter

assignment using the key .

— Ifthe LED of the key is lit, infotext is available for the selected object or the

current screen.

Use the key to display the infotext for the operating element or current screen.

3. Select "] to confirm your entry.
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8.5 Entries using the keys

Result
You have changed the numerical value or entered a new one.
8.5.6 Entering and editing alphanumerical values
Procedure
Alphanumerical values can be entered in character mode using the system keys.
Proceed as follows:
1. Select the desired text box within the screen with .
The existing value is selected in the text box.
2. Enter the value using the system keys.

You have the following options to enter a value:

— The existing value is deleted when you enter the first character. Completely reenter
the value.

— Press and a cursor key simultaneously. The selection of the field content is
canceled. Move the cursor in the existing value. You can now edit the characters of
the current value or add characters.

The key deletes the character positioned to the right of the cursor. Use the
key to delete the character to the left of the cursor.
To enter letters, switch the numerical keypad to letter assignment using the key .

— Ifthe LED of the key is lit, infotext is available for the selected object or the
current screen.

Use the key to display the infotext for the operating element or current screen.
3. Select to confirm your entry.
Result

You have changed the alphanumeric value or entered a new one.

MP 377 (WIinCC flexible)

182 C S@ ating Instructions, 09/2007, 6AV6 691-1DR01-0AB0
VICPAS
VICPAS" g

Everg,-'thin? for your HMI running
B sales@vicpas.com

O +86-15876525394



Operating a project

8.5.7

8.5 Entries using the keys

Entering the date and time

Entering the date and time

8.5.8

Enter the date and time in the same way you enter alphanumerical values.

Note

When entering the date and time, please note that the format is determined by the
configured project language.

Entering symbolic values

Drop down list box

Procedure

Result

When you select a symbolic 1/O field, a drop down list box opens.

Figure 8-5  Symbolic I/O field, example

Symbolic values are selected from the entries of a drop down list box.

Proceed as follows:

1. Select the desired symbolic text box within the screen with .

ENTER

2. Open the drop down list box using the key . The drop down list box opens.

3. Select the required entry using the cursor keys IZI Iz' or IEI

4. Select "™ to confirm your entry.

You have changed the symbolic value or entered a new one.
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8.5 Entries using the keys

8.5.9

Purpose

Procedure

Displaying infotext

The configuration engineer uses infotext to provide additional information and operating
instructions. The configuration engineer can configure infotext on screens and operating
elements.

The infotext of an I/O field may contain, for example, information on the value to be entered.

Enter termperature setpoint for Tank_1
{Range 40...80 =C)

Figure 8-6  Infotext for an I/O field, example

If the LED of the key lights up, an infotext has been configured for the selected display
object or for the current screen.

HELP
1. Press .

The infotext for the selected screen object is displayed. If there is no infotext for the
selected screen object, the infotext for the current screen is displayed, if it has been
configured.

You can scroll through the contents of long infotexts using the cursor keys Iz' and IZI

Note
Switching between displayed infotext

The configuration engineer can configure infotext for an I/O field and the associated

screen. You can switch between two infotexts by pressing the key .

2. Close the infotext by pressing key .

Alternative procedure

184

Depending on your configuration, infotext can also be called via a function key or via an
existing operating element.

Further information on this may be available in your plant documentation.
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Operating a project

8.6

Bar

Layout

Gauge

Layout

Operation

8.6 Bar and gauge

Bar and gauge

The bar is a dynamic display object. The bar displays a value from the PLC as a rectangular
area. The bar allows you to recognize the following at a glance:

® The distance of the current value from the configured limit values
® Whether a set point value has been reached

The bar can display values such as fill levels or batch counts.
100

&0
30
o

The layout of the bar depends on the configuration:
® The bar may feature a scale of values
® The configured limit values can be indicated by lines

® Color changes can signal when a limit value has been exceeded or has not been reached

The gauge is a dynamic display object. The gauge displays numeric values in analog form
by means of a pointer. This enables an operator at the HMI device to see at a glance if the
boiler pressure is in the normal range, for example.

The layout of the gauge depends on the configuration:

® A trailing pointer can display the maximum value reached so far on the scale. The trailing
pointer is reset when the screen is reloaded

® The label on the scale can show the measured variable, for example boiler pressure and
the physical unit, for example bar

The bar and the gauge are for display only. Both objects cannot be controlled by the
operator.
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8.7 Operating the swifch

8.7 Operating the switch

Introduction
The switch is an operating element and display object with two predefined switching states,
for example "On" and "Off". Switches can signalize the state of a plant section, for example if
a motor is running or not. At the same time, you can use the switch to change the state of
the corresponding plant section via the HMI device, for example from "On" to "Off".

Layout

The layout of the switch depends on the configuration:
e Switch with slider

The two states are displayed by the position of the slider

Swyitch

©) Slider
® Switch with text or graphic

The two states are displayed by the label on the slider

Depending on the switching state, the switch is labeled with one of two texts or one of two
graphics.

Examples:

"Backward" or "Forward"

""" q.[

Procedure using the touch screen
e Switch with slider
Proceed as follows:
Move the slider to the other position or double-click the slider area
e Switch with text or graphic
Proceed as follows:

Touch the switch

Procedure using the keys
Proceed as follows:

1. Select the desired switch within the screen with .

2. Press .
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8.8 Operating the trend view

Result
The switch changes its appearance. The associated value is switched.

8.8 Operating the trend view

Trends
Trends continuously display the current process data or process data from a log.

Trend view

Trends are displayed in the trend view. A trend view can display several trends
simultaneously.

1007] ’
@
EI_I 1
| w|wlw|alalf=]&]x—0
Trend Tag assignment Value Date/time -
Pressure |Pressure pattern | 2|5| 31.01.2006 13:06:34 3

®

Figure 8-7  Trend view, example

@ Ruler
® Buttons for trend operation
® Trend value in the value table

Layout and operation

The layout and operation of the trend view depends on the configuration. The configuration
engineer determines, for example, the following:

® Appearance of the trend view, the axes, value ranges and labels
® QOperating options of the trend view

e Limit values for the trend values

® The change of color of the trend in the event of limit violation

Further information on this may be available in your plant documentation.
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8.8 Operating the trend view

Value table
The trend values can be read from the value table if this is configured:

e \When the ruler is displayed, the trend values are shown at a position of the ruler in the
value table

® When the ruler is hidden, the latest trend values are displayed in the value table

Ruler

When configured, a ruler is available to provide an exact reading of the trend values in the
value table.

You can move the ruler to the desired position of the trend view.

Operation
The trend view can be operated as follows:

® Enlarge or reduce the time interval displayed

Scroll forward or back by one display width

Stop and resume trend recording

Move the ruler

Hide and display the ruler

The following table shows the trend view buttons:

Key combination Functions

Stops or continues trend recording.

Zooms the displayed time section.

=
4e
N

Zooms out of the displayed time section.

Scrolls one display width backwards (to the left)

SHIFT

+

Scrolls one display width forwards (to the right)

SHIFT

Scrolls back to the beginning of the trend recording. The
start values of the trend recording are displayed there.

A, IE' Moves the ruler backwards (to the left)

+ +

L ENTER

+

I I = I O
||| =3||] = T ||| =
— || L — || L
+ + |+
=]
n

Moves the ruler forwards (to the right)

[v]

EEEERERS:

Shows or hides the ruler.

-
in
-

In addition, the configuration engineer can configure function keys or operating objects with
which you can control trend views.

Further information on this may be available in your plant documentation.
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8.9 Operating the slider control

Touch operation
Touch the required button in the trend view.

The position of the ruler can also be changed by means of touching and dragging the ruler
on the touch screen.

Procedure using the keys
Proceed as follows:

1. Using the key select the desired button within the trend view.

ENTER|

2. Confirm your entry by pressing the key

8.9 Operating the slider control

Introduction
The slider control can be used to monitor and change process values within a defined range.
The slider control can also be configured without a slider. In this case, you cannot enter a
value. The slider control is then only used for displaying values.
SIMATIC
100 =
75%
60 &
s
30
15
0
0——1—Q@
Figure 8-8  Slider control — example
0] Slider control for entering values
® Value display with current value
Layout

The layout of the slider control depends on the configuration:
® The slider control can contain a label and a setting range

® The current value can be displayed below the area of the slider control
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8.9 Operating the slider contro/

Procedure using the touch screen

Key control

Proceed as follows:

1. Touch the slider of the desired slide control.

2. Move the slider to the required value.

If a value display has been configured, you can check the exact value that has been set.

3. Release the slider.

The following table shows the control keys used to set the slide to a desired value:

Key combination

Description

SR

Increase value by 1

- [ 1

Reduce value by 1

Increase value in 5% increments.

Decrease value in 5% increments.

Set maximum value

Set minimum value

Procedure using the keys

Result

190

Proceed as follows:

1. Using the key mark the desired switch within the screen.

2. Move the slider to the required value.

If a value display has been configured, you can check the exact value that has been set.

The set value is applied.
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8.10 Operating the Status Force

8.10 Operating the Status Force

8.10.1 Overview

Application
You read or write access values of the connected PLC directly with Status Force. Status
Force allows you to monitor or change addresses of the PLC program, etc. You don't need
to connect an additional programming device or additional PC to the PLC.
Note
Status Force can only be used in combination with SIMATIC S5 or SIMATIC S7.
Layout
The layout of Status Force depends on the configuration.
The figure shows the general layout of Status Force. A value can be monitored or controlled
on every line.
The following figure shows an example of Status Force.
CDnnectiDnl Typel Ostetl FDrmatl Contral Yalue | [l
FLC_1 M |120 |DEC 33
FLC_1 T |40 |T 24,00
FLC_1 O |50 |DEC of .
FLC_1 O |50 | HEX DaOD | .
] [ _>I_I
I
The configuration engineer specifies which columns appear in Status Force.
The table shows the significance of all configurable columns.
Column Functions
"Connection" The PLC whose address ranges must be displayed.
"Type", "DB Number", "Offset", "Bit" The address range of the value
"Data Type", "Format" The data type of the value
"Status Value" The value read from the specified address.
"Control Value" The value to be written to the specified address.
Further information on this may be available in your plant documentation
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8.10 Operating the Status Force

Operating elements

Depending on your configuration, you can operate the Status Force using the following
buttons:

Buttons Functions

& "Read" button

Updates the display in the "Status Value" column.

This button engages when it is pressed. You cannot operate any text boxes until
the button is actuated again and the refresh is stopped.

A "Write" button

Applies the new value in the "Control Value" column. The control value is written
to the PLC.

8.10.2 Touch operation

Operator input options
Status Force can be operated as follows:
® (Change the column sequence
® Read the status values of the connected PLC

® Enter values and transfer them to the PLC

Change column sequence
Depending on the configuration, you can change the column sequence of Status Force.
Proceed as follows:
1. Touch the column header which you wish to exchange with a different column header

2. Keeping the touch screen pressed, move the column heading to the column heading you
wish to exchange it with

Result
The columns are displayed in the modified sequence.

Procedure for reading the status value
Proceed as follows:

1. Enter the address and the desired format of a value for each line. Touch the respective
columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the &' button.

Result

All values are read cyclically by the PLC and entered in the "Status Value" column until the

i button is touched again.
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8.10 Operating the Status Force

Requirements for forcing
The following requirements must be fulfilled in order to force values:
® The "Control Value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired value in the "Control Value"
column. Touch the respective columns to display the screen keyboard.

2. Once you have entered all of the desired values, touch the 52 button.

Result

The values from the "Control Value" column are transferred once to the PLC.

8.10.3 Key control

Operator input options
Status Force can be operated as follows:
® Change the column width.
® Read the status values of the connected PLC

® Enter values and transfer them to the PLC

Key control
The following table lists the key combinations for operating the Status Force:

Keys Functions

. Operates the "Read" button.

Operates the "Write" button.

ENTER

n
=
Py
—
+

Selects the first/last field in the current line.

O
|
X
z
+

2] [«][>]|[v][a]

Selects the first/last field in the current column.

O
4
pe)
z
+

Deletes the current line.

(@]
=
P
—
+
—
i

Otherwise:

Do not select a PLC in the "Connection" column.
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8.10 Operating the Status Force

Keys Functions

EnTER Opens selection box.

B -5
ﬂ ALT .\ IEI Decreases the width of the current column.

ﬁ + - Optimizes column width.

Increases the width of the current column.

Procedure for reading the status value
Proceed as follows:

1. Enter the address and format of the status value for each status value you wish to read in
one line. Select the respective fields and enter the values using the keyboard.

[
2. Press + .

Result

All status values are read cyclically from the PLC and entered in the "Status Value" column

{1}
until the + keys are pressed again.

Requirements for forcing
The following requirements must be fulfilled in order to force values:
® The "Control Value" column must be available

® The "Write" button must be available

Procedure for forcing a value
Proceed as follows:

1. Enter the address of a value for each line. Enter the desired control value in the "Control
Value" column. Select the respective fields and enter the values using the keyboard.

ENTER

2. Once you have entered all of the desired control values, press the + key.

Result
The values from the "Control Value" column are transferred once to the PLC.

Alternative procedure

Alternatively, you can also select the buttons &' and i using the key

and operate it using key .
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8.11

8.11.1

Application

Layout

Monitoring mode

Operation

8.11 Operating the Sm@rtClient view

Operating the Sm@rtClient view

Overview

The Sm@rtClient view enables you to monitor and remotely operate the current project of a
remote HMI device. With the correct configuration, several equal priority HMI devices can
access a remote HMI device.

Note

If another HMI device accesses your HMI device via the Sm@rtClient view, this leads to an
additional load on your HMI device.

In the Sm@rtClient view, the remote HMI is displayed with the complete layout.
Depending on the configuration, you can monitor and also operate this screen.

You can also operate the function keys like buttons on an HMI device with a touch screen.

On a Sm@rtClient view which is configured for monitoring mode, you can only monitor the
remote HMI device. You cannot control its operation.

Note

It is not possible to operate the direct keys of the remote HMI device from the local HMI
device.

The available operating elements depend on the HMI devices used:
® Same type of HMI devices

You can operate the project of the remote HMI device with the operating elements of your
HMI device

e Operate keys from a local touch screen

All the keys of the remote HMI device are displayed as buttons on the touch screen. You
can also touch them to operate them

® Touch operation from a local HMI device using keys

You operate the buttons in the usual manner.
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8.117 Operating the Sm@rtClient view

8.11.2 Touch operation

Operator input options
The Sm@rtClient view can be operated as follows:

e Starting remote control

® Forcing permission

® Ending remote operation

Procedure for starting remote operation
Proceed as follows:

1.

On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.
— The connection must be established by touching the appropriate button.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The current screen of the project running on the remote device is displayed on the screen
of your HMI device.

You can now monitor and control this screen depending on your configuration.

Scroll bars are displayed if the screen of the remote HMI device is larger than that of the
current HMI device.

Procedure for forcing permissions

If several HMI devices have access to a HMI device, only one HMI device has operating
permission at any one time.

Two cases must be distinguished for this case:

196

If another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

— You are now authorized to operate the remote HMI device

If another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device

— Touch the screen of your HMI device five times consecutively

— You are given permission to operate your local HMI device
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8.11 Operating the Sm@rtClient view

Procedure for ending remote control

You can end monitoring and control of a remote HMI device with one of the following
methods depending on the configuration:

® Touch a button configured for this action
® Exit the screen containing the Sm@rtClient view

® [f configured, a menu is displayed after you have touched an empty space over a longer
period. Select the "Close" menu item.

Further information on this may be available in your plant documentation

8.11.3 Key control

Operator input options
The Sm@rtClient view can be operated as follows:
e Starting remote control
® Forcing permission

e Ending remote control

Procedure for starting remote operation
Proceed as follows:
1. On the HMI device change to the screen with the Sm@rtClient view.

The following options are available for establishing the connection to the remote HMI
device:

— The connection is established automatically.

— Continue to press the key until the Sm@rtClient view is selected.

Depending on the configuration, you may be required to enter the address of the
remote HMI device and a password.

The connection is established. The current screen of the project running on the remote
device is displayed on the screen of your HMI device.

2. You can now monitor and control this screen depending on your configuration.

3. Scroll bars are displayed if the screen of the remote HMI device is larger than that of the

current HMI device. Move the scroll bars in the direction required using keys + IZI

oreey + (W]
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8.117 Operating the Sm@rtClient view

Procedure for forcing permissions

If several HMI devices access an HMI device, only one HMI device has permission to
operate.

Two cases must be distinguished for this case:

e |f another HMI device is already controlling the remote HMI device, if configured
accordingly, you can force operating permission for the remote HMI device

— You are trying to operate the remote HMI device

— A dialog appears in which you are prompted to enter the appropriate password for
forcing remote control

You are now authorized to operate the remote HMI device
e [f another HMI device is accessing your HMI device via the Sm@rtClient view, you can
force local operating permission for your HMI device
— Press five times consecutively.

You are given permission to operate your local HMI device

Procedure for ending remote control

You can end monitoring or control of a remote HMI device with one of the following methods
depending on the configuration:

® Press the key configured for this

® Exit the screen containing the Sm@rtClient view
e |f configured, display a menu with + . Select the desired menu command with

and the respective identification letter.

Further information on this may be available in your plant documentation.
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8.12 Project security

8.12 Project security

8.12.1 Overview

Design of the security system

The configuration engineer can protect the operation of a project by implementing a security
system.

The security system is based on authorizations, user groups and users.

If operating elements protected by a password are operated, the HMI device first requests
that you log on. A logon screen is displayed in which you enter your user name and
password. After logging on, you can operate the operating elements for which you have the
necessary authorizations.

The logon dialog can be set up by the configuration engineer via an individual operating
element.

In the same way, the configuration engineer can set up an operating element to log off. After
logging off, objects assigned password protection can no longer be operated; to do so, log
on again.

Further information on this may be available in your plant documentation.

User groups and authorizations

Project-specific user groups are created by the configuration engineer. The "Administrators"
and "PLC User" groups are included in all projects by default. User groups are assigned
authorizations. Authorization required for an operation is specifically defined for each
individual object and function in the project.

Users and passwords

Logoff times

Each user is assigned to exactly one user group.

The following people are allowed to create users and assign them passwords:
® The configuration engineer during configuration

® The administrator on the HMI device

® A user with user management authorization on the HMI device

Irrespective of the user group, each user is allowed to change his own password.

A logoff time is specified in the system for each user. If the time between any two user
actions, such as entering a value or changing screens, exceeds this logoff time, the user is
automatically logged off. The user must then log on again to continue to operate objects
assigned password protection.
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8. 12 Project security

Backup and restore

The user data is encrypted and saved on the HMI device to protect it from loss due to power
failure.

The users, passwords, group assignments and logoff times set up on the HMI device can be
backed up and restored. This prevents you having to enter all of the data again on another
HMI device.

NOTICE

The currently valid user data is overwritten in the following cases:
e Depending on the transfer settings, when the project is transferred again
e Upon restore of a backed-up project

e Upon import of the user administration via an operating element. Further information on
this may be available in your plant documentation

The retransferred or restored user data and passwords are valid with immediate effect.

Limits for user, password and user View

8.12.2

Application

Layout

200

Number of characters
Length of user name, maximum 40
Length of password, minimum 3
Length of password, maximum 24
Entries in user view, maximum 50

User view

The user view is used to display the users on the HMI device:

e All users on the HMI device are displayed in the user view to the administrator or to a
user with administrator authorizations

® [f you are a user without user management authorization, you can only see your personal
user entry

The authorizations of a user after logging on depends on the user group to which the user is
assigned.

Further information on this may be available in your plant documentation

The configuration engineer can implement a simple or enhanced user view.

The two user views offer the same functions. They differ only in the display of information.
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8.12 Project security

Simple user view

If you are not logged on to the HMI device, the only entry contained in the simple user view
is "<ENTER>".

If you are logged on to the HMI device, the simple user view only displays the user name
and user group.

Group (9%
PLC User Group (1)
Uzer 1 Group (1)
<hew Lisers>

Enhanced user view
The enhanced user view displays information about the users.

Group Logoff time

Adrmin Group (9% 5

PLC Llger || ****wrss | Group (1) 5

User 1 | **wwswsrss | Group (1) 5

1| [ E

The enhanced user view contains the following columns:
® Users

® Password

® Group

® | ogoff time

The passwords are encrypted by appear as asterisks.

8.12.3 User logon

Logon dialog
Use the logon dialog to log on to the security system of the HMI device. Enter your user
name and password in the logon dialog.
x|
Lser: I
Passwiard: I
Ok, | Cancel |
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8. 12 Project security

The logon dialog opens in the following cases:
® You are operating an operating element with password protection

® You are operating an operating element that was configured for displaying the logon
dialog

® You activate the "<ENTER>" entry in the simple user view
® You activate a blank entry in the extended user view

® The logon dialog will be automatically displayed when the project is started, depending on
the configuration

Further information on this may be available in your plant documentation.

Requirements

The logon dialog is open.

Procedure using the touch screen
Proceed as follows:
1. Enter the user name and password.
Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
2. Select "OK" to confirm logon.

Procedure using the keys
Proceed as follows:

1. Using the key select the "User" text box within the logon dialog.

2. Enter the user name using the system keys.

To enter letters, switch the numerical keypad to letter assignment using the key .

3. Using the key select the "Password" text box.

4. Enter the password using the system keys.

5. Touch the "OK" button to confirm your entries.

Note
The user name is not case-sensitive.

The password is case-sensitive.

Result

After successful logon to the security system, you can execute password-protected functions
on the HMI device for which you have authorizations.

If you enter a wrong password, an error message is displayed when an alarm window has
been configured.
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8.12 Project security

8.124 User logoff

Requirements

You have logged into the security system of the HMI device.

Procedure
You have the following options for logging off:
® You operate an operating element that was configured for logoff
® You will be logged off automatically if you are not operating the project and if the logoff
time has been exceeded
You will also be automatically logged off if you enter an incorrect password.
Result

You are no longer logged into the project. In order to operate an operating element with
password protection, you must first log on again.

8.12.5 Creating users

8.12.5.1  Creating users with touch operation

Requirements
You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""

Procedure for creating a user in the simple user view
Proceed as follows:
1. Touch the "<New User>" entry in the user view.

The following dialog opens:

B x|
Lser: I
Password: I
(04 | Cancel
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8. 12 Project security

2. Enter the desired user name and password.
Touch the corresponding text box. The alphanumerical screen keyboard is displayed.
3. Touch the "OK" button.

The following dialog opens:

O x|
e Na |Group (1) |

Logoff time: |5

Cancel |

4. Assign the user to a group.

In order to do so, open the "Group" drop down list box by means of the | button. Select
«|and | to scroll in the drop down list box.

5. Touch the required entry in the drop down list box.
The selected entry is then accepted as input.

6. Touch the text box "Logoff time". The screen keyboard is displayed.

7. Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

8. Touch the "OK" button to confirm your entries.

Procedure for creating a user in the enhanced user view
Proceed as follows:
1. Touch the desired field in the blank line of the user view.

The appropriate screen keyboard is displayed.

2. Switch into input mode by means of the ~—| |key.
3. Enter the respective user data in the field:
— Assign the user to one of the groups from the drop down list box.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

Result
The new user is created.
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8.12 Project security

8.12.5.2 Creating users with key operation

Requirements
You have opened a screen containing the user view.

You have user management authorization or you are the administrator.

NOTICE

The following characters cannot be used in passwords:
e Blank
e Special characters *? . % /\""

Procedure for creating a user in the simple user view
Proceed as follows:

1. Select the user view using the key or using the cursor keys.

ENTER

2. Select the entry "<New user>" in the user view with the cursor keys and confirm with

The following dialog opens:

B x|
Lser: I
Password: I
(04 | Cancel |

3. Enter the desired user name using the system keys.

4. Select the next text box with the key and enter a password using the system keys.

5. Touch the "OK" button to confirm your entries.

The following dialog opens:

DN x|
Group: |Group (1) |

Logoff time: |5

(04 I Cancel |
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8. 12 Project security

6. Select the "Group" selection box with .

7. Assign the user to a group.

ENTER

— Select to open the drop down list box. The drop down list box opens.

— Select the required entry using IZI or Izl

— Confirm your entry by pressing the key .

8. Select the text box "Logoff time" with .

9. Enter the desired logoff time using the system keys.

Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for "no
automatic logoff."

10. Touch the "OK" button to confirm your entries.

Procedure for creating a user in the enhanced user view
Proceed as follows:

1. Select the user view with the key via the configured tab order.

2. Select a blank line with the IZI or Iz' keys.

3. Select the desired field in the blank line of the user view with the IE' or IE' keys.

4. Confirm your entry by pressing the key .
5. Enter the desired user data:
— Enter the data using the system keyboard. To enter letters, switch the numerical
keypad to letter assignment using the key .
— Assign the user to one of the groups from the drop down list box. Open the drop down

list box with the key and select the desired entry with the |Z| or Izl keys.

— Enter a value between 0 and 60 for the logoff time in minutes. The value 0 stands for
"no automatic logoff."

ENTER

6. Confirm your entry by pressing the key

Result
The new user is created.
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8.12 Project security

8.12.6 Changing user data

8.12.6.1  Changing user data with touch operation

Requirements
You have opened a screen containing the user view.
Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name

Group assignment

Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

— Password

— Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC.

Procedure for changing user data in the simple user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Procedure for changing user data in the enhanced user view
Proceed as follows:
1. In the user view, touch the user whose user data you want to change

2. When entering the data, use exactly the same procedure as for creating a user

Result
The user data for the user is changed.
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8. 12 Project security

8.12.6.2

Changing user data with key operation

Requirements

You have opened a screen containing the user view.

Which data you are allowed to change depends on your authorization:

® You are an administrator or a user with user management authorization. In these cases
you are allowed to change the data for all the users on the HMI device in the user view:

User name
Group assignment
Password

Logoff time

® You are a user without user management authorization. In this case you are only allowed
to change your personal user data:

Password

Logoff time, if configured

Note
You can only change the logoff time and password for the "Admin" user.

You can only change the logoff time for the "PLC_User". This user is used for logging
on via the PLC.

Procedure for changing user data in the simple user view

Proceed as follows:

1. Confirm your entry by pressing the key .

2. In the user view, use the cursor keys to select the user whose user data you want to

change. Confirm your entry by pressing the key

ENTER

3. When entering the data, use exactly the same procedure as for creating a user.

Procedure for changing user data in the enhanced user view

208

Proceed as follows:

1. Confirm your entry by pressing the key .

2. Use the cursor keys to select the field in which you want to change data. Confirm your

entry by pressing the key

ENTER

3. When entering the data, use exactly the same procedure as for creating a user
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Operating a project
8.13 Closing the project

Result
The user data for the user is changed.

8.12.7 Deleting users

Requirements
You have opened a screen containing the user view.

To delete a user, you must be an administrator or have user management authorization.

Note

The "Admin" and "PLC_User" users exist by default. These users cannot be deleted.

Procedure

To delete a user, delete the user name entered.

Result

The user has been deleted and may no longer log onto the project.

8.13 Closing the project

Procedure
Proceed as follows:
1. Use the corresponding operating element object to close the project.
Wait for the Loader to open after you closed the project.

2. Switch off power to the HMI device.
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Operating a project

8.13 Closing the project
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Operating alarms

9.1 Overview

Alarms

Alarms indicate events and states on the HMI device which have occurred in the system, in

the process or on the HMI device itself. A status is reported when it is received.

An alarm could trigger one of the following alarm events:

The configuration engineer defines which alarms must be acknowledged by the user.

Incoming
Outgoing

Acknowledge

An alarm may contain the following information:

MP 377 (WIinCC flexible)

Date

Time

Alarm text
Location of fault
State

Alarm class
Alarm number
Alarm group

Diagnostics capability
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Operating alarms

9.1 Overview

Alarm classes

Alarm groups

Alarm buffer

Alarm report

Alarm log

212

Alarms are assigned to various alarm classes:
® Error

Alarms in this class must always be acknowledged. Error alarms normally indicate critical
errors within the plant such as "Motor temperature too high"

® QOperation

Warning alarms usually indicate states of a plant such as "Motor switched on"
e System

System alarms indicate states or events which occur on the HMI device
e SIMATIC diagnostic alarms

SIMATIC diagnostic alarms show states and events of the SIMATIC S7 or SIMOTION
PLCs

® User-specific alarm classes
The properties of this alarm class must be defined in the configuration

Further information on this may be available in your plant documentation.

The configuration engineer can group alarms into alarm groups. When you acknowledge an
individual alarm of an alarm group, you acknowledge all alarms which belong to the same
alarm group.

The alarm events are stored in an internal buffer. The size of this alarm buffer depends on
the HMI device type.

The configuration engineer can activate alarm reporting on the project. In this case, alarm
events are output directly on the connected printer.

The configuration engineer can define whether each individual alarm is logged. An alarm of
this type is printed when the alarm events "Incoming" and "Outgoing" occur.

If you want to print alarms of the "System" alarm class, you have to print the contents of the
associated alarm buffer. For this case the configuration engineer has to configure an
operating element for printing the alarm buffer.

Alarm events are stored in an alarm log, provided this log file is configured. The capacity of
the log file is limited by the storage medium and system limits.
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Operating alarms

9.2 Deftecting queued alarms

9.2 Detecting queued alarms

Introduction

You can recognize the presence of alarms which must be acknowledged by the following:

® For an HMI device with keys: The LED in the key lights up.

® Depending on the configuration: An alarm indicator is displayed on screen.

The configuration determines whether an alarm has to be acknowledged or not. This is also
defined by the alarm class which an alarm belongs to.

LED in the "ACK" key

Alarm indicator

On an HMI device with keys, an LED is integrated in the key . The LED is lit if there are

alarms requiring acknowledgment which must still be acknowledged.

The LED goes out when you acknowledge all alarms requiring acknowledgment.

The alarm indicator is a graphic symbol indicating pending alarms or alarms requiring
acknowledgment, depending on the configuration.

/N

3

The alarm indicator flashes as long as alarms are pending for acknowledgment. The number
displayed indicates the number of pending alarms. The configuration engineer can assign
functions to be executed when the alarm indicator is operated.

Usually, the alarm indicator is only used for error alarms. Further information may be
available in your plant documentation.
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Operating alarms
9.3 Message display

9.3 Message display

Displaying alarms
Alarms are displayed in the alarm view or in the alarm window on the HMI device.

Alarm view
Depending on the configuration, the alarm view is displayed as follows:
® As a single line. Alarm numbers and alarm texts are displayed as single lines
® As simple alarm view
® As enhanced alarm view

In the simple or enhanced alarm views the configuration engineer specifies the alarm
information to be displayed.

Depending on the configuration, alarms from alarm logs are also displayed in the alarm view.

Simple alarm view

19.04.2005 11:41:37 ! 1
Motor 23 too hot

_?| J

The buttons have the following functions:

- | |

Buttons Functions
Displaying infotext for an alarm.

Process alarm.

Acknowledge alarm.

Select the next or previous alarm in the list.

===

Scroll one page up or down.
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Operating alarms

9.3 Message display

Enhanced alarm view

| |No. |Time |Date |Status
[ 12:04:59 19.04.2005 K

Motor 23 too hot

(]
a
il

The buttons have the following functions:

Buttons Functions

Displaying infotext for an alarm.

Process alarm.

Acknowledging alarms.

|

Changing the column sequence and sorting in the enhanced alarm view

Depending on the configuration, you can change the column sequence and sorting order on
HMI devices with touch operation.

e Change column sequence
— Touch the column header which you wish to exchange with a different column header

— Keeping the touch screen pressed, move the column heading to the column heading
you wish to exchange it with

® Change sorting order

To change the sorting order of the alarms, touch the respective column header on the
touch screen

Alarm class layout
The various alarm classes are identified in order to distinguish between them in the alarm

view.
Icon Alarm class
! Error
Without a symbol Operation
Symbol depending on the configuration | User-defined alarm classes
S7 SIMATIC or SIMOTION diagnostic alarms
$ System

The configuration engineer can change the symbols for the alarm classes. Further
information on this may be available in your plant documentation.
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Operating alarms

9.4 Displaying infotexts

Alarm window

The alarm window is independent of the process screen. Depending on the configuration,
the alarm window opens automatically as soon as a new alarm is pending for
acknowledgment. The alarm window can be configured so that it only closes after all the
alarms have been acknowledged.

The layout and the operation of the alarm window are the same as for the alarm view.

Further information on this may be available in your plant documentation.

9.4 Displaying infotexts

Displaying infotext

The configuration engineer can also provide infotext for alarms.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the j button in the simple alarm view or in the enhanced alarm view.

If configured, the infotext assigned to this alarm is displayed.

3. Close the screen for displaying the Infotext by means of the button.

Procedure using the keys
Proceed as follows:

1. Select the desired alarm in the alarm view.

2. Press .

If configured, the infotext assigned to this alarm is displayed.

3. Close the infotext by pressing key .
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Operating alarms
9.5 Acknowledge alarm

9.5 Acknowledge alarm

Requirements
The alarm to be acknowledged is displayed in the alarm window or the alarm view.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window.

The alarm is selected.

2. Touch the J button in the simple alarm view or 4 | in the enhanced alarm view.

Procedure using the keys

The alarm view and the alarm window have a tab sequence with which you can select
operating elements and the last selected alarm using the keyboard.

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , Iz' or IZ' keys.
3. Press .

Alternative operation

Depending on the configuration, you can also acknowledge an alarm with a function key.

Result

The alarm is acknowledged. If the alarm belongs to an alarm group, all the alarms of the
associated group are acknowledged.

More information on acknowledgment and on available alarm groups may be found in your
plant documentation.
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9.6 Editing alarms

9.6 Editing alarms

Introduction

The configuration engineer can assign additional functions to each alarm. These functions
are executed when the alarm is processed.

Note
When you edit an unacknowledged alarm, it is acknowledged automatically.

Requirements
The alarm to be edited is displayed in the alarm window or the alarm view.

Procedure using the touch screen
Proceed as follows:
1. Touch the desired alarm in the alarm view or the alarm window. The alarm is selected.

2. Touch the ﬂ button in the simple alarm view or & | in the enhanced alarm view.

Procedure using the keys
Proceed as follows:

1. Select the desired alarm view or alarm window with .

2. Select the desired alarm. Use the , , IZI or Izl keys.

3. Continue to press the key untiI the button ﬂ is selected in the simple alarm view or

& | in the extended alarm view.

4. Confirm your entry by pressing the key

ENTER

Result

The system executes the additional functions of the alarm. Further information on this may
be available in your plant documentation.
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Operating recipes 1

10.1 Overview

Introduction

Recipes are used when different variants of a product are manufactured with the same
process. In this case, the product variants differ in terms of their type and quantity of the
components, but not in terms of the manufacturing process sequence. The configuration
engineer can store the combination of each individual product variant in a recipe.

Field of application

Recipes can be used everywhere the same product components are used in variable
combinations to create different product variants.

Examples:

® Beverage industry

® Food processing industry
® Pharmaceutical industry

® Paint industry

e Building materials industry

e Steel industry
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Operating recipes

10.2 Structure of a recijpe

10.2 Structure of a recipe

Recipes

The recipe collection for the production of a product family can be compared to a file cabinet.
A recipe which is used to manufacture a product corresponds to a drawer in a file cabinet.

Example:

In a plant for producing fruit juice, recipes are required for different flavors. There is a recipe,
for example, for the flavors orange, grape, apple and cherry.

(
®

(
®)

//
— | @

©O) File cabinet Recipe collection Recipes for a fruit juice plant
@ Drawer Recipe Orange flavored drinks
® Drawer Recipe Grape flavored drinks
0] Drawer Recipe Apple flavored drinks
® Drawer Recipe Cherry flavored drinks
MP 377 (WinCC flexible)
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Operating recipes
10.2 Structure of a recipe

Recipe data records

The drawers of the file cabinet are filled with suspension folders. The suspension folders in
the drawers represent records required for manufacturing various product variants.

Example:
Product variants of the flavor apple might be a soft drink, a juice or nectar, for example.

ONONONO

—

Drawer Recipe Product variants of apple flavored drinks
Suspension folder Recipe data record  Apple drink

Suspension folder Recipe data record  Apple nectar

Suspension folder Recipe data record  Apple juice

® 006

Elements

In the figure showing the file cabinet, each suspension folder contains the same number of
sheets. Each sheet in the suspension folder corresponds to an element of the recipe data
record. All the records of a recipe contain the same elements. The records differ, however, in
the value of the individual elements.

Example:

All drinks contain the same components: water, concentrate, sugar and flavoring. The
records for soft drink, fruit juice or nectar differ, however, in the quantity of sugar used in
production.
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Operating recipes

10.3 Recipes in the project

10.3 Recipes in the project

Overview

222

If recipes are used in a project, the following components interact:

® Recipe view / recipe screen

On the HMI device, recipes are displayed and edited in the recipe view or in a recipe
screen.

— The recipe data records from the internal memory of the HMI device are displayed and
edited in the recipe view.

— The values of the recipe tags are displayed and edited in the recipe screen

Depending on the configuration, the values displayed in the recipe view are synchronized
with the values of recipe tags.

HMI device recipe memory

Recipes are saved in the form of data records in the HMI device recipe memory.
The recipe data can also be saved in recipe tags.

Recipe tags

The recipe tags contain recipe data. When you edit recipes in a recipe screen, the recipe
values are stored in recipe tags. Depending on the configuration, the values of the recipe
tags are exchanged with the PLC.

The recipe tags can be synchronized with the recipe data records so that the same
values are saved in both.

Memory card

The memory card is an external storage medium for recipe data records. The recipe data
records are exported from the HMI device recipe memory and are saved on the memory
card in a *.csv file. The records can be reimported from the memory card to the recipe
memory.
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Operating recipes
10.3 Recipes in the project

Data flow
The following figure shows the data flow in a project with recipes.
HMI device m
Recipe view @ v
Recipe 1
/-> « Recipe 2
/ « =" @ Recipe 3
1 @
Reci —p Recipe tag A
ecipe
screen @ T \\ _/
® q
Memory card
® Editing, saving or deleting a recipe data record
@ Display recipe data record
® Synchronize or do not synchronize recipe tags
@ Display and edit recipe tags in the recipe screen
® Write records from the recipe view to the PLC or read records from the PLC and
display them in the recipe view
® Recipe tags are to the PLC online or offline
@ Export or import recipe data record to memory card
MP 377 (WinCC flexible)
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Operating recipes

10.4 Recipe displays

10.4 Recipe displays

Displaying recipes
You can display and edit recipes on the HMI device with a recipe view or recipe screen.

Recipe view

A recipe view is a screen object used to manage recipe data records. The recipe view shows
recipe data records in tabular form.

Depending on the configuration, the recipe view is displayed as follows:
® As enhanced recipe view
® As simple recipe view

The configuration engineer also defines which operating elements are displayed in the recipe
view.

Enhanced recipe view
The following figure shows an example of the enhanced recipe view.

RFecipe Mame: Mo,
@7|Orange j | 1 4@
Data Record Mame: Ma.:

@7| Mectar j |2 4@
Enfry Mame YWalue 2
(B)——water s——5)
Concentrate o

G050 et

Selection box for the recipe

Selection box for the recipe data record

Element name
The element name designates a specific element in the recipe data record

Display field

This show the number of the selected recipe or the selected recipe data record
Value of the element

Buttons for editing a recipe data record

Status bar for display of the status messages

Qe © 606
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Operating recipes

10.4 Recipe displays

Simple recipe view

Display of values

The simple recipe view consists of three areas:
® Recipe list

e Record list

® Element list

In the simple recipe view, each area is shown separately on the HMI device. Depending on
the configuration, the simple recipe view starts with the recipe list or data record list.

The following figure shows an example of the record list.

Juice
Beverage -—
Nectar

Number of the recipe data record
Recipe data records
Buttons for changing the displayed list and calling the menu

@00 (——eoenr-=
|

NOTICE
Changing the recipe data record in the background

Applies to the processing of a recipe data record:
If values of the corresponding recipe data record are changed by a PLC job, the recipe view
is not updated automatically.

To update the recipe view, reselect the respective recipe data record.
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10.4 Recipe displays

Recipe screen

226

A recipe screen allows the correlation between the plant and the recipe data to be displayed
in graphic form. The configuration engineer combines /O fields and screen objects to form a
custom input screen. The configuration engineer can distribute the 1/O fields of a recipe over
several recipe screens, thus allowing recipe elements to be arranged by subject. The recipe
screen can be operated using buttons configured accordingly.

The following figure shows an example of the recipe screen.

N A\
40 - Recipe name No.:
70 - | Orange T 1
30 - Data record name No.:
30 -) [ Nectar ¥ 2 /)

= N
Save | Data from the PLC |

Load | Data to PLC |

® QD
Element name and associated values

The element name designates a specific element in the recipe data record
Buttons for editing a recipe data record

Modified recipe view

Buttons for transferring recipe data

®e 66 o6

The values displayed or entered in the recipe screen are saved in recipe tags. The recipe
values are exchanged with the PLC immediately or later via these tags.

A configured recipe view can itself be a component of a recipe screen You must synchronize
the tags in order to synchronize data between the tags of the recipe screen and the recipe
data records displayed in the recipe view. Synchronization of tags is only possible in the
enhanced recipe view.

Further information on this may be available in your plant documentation.
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10.5 Recipe values in the HM/ device and the PLC

10.5 Recipe values in the HMI device and the PLC

Introduction

You can change the values of a recipe on the HMI device and therefore influence the
manufacturing process or a machine.

Depending on the configuration, the recipe values are displayed, edited and saved in
different ways:

e |f you are editing recipes with a recipe view in your project, the values are saved in recipe
data records

® |f you are editing recipes in a recipe screen in your project, the values are saved in recipe
tags

Differences may occur between the display values in the recipe view and the values saved in
the associated tags in an ongoing project when you edit recipes with a recipe view and in a
recipe screen. To prevent this, the recipe data record values must be synchronized with the
values of the recipe tags.

You have however the option to perform synchronization operations at any time.
Synchronization only takes place if the configuration engineer has activated the respective
settings for a recipe.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

Synchronizing recipe tags
Synchronization of the recipe tags depends on the configuration:
e Automatic synchronization:

The values of the recipe view are synchronized with the associated recipe tags. In this
case, changes to values in the recipe view have an immediate effect on the values of the
associated recipe tags. The values are only synchronized, when an operating element
that is outside the recipe view is operated.

e Synchronization by the user:

The values of the recipe view and the associated recipe tags are not synchronized

automatically. The configuration engineer has assigned the same function to the ﬁl
button or a different operating element in the recipe view. The recipe tags and the recipe
view are only synchronized when you operate the buttons or the appropriate operating

element.
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10.6 Operating the recipe view

Recipe tags online / offline

The configuration engineer can configure a recipe so that changes to the values of the recipe
tags do not have an immediate effect on the current process.

Synchronization of the recipe values between the HMI device and the PLC depends on
whether the configuration engineer has selected the settings "Tags online" or the setting
"Tags offline" for a recipe.

"Tags online":
This setting has the following effect:

— When you change recipe values in the recipe screen, these changes are applied
immediately by the PLC and immediately influence the process

— If recipe values are changed in the PLC, the changed values are displayed
immediately in the recipe screen

"Tags offline":

With this setting, changed recipe values are not synchronized immediately between the
HMI device and the PLC

In this case, the configuration engineer must configure operating elements for transferring
the values to the PLC or reading them from the PLC in a recipe screen. The recipe values
are only synchronized between HMI device and PLC when you operate the appropriate
operating element

10.6 Operating the recipe view

10.6.1 Overview

Operation

The recipe view can be operated as follows:

228

Enter values for the recipe elements

Create recipe data records

Save recipe data records or save them under a new name

Delete recipe data records

Synchronize values of the recipe view with the associated recipe tags

Transfer recipe data records from the PLC and to the PLC
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Operating recipes

Operating elements of the recipe view

10.6 Operating the recipe view

The following table shows the operating elements of the recipe view.

Buttons

Key combination

Functions

{1
e L[]

Creates a new recipe data record.
If a start value is configured, it is shown in the text box.

CTRL|

ENTER|

+

Saves the displayed values of the recipe data record.
The storage location is predefined by the project.

===

9]
=
T
—
+
I

The recipe data record is saved under a different name
irrespective of the recipe view. A dialog box opens in which
the name is entered.

O
=
pel
z
+

The displayed recipe data record is deleted.

[:3ES

9]
=
T
P

The values of the recipe view are synchronized with the
associated recipe tags. The values changed during editing are
written to the associated recipe tags. Subsequently all the
values of the tags are read out and updated in the table.

0O
=
T
z
+

The recipe values from the PLC are displayed in the recipe
view.

L3

0O
=
T
z
+

<> O

The values of the set recipe data record displayed in the
recipe view are transferred to the PLC.

Operating the recipe screen

You operate the recipes in a recipe screen with the operating elements provided by the
configuration engineer.

Further information on this may be available in your plant documentation.

10.6.2 Creating a recipe data record

Introduction

You create a new recipe data record by modifying an existing record. You then save the
modified data record under a new name.

Requirements

A screen with a recipe view is displayed.
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10.6 Operating the recipe view

Procedure using the touch screen
Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

Touch El

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

Touch il

Enter a name for the data record.
The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

Procedure using the keys
Proceed as follows:

Result

230

1.

If the recipe view contains several recipes: Select the recipe for which you want to create
a new recipe data record.

{1}
press [11] « [u]

A new recipe data record with the next available number is created.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Enter values for the elements of the data record.

The elements of the recipe data record can be assigned default values depending on the
configuration.

5. Enter a name for the data record.

6. Confirm your entry.

The data record is saved under the new name.

If the recipe data record already exists, a dialog is opened. In this dialog, specify whether
the existing data record is to be overwritten.

The new recipe data record is saved to the selected recipe.
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10.6 Operating the recipe view

10.6.3 Editing a recipe data record

Introduction
Edit the values of the recipe data records and save them in a recipe view.

Synchronization with the PLC
If you want to display the current recipe values from the PLC in the recipe view, you first

have to read the current values from the PLC with ﬂ

The values changed in the recipe view only become effective when the amended data record

is transferred to the PLC by means of theﬂl button.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.

4. Save your changes by means of the El button.

If you want to save the recipe data record under a different name, touch the = | key.

5. The recipe data record is saved.

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to change.

3. Change the data record as required.

4. Save your changes with + [

If you want to save the recipe data record under a different name, press + .

The recipe data record is saved.
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10.6 Operating the recipe view

Result
The edited recipe data record has now been saved in the selected recipe.

10.6.4 Deleting a recipe data record

Introduction
You can delete all the data records of a recipe which are not required.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

3. Touch il

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to delete.

INS
3. Press + .

Result
The recipe data record is deleted.
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10.6 Operating the recipe view

10.6.5 Synchronizing tags

Introduction

Requirements

The values of the recipe elements can be saved to recipe tags, depending on the
configuration.

Differences may occur between the display values in the recipe view and the actual values of
tags in an ongoing project. Synchronize the tags to equalize such differences.

Synchronization always includes all the variables which belong to a recipe data record.

NOTICE

Changed tag name

Tags and the value of the recipe data record cannot be assigned to each other if the tag
name of the tag to be synchronized has been changed. The tags in question are not
synchronized.

Note
Recipe tags can only be synchronized in the enhanced recipe view.

A screen with a recipe view is displayed.

Procedure using the touch screen

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Touch @

Procedure using the keys

Result

Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to synchronize.

3. Press o] +[ =]

The elements of the recipe data record are synchronized with the recipe tags.
If the values of the recipe view and the tag do not match, the more current value is accepted.
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10.6 Operating the recipe view

10.6.6 Reading a recipe data record from the PLC

Introduction

Requirements

In the current project, the values which are also stored in the recipes in the HMI device can

be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the recipe data records saved
in the HMI device possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.

A screen with a recipe view is displayed.

Procedure using the touch screen

Proceed as follows:

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

. Select the recipe data record to which you want to apply the values from the PLC.

Touch ﬂ

The values are read from the PLC.

If you want to store the displayed values in the HMI device, touch the El button.

Procedure using the keys
Proceed as follows:

Result

234

1.

If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the recipe data record to which you want to apply the values from the PLC.

o 1. ]

The values are read from the PLC.

If you want to store the displayed values in the HMI device, press the keys + |77

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.
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10.6 Operating the recipe view

10.6.7 Transferring a recipe data record to the PLC

Introduction

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

Requirements
A screen with a recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Touch El

Procedure using the keys
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record whose values you want to transfer to the PLC.

3. Press P +[ V]

Result

The display values in the recipe view were transferred to the PLC and take effect in the
process.
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10.7 Operating the simple recipe view

10.7 Operating the simple recipe view

10.7 1 Overview

Introduction

The simple recipe view consists of three areas:

® Recipe list

® Record list

® FElement list

You can use the context menu to operate each of these display areas.
Operation

The simple recipe view can be operated as follows:

® Enter values for the recipe elements

® (Create recipe data records

® Save recipe data records or save them under a new name
® Delete recipe data records

® Transfer recipe data records from the PLC and to the PLC

Operating elements of the simple recipe view
Toggle between the display areas and the context menus to operate the simple recipe views.

The following table shows the operation of the display area.

Touch operation Key control Functions
Touching an entry The next lower display area opens.
ENTER
:l o The next higher display area opens.
:l :l The context menu of the display area opens.

The following table shows the operation of the context menu.

Touch operation Key control Functions
J The menu is closed.
-+ ESE .
The display area opens.
Touch the menu Input of the number | The menu command is executed.
command of the menu
command
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Context menus of the simple recipe view

10.7 Operating the simple recipe view

A number is assigned to each menu command which you can use to call the menu
command with key control.

With touch operation, touch the menu command to execute it.

Some menu functions can also be called directly in the lists of the simple recipe view using
the keys.

® Recipe list

No. Menu command | Key combination | Functions
0 New A new recipe data record is created for the selected
recipe.
If a start value is configured, it is shown in the text box.
1 Displaying The infotext configured for the simple recipe view is
infotext displayed.
2 Open The record list of the selected recipe opens.
ENTER

® Record list

No. Menu command | Key combination | Functions

0 New A new recipe data record is created for the selected
recipe.

If a start value is configured, it is shown in the text box.

1 Delete The selected record is deleted.

2 Save as The selected record is saved under a different name
irrespective of the simple recipe view. A dialog box
opens in which the name is entered.

3 Rename The selected record is renamed. A dialog box opens in
which the name is entered.

® FElement list

No. Menu command | Key combination | Functions

0 Save The selected record is renamed.

1 To PLC The display values of the selected record are
transferred from the HMI device to the PLC.

2 From PLC The recipe values from the PLC are displayed on the
HMI device in the recipe view.

3 Save as The selected record is renamed. A dialog box opens in
which the name is entered.

Touch operation of the menu

Touch the desired menu command. The command is executed.
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10.7 Operating the simple recipe view

Key control of the menu

Select the required entry using Izl or IZI Press .

Alternatively, press the numerical key with the number of the desired menu command.

The command is executed.

Operating the recipe screen

You operate the recipes in a recipe screen with the operating elements provided by the
configuration engineer.

Further information on this may be available in your plant documentation.

10.7.2 Creating a recipe data record

Introduction

Create a new recipe data record in the recipe list or in the record list. Then enter the values
for the new record in the element list and save the record.

Requirements
A screen with a simple recipe view is displayed.

Procedure
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe for which you want to create a
new recipe data record.

2. Open the recipe list menu.
3. Select the menu command "0 New".
A new record is created.
The element list of the new record opens.
4. Enter values for the elements of the data record.
The tags of the record can be assigned default values depending on the configuration.
5. Open the element list menu and select the menu command "0 Save".
6. Enter a name for the new record.
7. Confirm your entries.

If you change the new data record number to an existing data record number, the existing
data record is overwritten.

Result

The new recipe data record is saved to the selected recipe.
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10.7 Operating the simple recipe view

10.7.3 Editing a recipe data record

Introduction

Edit the values of the recipe data records in a simple recipe view.

Synchronization with the PLC

If you want to display the current recipe values from the PLC in the simple recipe view, you
first have to read the current values from the PLC with the menu command "2 from PLC" in
the element list.

The values changed in the recipe view only take effect in the PLC when you transfer the
edited data record to the PLC with the menu command "1 to PLC".

Requirements

A screen with a simple recipe view is displayed.

Procedure

Proceed as follows:

1.

o 0k N

Result

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.

Select the recipe data record you want to change.
Open the element list.

Change the values of the records as required.

Save your changes with the menu command "0 Save".

The recipe data record is saved.

The edited recipe data record has now been saved in the selected recipe.
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10.7 Operating the simple recipe view

10.7.4 Deleting a recipe data record

Introduction
You can delete all the data records which are not required.

Requirements
A screen with a simple recipe view is displayed.

Procedure using the touch screen
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Open the data record list.
Select the data record you want to delete.

Open the menu.

o > N

Select the menu command "1 Delete".

Procedure using the keys
Proceed as follows:

1. If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Open the data record list.

3. Select the data record you want to delete.

INS
4. Press .

Result
The data record is deleted.

10.7.5 Reading a recipe data record from the PLC

Introduction
The values of recipe elements are exchanged with the PLC via tags.

In the current project, the values which are also stored in the recipes in the HMI device can
be changed directly in the plant. This is the case, for example, if a valve was opened further
directly at the plant than is stored in the recipe. The values of the tags on the HMI device
possibly no longer match the values in the PLC.

To synchronize the recipe values, read the values from the PLC and display them in the
recipe view.
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Operating recipes

Requirements

Procedure

Result

10.7 Operating the simple recipe view

A screen with a simple recipe view is displayed.

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

Select the element list of the recipe data record to which you want to apply the values
from the PLC.

3. Open the menu.

4. Select the menu command "2 from PLC".

The values are read from the PLC.

If you want to save the display values in the HMI device, select the menu command "0
Save".

The values were read from the PLC, displayed on the HMI device and saved to the selected
recipe data record.

10.7.6 Transferring a recipe data record to the PLC

Introduction

Requirements

Procedure

Result

In order for an edited recipe data record to take effect in the process, you must transfer the
values to the PLC.

The display values in the recipe view are always transferred to the PLC.

A screen with a simple recipe view is displayed.

Proceed as follows:

1.

If the recipe list contains several recipes: Select the recipe which contains the desired
recipe data record.

. Select the element list of the recipe data record whose values you want to transfer to the

PLC.

3. Open the menu.

4. Select the menu command "1 To PLC".

The values of the recipe data record were transferred to the PLC and take effect in the
process.
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10.8 Importing a recipe data record

10.8 Importing a recipe data record

Introduction

You can import values from a CSV file to a recipe data record, depending on the
configuration.

Requirements

® An operating element with the function "Import data record" has been configured, for
example a button

® A screen with a recipe view is displayed.

Procedure
Proceed as follows:
1. If the recipe view contains several recipes: Select the recipe which contains the recipe
data record to be imported.
2. Operate the operating element with the function "Import data record".
The record is imported from an external data medium as a CSV file and then displayed in
the recipe view after import.
Result

The imported recipe data record is saved on the HMI device.

Deviating structure

If the structure of the CSYV file differs from the structure of the recipe, deviations are handled
as follows:

® Any additional values in the CSV file will be rejected

® The system applies the configured default value to the recipe data record if the CSV file
contains an insufficient number of values

e |f the CSV file contains values of the wrong data type, the configured default value is set
in the recipe data record

Example:
The imported CSV file contains values that were entered as floating point numbers.

However, the corresponding tag expects an integer value. In this case, the system
discards the imported value and uses the configured default.
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10.9 Exporting a recipe data record

10.9 Exporting a recipe data record

Introduction

You can export one or more recipe data records to a CSV file, depending on the
configuration. After export, the values in the recipe data record can be further processed in a
spreadsheet program such as MS Excel. The degree to which you can influence the export
depends on the configuration:.

Requirements
® A screen with a recipe view is displayed.
® An operating element with the function "Export record" has been configured.

® The following tags are configured equally in the recipe view and for the "Export record"
operating element:

— Recipe number

— Data record number

Procedure
Proceed as follows:

1. If the recipe view contains several recipes: Select the recipe which contains the desired
recipe data record.

2. Select the recipe data record you want to export.

3. Operate the operating element which was configured for export, for example the "Export
data record" button.

The data record is exported as a CSV file to an external data medium.

Further information on this may be available in your plant documentation.

Result
The recipe data record is exported.
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10.10 Examples

10.10

10.10.1

Introduction

Procedure

244

Examples

Entering a recipe data record

You would like to enter production data on the HMI device without interrupting the process in
the machine or plant. For this reason, the production data should not be transferred to the
PLC.

Proceed as follows:

1.

2
3.
4

Call the recipe view or a recipe screen.

. Select the desired recipe data record.

Enter the values of the elements.

. Save the recipe data record.

The recipe data record is saved in the internal memory of the HMI device.

The following figure shows the data flow schematically.

HMI device m

Recipe view @ w

Recipe 1
Recipe 2
—o @
/ @
Recipe tag

Recipe 3
Recipe
screen @ v

©@®e 60

S
©

PLC

Display recipe data record

Save recipe data record

Tags are synchronized

Display and edit recipe tags in the recipe screen
Tags are offline
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10.10.2 Manual production sequence

Introduction

10.10 Examples

You request the production data of different workpieces from the PLC and display this data
on the screen of the HMI device for inspection. You want to correct the transferred

Procedure

production data in the recipe view or the recipe screen if necessary.

A scanner connected to the PLC reads the barcode of a workpiece. The barcode names
correspond to the names in the recipe data record. Based on the barcode name, the PLC
can read the required recipe data record. The recipe data record is displayed for inspection
on the HMI device. You can now edit and save the recipe data record. Then transfer the
edited recipe data record to the PLC again.

The following figure shows the data flow schematically.

MP 377 (WIinCC flexible)
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10.10 Examples
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Maintenance and care

11.1 Maintenance and care

Introduction

Requirements

Procedure

11

The HMI device is designed for maintenance-free operation. The touch screen and keyboard

membrane should nevertheless be cleaned regularly.

Use a cleaning cloth dampened with a cleaning agent to clean the equipment. Only use
water with a little liquid soap or a screen cleaning foam.

NOTICE

Unintentional response

When cleaning the touch screen, an unintentional response in the controller can be
triggered by touching keys.

Switch the HMI device off before cleaning to prevent unintentional responses.
Damage caused by unauthorized cleaning products

The HMI device may be damaged if compressed air, steam jet-air ejectors, aggressive
solvents or scouring powders are used for cleaning purposes.

Do not clean the HMI device with compressed air or steam jet blowers. Do not use
aggressive solvents or scouring powder.

Proceed as follows:
1. Switch off the HMI device.
2. Spray the cleaning solution onto a cleaning cloth.
Do not spray directly onto the HMI device.
3. Clean the HMI device.
When cleaning the display wipe from the screen edge inwards.
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11.2 Clean screen on MP 377 Touch

11.2

Introduction

11.3

248

Clean screen on MP 377 Touch

The HMI touch screen can be cleaned when it is switched on and a project is running. An
operating element must be available in the project with which the clean screen can be called
up. Once the clean screen is activated, touch screen operation is locked for a configured
period of time. The time the touch screen is locked can be set between 5 and 30 seconds.
The time remaining for the lockout is indicated by a progress bar.

NOTICE

Unintentional responses

When cleaning the touch screen, an unintentional response in the controller can be
triggered by touching keys.

Always open the clean screen or switch off the HMI device before you clean the touch
screen while the system is running!

Once the period for the clean screen has passed, operations are again possible. Avoid data
inadvertent operations.

Cannot be operated when the clean screen is active
When the clean screen is active, operations on the HMI device are not possible.

Wait for the period for the clean screen to lapse. Then you can operate the plant again with

the HMI device.

Protective foil

Protective foil is available for the HMI device touch screens. You will find the necessary
ordering data online at "http://mall.automation.siemens.com". The protective foil is not part of
the scope of delivery of the HMI device.

The self-adhesive protective foil prevents the screen from being scratched and soiled. The
matt surface of the protective foil reduces reflections where lighting is poor.

The protective foil can be removed without leaving any adhesive residue on the screen.

CAUTION

Applying and removing the protective foil

Always switch off the HMI device before applying the protective foil. Otherwise, there is a
risk that functions are inadvertently activated. This also applies to removing the protective
foil.

Never use sharp or pointed objects such as a knife to remove the protective foil. You might
otherwise damage the touch screen.
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Maintenance and care

11.4 Spare parts and repairs

11.4 Spare parts and repairs

Repairs

Service pack

In case of repair, the HMI device must be shipped to the Return Center in Firth. Repairs
may only be carried out at the Return Center in Firth.

Depending on the work necessary to repair the device, the Center may decide to give you a
credit note. In this case, it is your responsibility to order a new device.

The address is:

Siemens AG
Automation and Drives
Returns Center
Siemensstr. 2

90766 Firth

Germany

A service pack for maintenance can be ordered separately. The necessary ordering data can
be found in the Siemens ST 80 Catalog.

The service pack includes:
® Mounting seals
® Mounting clamps

® Plug-in terminal strip, 2-pin

Service & Support on the Internet

Service & Support provides additional comprehensive information on SIMATIC products
through online services at "http://www.siemens.com/automation/support”.

Information about on-site services, repairs, spare parts, and much more is available on our
"Services" pages.
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11.4 Spare parts and repairs
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Technical specifications 1 2

12.1 Dimension drawings

1211 Dimension drawings of the MP 377 12" Touch
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Technical specifications

12.1 Dimension drawings

12.1.2 Dimension drawings of the MP 377 12" Key
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Technical specifications

12.1 Dimension drawings

12.1.3 Dimension drawings of the MP 377 15" Touch
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Technical specifications

12.1 Dimension drawings

1214 Dimension drawings of the MP 377 19" Touch
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Technical specifications

12.2 Specifications

12.2 Specifications
HMI device
MP 377 12" Touch | MP 377 12" Key MP 377 15" Touch | MP 377 19" Touch
Weight without packing 3.75 kg 5.41 kg 4.69 kg 7.65 kg
Display
MP 377 12" Touch | MP 377 12" Key | MP 377 15" Touch | MP 377 19" Touch
Type LCD-TFT
Display area, active 246 mm x 184.5 mm (12.1") 304.1 mm x 228.1 | 376.3 mm x 301.1
mm mm
(15") (19"
Resolution 800 x 600 pixels 1024 x 768 pixels | 1280 x 1024 pixels
Colors, displayable 64 k
Brightness control Yes
Backlighting CCFL
Half brightness life time, typical 50,000 h

Pixel error class according to
DIN EN ISO 13406-2

Input unit
MP 377 12" Touch | MP 377 12" Key MP 377 15" Touch | MP 377 19" Touch
Type Touch screen, Keyboard Touch screen, analog, resistive
analog, resistive
Memory

MP 377 12" Touch | MP 377 12" Key MP 377 15" Touch | MP 377 19" Touch

Application memory

12 MB

Ports

MP 377 12" Touch | MP 377 12" Key MP 377 15" Touch | MP 377 19" Touch

1 x RS 422/RS 485

Max. 12 Mbit/s, applies to DP operations

2xUSB 2.0

USB host
conforms to USB standard 2 (supporting low-speed and full-speed USB devices),
maximum load 500 mA

2 x Ethernet

RJ45 10/100 Mbits

Audio

Line out

MP 377 (WIinCC flexible)
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Technical specifications

12.2 Specifications

Supply voltage

MP 377 12" Touch

MP 377 12" Key

| MP 377 15" Touch

| MP 377 19" Touch

Nominal voltage
Voltage range, permissible

+24 VDC

19.2Vto 28.8

V (=20 %, +20 %)

Transients, maximum
permissible

35V

(500 ms)

Time between two transients,
minimum

50s

Current consumption

o Typical

e Constant current, maximum
e Power on current surge 12t

Approx. 1,300 mA
Approx. 1,800 mA
Approx. 4 A%s

Approx. 1,300 mA
Approx. 1,800 mA
Approx. 4 A%s

Approx. 1,700 mA
Approx. 2,500 mA
Approx. 4 A%s

Approx. 2,200 mA
Approx. 3,100 mA

Approx. 4 A%s

Fuse, internal

Electronic

Miscellaneous

MP 377 12" Touch

MP 377 12" Key

MP 377 15" Touch

MP 377 19" Touch

Realtime clock, buffered ?

Yes

Loudspeaker

Onboard

Magnetic field strength

50/60 Hz; 100 A/m RMS

1

256

Bridging time of the buffering - approx. 6 weeks.
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Technical specifications

12.3

Bit assignment of the direct keys

The following figures show the assignment of the keys and LEDs to the bytes in the PLC
process image.

Further information may be available in your plant documentation.

12.3 Bit assignment of the direct keys

Note

Do not use the LED bits "ACK", "A-Z I", "A-Z r" and "HELP" when a project is running on the
HMI device.

Bit assignment of the direct keys for the MP 377 12" Key

| Key bits | LED bits
7 6 5 4 3 2 1 0 Byte 7 6 5 4 3 2 1 0
S8 | s7|s6|s5|s4|s3|s2]| s n S8 | s7|s6|sS5|s4|s3]|s2]| s1
S16 | S15 [ S14 | 13 | S12| S11 | S10 | S9 n+1 S16 | S15 | S14 | S13 | S12 | 11| S10 | S9
F8 | F7 | F6 | F5 | F4 | F3 | F2 | F1 n+2 F8 | F7 | F6 | F5 | F4 | F3 | F2 | F1
F16 | F15 | F14 | F13 | F12 | F11 | F10 | F9 n+3 | |F16 | F15 | F14 | F13 [ F12 | F11 | F10 | F9
ACK | ALT |CTRL|SHIFT| F20 | F19 | F18 | F17 | | n+4 | | Ack | 52 | 255 |INFO| F20 | F19 | F18 | F17
Bit assignment of the direct keys for the MP 377 12" Touch, MP 377 15" Touch and
MP 377 19" Touch
| Touch assignment |
7 6 5 4 3 2 1 0 Byte
7|16 |5 |4 3] 2|1 n
1514 [ 13[12]11]10] 9 n+1
23|22 | 21| 20| 19| 18] 17 | 16 n+2
31 | 30 | 20 | 28 | 27 | 26 | 25 | 24 n+3
390 | 38 | 37 | 36 | 35 | 34 | 33 | 32 n+4
MP 377 (WinCC flexible)
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Technical specifications

12.4 Description of the ports

12.4 Description of the ports

12.4.1 Power supply

Plug connector, 2-pin

1 2

]

Figure 12-1  Power supply pin assignment

Pin Assignment

1 +24 VDC (L+)

2 GND24V (M)

124.2  X10/IF 1B (RS 422/RS 485)

Sub-D socket, 9-pin, with screw lock

5 1

BB

9 6

Figure 12-2  Pin assignment of the interface X10/IF 1B

Pin Assignment for the RS 422 Assignment for the RS 485
1 n. c. n. c.
2 GND 24V GND 24V
3 TxD+ Data channel B (+)
4 RD+ RTS"
5 GND 5V, floating GND 5V, floating
6 +5 VDC, floating +5 VDC, floating
7 +24 VVDC, out (max. 100 mA) +24 VVDC, out (max. 100 mA)
8 TxD- Data channel A (-)
9 RxD- RTS"
N On pin 4 or pin 9, can be set with DIP switch on the rear of the device
MP 377 (WinCC flexible)
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Technical specifications

12.4.3 X1 (PROFINET)
RJ45 plug connector

1

nannnnn
1 8

Figure 12-3  Pin assignment of the RJ45 connector

12.4 Description of the ports

Pin Assignment

Tx+

Tx—

Rx+

n.c.

n.c.

Rx—

n.c.

O |IN|oOjO |~ |WIN]|~

n. c.

1244 X20, X21 (USB)
USB socket

=]

Figure 12-4  Pin assignment of the X20 and X21 ports

Pin Assignment

+5 VDC, out,

max. 500 mA

USB-DN

USB-DP

AW IN]|=-

GND

MP 377 (WinCC flexible)
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Technical specifications

12.4 Description of the ports

1245  X40 (line out)

Line out connector

Figure 12-5 Pin assignment of line out connector

Pin Assignment

Left audio channel

Right audio channel
3 GND

MP 377 (WIinCC flexible)
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Appendix l \

A.1 ESD guideline

Definition of ESD

All electronic modules are equipped with large-scale integrated ICs or components. Due to
their design, these electronic elements are highly sensitive to overvoltage, and thus to any
electrostatic discharge. These electronic components are therefore specially identified as

ESDs.
Abbreviations
The following abbreviation is commonly used for electrostatic sensitive devices:
o EGB - Elektrostatisch Gefahrdete Bauteile/Baugruppen (Germany)
e ESD - Electrostatic Sensitive Device (internationally recognized term)
Labeling

ESDs are labeled with the following symbol:

y
Arad

Electrostatic charging

CAUTION

Electrostatic charging

ESDs may be destroyed by voltages far below the level perceived by human beings.
Voltages of this kind develop when a component or an assembly is touched by a person
who is not grounded against static electricity. Usually, it is unlikely that damage to an ESD
as a result of overvoltage is detected immediately but may become apparent only after a
longer period of operation.

Prevent electrostatic charging of your body before you touch the ESD!

MP 377 (WIinCC flexible)
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Appendix

A.1 ESD guideline

Anyone who is not connected to the electrical potential of their surroundings is subjected to
electrostatic charging.

The following figure indicates the maximum electrostatic charge anyone is subjected to when
coming into contact with the materials shown. These values correspond with specifications to
IEC 801-2.

Voltage

SNWhOOTON®O

: T T T T T T
510 20 30 40 50 60 70 80 90 100 [%]
Relative humidity

0] Synthetic materials
® Wool
®

Antistatic materials such as wood or concrete

Protective measures against electrostatic discharge

CAUTION

Observe grounding measures

When working with electrostatic sensitive devices, make sure that the person, the
workplace and the packaging are properly grounded. This helps to avoid electrostatic
charging.

As a rule, only touch the ESD if this is unavoidable, for example for maintenance. When you
touch modules, make sure that you do not touch the pins on the modules or the PCB tracks.
In this way, the discharged energy can not affect the sensitive devices.

Discharge electrostatic electricity from your body if you are performing measurements on an
ESD. Do so by touching grounded metallic parts.

Always use grounded measuring instruments.

MP 377 (WIinCC flexible)
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Appendix

A.2 System alarms

Introduction

A.2 System alarms

System alarms on the HMI device provide information about internal states of the HMI device

and PLC.

The following overview shows the causes of system alarms and how to eliminate the cause

of error.

Some of the system alarms described in this section are relevant to individual HMI devices

based on their range of features.

Note

System alarms are only indicated if an alarm window was configured. System alarms are
output in the language currently set on your HMI device.

System alarm parameters

System alarms may contain encrypted parameters which are relevant to troubleshooting
because they provide a reference to the source code of the runtime software. These
parameters are output after the text "Error code:"

Meaning of the system alarms

All the system alarms that can be displayed are listed below. The system alarms are divided

into different ranges:

Table A-1 10000 - Printer alarms

Number Effect/cause Remedy

10000 The print job could not be started or was canceled Check the printer settings, cable connections and the
due to an unknown error. Faulty printer setup. Or: No | power supply.
authorization is available for accessing the network Set up the printer once again. Obtain a network
printer. printer authorization.
Power supply failure during data transfer. If the error persists, contact the Hotline!

10001 No printer is installed or a default printer has not been | Install a printer and/or select it as the default printer.
set up.

10002 Overflow of the graphics buffer for printing. Up to two | Allow sufficient intervals between successive print
images are buffered. jobs.

10003 Images can now be buffered again. --

10004 Overflow of the buffer for printing lines in text mode Allow sufficient intervals between successive print
(e.g. alarms). Up to 1000 lines are buffered. jobs.

10005 Text lines can now be buffered again. -

10006 The Windows printing system reports an error. Refer | Repeat the action if necessary.
to the output text and the error ID to determine the
possible causes. Nothing is printed or the print is
faulty.
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Operating Instructions, 09/2007, 6AV6 691-1DR01- C S@
VICPAS
‘:om |

263

Everg,-'thin? for your HMI running
B sales@vicpas.com

O +86-15876525394



Appendix

A.2 System alarms

Table A-2 20000 - Global script alarms

Number Effect/causes Remedy

20010 An error has occurred in the specified script line. Select the specified script line in the configuration.
Execution of the script was therefore aborted. Note Ensure that the tags used are of the allowed types.
the system alarm that may have occurred prior to Check system functions for the correct number and
this. types of parameters.

20011 An error has occurred in a script that was called by In the configuration, select the script that has been
the specified script. called directly or indirectly by the specified script.
Execution of the script was therefore aborted in the Ensure that the tags used are of the allowed types.
called script. Check system functions for the correct number and
Note the system alarm that may have occurred prior | types of parameters.
to this.

20012 The configuration data is inconsistent. The script Recompile the configuration.
could therefore not be generated.

20013 The scripting component of WinCC flexible Runtime | Reinstall WinCC flexible Runtime on your PC.
is not correctly installed. Therefore, no scripts can be | Rebuild your project with "Project > Generator >
executed. Generate" and transfer the project to the HMI device.

20014 The system function returns a value that is not written | Select the specified script in the configuration.
in any return tag. Check whether the script name has been assigned a

value.

20015 Too many successive scripts have been triggered in | Find what is triggering the scripts. Extend the times,
short intervals. When more than 20 scripts are e.g. the polling time of the tags which trigger the
queued for processing, any subsequent scripts are scripts.
rejected. In this case, the script indicated in the alarm
is not executed.

Table A-3 30000 - Alarms for IFwSetValue: SetValue()

Number Effect/causes Remedy

30010 The tag could not accept the function result, e.g. Check the tag type of the system function parameter.
when it has exceeded the value range.

30011 A system function could not be executed because the | Check the parameter value and tag type of the invalid
function was assigned an invalid value or type in the | parameter. If a tag is used as a parameter, check its
parameter. value.

30012 A system function could not be executed because the | Check the parameter value and tag type of the invalid
function was assigned an invalid value or type in the | parameter. If a tag is used as a parameter, check its
parameter. value.

Table A-4 40000 - Linear scaling alarms

Number Effect/causes Remedy

40010 The system function could not be executed since the | Check the parameter types in the configuration.
parameters could not be converted to a common tag
type.

40011 The system function could not be executed since the | Check the parameter types in the configuration.
parameters could not be converted to a common tag
type.

MP 377 (WinCC flexible)
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Appendix

A.2 System alarms

Table A-5 50000 - Data server alarms

Number Effect/causes Remedy

50000 The HMI device is receiving data faster than it is --
capable of processing. Therefore, no further data is
accepted until all current data have been processed.

Data exchange then resumes.
50001 Data exchange has been resumed. -
Table A-6 60000 - Win32 function alarms

Number Effect/causes Remedy

60000 This alarm is generated by the --
“DisplaySystemAlarms” function. The text to be
displayed is transferred to the function as a
parameter.

60010 The file could not be copied in the direction defined Restart the system function or check the paths of the
because one of the two files is currently open or the | source/target files. Using Windows NT/2000/XP: The
source/target path is not available. user executing WinCC flexible Runtime must be
It is possible that the Windows user has no access granted access rights for the files.
rights to one of the two files.

60011 An attempt was made to copy a file to itself. Check the path of the source/target file.

It is possible that the Windows user has no access Using Windows NT/2000/XP with NTFS: The user
rights to one of the two files. executing WinCC flexible Runtime must be granted
access rights for the files.
Table A-7 70000 - Win32 function alarms

Number Effect/causes Remedy

70010 The application could not be started because it could | Check whether the application exists in the specified
not be found in the path specified or there is path or close other applications.
insufficient memory space.

70011 The system time could not be modified. Check the time which is to be set.

The error alarm only appears in connection with area | Using Windows NT/2000/XP: The user executing
pointer "Date/time PLC". Possible causes: WinCC flexible Runtime must be granted the right to
e Aninvalid time was transferred in the job mailbox. | change the system time of the operating system.
e The Windows user has no right to modify the
system time.
If the first parameter in the system alarm is displayed
with the value 13, the second parameter indicates the
byte containing the incorrect value.

70012 An error occurred when executing the function Close all programs currently running.
"StopRuntime" with the option "Runtime and Then close Windows.
operating system".

Windows and WinCC flexible Runtime are not closed.
One possible cause is that other programs cannot be
closed.
70013 The system time could not be modified because an Check the time which is to be set.

invalid value was entered. Incorrect separators may
have been used.

MP 377 (WIinCC flexible)
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Appendix

A.2 System alarms

Number

Effect/causes

Remedy

70014

The system time could not be modified. Possible
causes:

e An invalid time was transferred.

e The Windows user has no right to modify the
system time.

Windows rejects the setting request.

Check the time which is to be set.

Using Windows NT/2000/XP: The user executing
WinCC flexible Runtime must be granted the right to
change the system time of the operating system.

70015

The system time could not be read because Windows
rejects the reading function.

70016

An attempt was made to select a screen by means of
a system function or job. This is not possible because
the screen number specified does not exist.

Or: A screen could not be generated due to
insufficient system memory.

Or: The screen is blocked.
Or: Screen call has not been executed correctly.

Check the screen number in the function or job with
the screen numbers configured.
Assign the number to a screen if necessary.

Check the details for the screen call and whether the
screen is blocked for specific users.

70017

Date/time is not read from the area pointer because
the address set in the PLC is either not available or
has not been set up.

Change the address or set up the address in the
PLC.

70018

Acknowledgment that the password list has been
successfully imported.

70019

Acknowledgment that the password list has been
successfully exported.

70020

Acknowledgment for activation of alarm reporting.

70021

Acknowledgment for deactivation of alarm reporting.

70022

Acknowledgment to starting the Import Password List
action.

70023

Acknowledgment to starting the Export Password List
action.

70024

The value range of the tag has been exceeded in the
system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70025

The value range of the tag has been exceeded in the
system function.

The calculation of the system function is not
performed.

Check the desired calculation and correct it if
necessary.

70026

No other screens are stored in the internal screen
memory.
No other screens can be selected.

70027

The backup of the RAM file system has been started.

70028

The files from the RAM have been copied in the
Flash memory.

The files from the RAM have been copied in the
Flash memory. Following a restart, these saved files
are copied back to the RAM file system.

70029

Backup of the RAM file system has failed.
No backup copy of the RAM file system has been
made.

Check the settings in the "Control Panel > OP" dialog
and save the RAM file system using the "Save Files"
button in the "Persistent Storage" tab.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
70030 The parameters configured for the system function Compare the parameters configured for the system
are faulty. function with the parameters configured for the PLCs
The connection to the new PLC was not established. | and correct them as necessary.
70031 The PLC configured in the system function is not an | Compare the S7 PLC name parameter configured for
S7 PLC. the system function with the parameters configured
The connection to the new PLC was not established. | for the PLC and correct them as necessary.
70032 The object configured with this number in the tab Check the number of the tab order and correct it if
order is not available in the selected screen. necessary.
The screen changes but the focus is set to the first
object.
70033 An e-mail cannot be sent because a TCP/IP Check the network connection to the SMTP server
connection to the SMTP server no longer exists. and re-establish it if necessary.
This system alarm is generated only at the first
attempt. All subsequent unsuccessful attempts to
send an e-mail will no longer generate a system
alarm. The event is regenerated when an e-mail has
been successfully sent in the meantime.
The central e-mail component in WinCC flexible
Runtime attempts, in regular intervals (1 minute), to
establish the connection to the SMTP server and to
send the remaining e-mails.
70034 Following a disruption, the TCP/IP connection to the | --
SMTP server could be re-established.
The queued e-mails are then sent.
70036 No SMTP server for sending e-mails is configured. Configure an SMTP server:
An attempt to connect to an SMTP server has failed | | WinCC flexible Engineering System
and itis not possible to send e-mails. using "Device settings > Device settings"
WinCC flexible Runtime generates the system alarm In the Wind CE i ¢
after the first attempt to send an e-mail. nl e" Indows operating system .
using "Control Panel > Internet Settings > E-mail >
SMTP Server"
70037 An e-mail cannot be sent for unknown reasons. Check the e-mail parameters (recipient etc.).
The contents of the e-mail are lost.
70038 The SMTP server has rejected sending or forwarding | Check the domain of the recipient address or
an e-mail because the domain of the recipient is deactivate the authentication on the SMTP server if
unknown to the server or because the SMTP server | possible. SMTP authentication is currently not used in
requires authentication. WinCC flexible Runtime.
The contents of the e-mail are lost.
70039 The syntax of the e-mail address is incorrect or Check the e-mail address of the recipient.
contains illegal characters.
The contents of the e-mail are discarded.
70040 The syntax of the e-mail address is incorrect or --
contains illegal characters.
70041 The import of the user management was aborted due | Check your user management or transfer it again to
to an error. the panel.
Nothing was imported.
70042 The value range for the tags has been exceeded Check the desired calculation and correct it if

while executing the system function.

The system function calculation has not been carried
out.

necessary.
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Appendix

A.2 System alarms

Number

Effect/causes

Remedy

70043

The value range for the tags has been exceeded
while executing the system function.

The system function calculation has not been carried
out.

Check the desired calculation and correct it if
necessary.

Table A-8

80000 - Archive alarms

Number

Effect/causes

Remedy

80001

The log specified is filled to the size defined (in
percent) and must be stored elsewhere.

Store the file or table by executing a ‘move’ or ‘copy’
function.

80002

A line is missing in the specified log.

80003

The copying process for logging was not successful.
In this case, it is advisable to check any subsequent
system alarms, too.

80006

Since logging is not possible, this causes a
permanent loss of the functionality.

In the case of databases, check whether the
corresponding data source exists and start up the
system again.

80009

A copying action has been completed successfully.

80010

Since the storage location was incorrectly entered in
WinCC flexible, this causes a permanent loss of the
functionality.

Configure the storage location for the respective log
again and restart the system when the full
functionality is required.

80012

Log entries are stored in a buffer. If the values are
read to the buffer faster than they can be physically
written (using a hard disk, for example), overloading
may occur and recording is then stopped.

Archive fewer values.
Or:
Increase the logging cycle.

80013

The overload status no longer applies. Archiving
resumes the recording of all values.

80014

The same action was triggered twice in quick
succession. Since the process is already in operation,
the action is only carried out once.

80015

This system alarm is used to report DOS or database
errors to the user.

80016

The logs are separated by the system function
"CloseAllLogs" and the incoming entries exceed the
defined buffer size.

All entries in the buffer are deleted.

Reconnect the logs.

80017

The number of incoming events cause a buffer
overflow. his can be caused, for example, by several
copying actions being activated at the same time.
All copy jobs are deleted.

Stop the copy action.

80019

The connection between WinCC flexible and all logs
were closed, for example, after executing the system
function "CloseAllLogs".

Entries are written to the buffer and are then written
to the logs when a connection is re-established.
There is no connection to the storage location and
the storage medium may be replaced, for example.

80020

The maximum number of simultaneously copy
operations has been exceeded. Copying is not
executed.

Wait until the current copying actions have been
completed, then restart the last copy action.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
80021 An attempt was made to delete a log which is still Wait until the current copying actions have been
busy with a copy action. Deletion has not been completed, then restart the last action
executed.
80022 An attempt was made to use the system function In the project, check
"StartSequencelLog"” to start a sequence log foralog |« If the "StartSequenceLog" system function was
which is not configured as a sequence log. No properly configured
sequence log file is created. e if the tag parameters are properly provided with
data on the HMI device
80023 An attempt was made to copy a log to itself. In the project, check
The log is not copied. o ifthe "CopyLog" system function was properly
configured
¢ if the tag parameters are properly provided with
data on the HMI device
80024 The "CopyLog" system function does not allow Edit the "CopyLog" system function in the project if
copying when the target log already contains data necessary. Before you initiate the system function,
("Mode" parameter). The log is not copied. delete the destination log file.
80025 You have canceled the copy operation. --
Data written up to this point are retained. The
destination log file (if configured) is not deleted.
The cancellation is reported by an error entry
$RT_ERRS at the end of the destination log.
80026 This alarm is output after all logs are initialized. --
Values are written to the logs from then on. Prior to
this, no entries are written to the logs, irrespective
whether WinCC flexible Runtime is active or not.
80027 The internal Flash memory has been specified as the | Configure "Storage Card" or a network path as the
storage location for a log. This is not permissible. storage location.
No values are written to this log and the log file is not
created.
80028 The alarm returns a status report indicating that the --
logs are currently being initialized. No values are
logged until the alarm 80026 is output.
80029 The number of logs specified in the alarm could not Evaluate the additional system alarms related to this
be initialized. The logs are initialized. alarm. Check the configuration, the ODBC (Open
The faulty log files are not available for logging jobs. | Database Connectivity) and the specified drive.
80030 The structure of the existing log file does not match Delete the existing log data manually, in advance.
the expected structure.
Logging is stopped for this log.
80031 The log in CSV format is corrupted. Delete the faulty file.
The log cannot be used.
80032 Logs can be assigned events. These are triggered as | Close WinCC flexible Runtime, delete the log, then

soon as the log is full. If WinCC flexible Runtime is
started and the log is already full, the event is not
triggered.

The log specified no longer logs data because it is
full.

restart WinCC flexible Runtime.

Or:

Configure a button which contains the same actions
as the event and press it.
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Appendix

A.2 System alarms

Number Effect/causes Remedy

80033 "System Defined" is set in the data log file as the data | Install MSDE again.
source name. This causes an error. No data is written
to the database logs, whereas the logging to the CSV
logs works.

80034 An error has occurred in the initialization of the logs. | No action is necessary. However, it is recommended
An attempt has been made to create the tables as a | to save the backup files or delete them in order to
backup. This action was successful. A backup has make the space available again.
been made of the tables of the corrupted log file and
the cleared log was restarted.

80035 An error has occurred in the initialization of the logs. | It is recommended to save the backups or to delete
An attempt has been made to create backups of the | them in order to release memory.
tables and this has failed. No logging or backup has
been performed.

80044 The export of a log was interrupted because Runtime | The export resumes automatically.
was closed or due to a power failure. It was detected
that the export needed to be resume when Runtime
restarted.

80045 The export of a log was interrupted due to an error in | The export is repeated automatically. Check:
the connection to the server or at the server itself. e The connection to the server

e If the server is running
e If there is enough free space on the server

80046 The destination file could not be written while Check whether there is enough space on the server
exporting the log. and it you have permission to create the log file.

80047 The log could not be read while exporting it. Check whether the storage medium is correctly

inserted.

80049 The log could not be renamed while preparing to Check whether the storage medium is correctly
export it. inserted and if there is sufficient space on the
The job can not be completed." medium.

80050 The log which shall be exported is not closed. Make sure the "CloseAll Logs" system function is
The job can not be completed. called before using the "ExportLog" system function.

Change the configuration as required.
Table A-9 90000 - FDA alarms

Number Effect/causes Remedy

90024 No operator actions can be logged due to lack of Make more space available by inserting an empty
space on the storage medium for log. The operator storage medium or swapping out the log files on the
action will therefore not be executed. server using "ExportLog".

90025 No user actions can be logged because of error state | Check whether the storage medium is correctly
of the archive. Therefore the user action will not be inserted.
executed.

90026 No operator actions can be logged because the log is | Before further operator actions are carried out, the
closed. The operator action will therefore not be log must be opened again using the system function
executed. "OpenAllLogs". Change the configuration as required.

90028 The password you entered is incorrect. Enter the correct password.

90029 Runtime was closed during ongoing operation Ensure that you are using the correct storage
(perhaps due to a power failure) or a storage medium | medium.
in use is incompatible with Audit Trail. An Audit Trail
is not suitable if it belongs to another project or has
already be archived.
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Appendix

A.2 System alarms

Number Effect/causes Remedy

90030 Runtime was closed during ongoing operation --
(perhaps due to a power failure).

90031 Runtime was closed during ongoing operation --
(perhaps due to a power failure).

90032 Running out of space on the storage medium for log. | Make more space available by inserting an empty
storage medium or swapping out the log files on the
server using "ExportLog".

90033 No more space on the storage medium for log. As of | Make more space available by inserting an empty
now, no more operator actions requiring logging will | storage medium or swapping out the log files on the
be executed. server using "ExportLog".

90039 You do not have the necessary authorization to Adapt or upgrade your authorizations.
perform this action.

90040 Audit Trail is switched off because of a forced user Activate the "Audit Trail" again using the system
action. function "StartLog".

90041 A user action which has to be logged has been A user action requiring logging should only be
executed without a logged on user. possible with permission. Change the configuration

by setting a required permission for the input object.

90044 A user action which has to be confirmed was blocked, | Repeat the user action if necessary.
because there is another user action pending.

Table A-10 110000 - Offline function alarms

Number Effect/causes Remedy

110000 The operating mode was changed. "Offline" mode is | --
now set.

110001 The operating mode was changed. "Online" mode is | --
now set.

110002 The operating mode was not changed. Check the connection to the PLCs.

Check whether the address area for the area pointer
88 “Coordination" in the PLC is available.

110003 The operating mode of the specified PLC was --
changed by the system function
"SetConnectionMode".

The operating mode is now "offline".

110004 The operating mode of the specified PLC has been --
changed by the system function
"SetConnectionMode".

The operating mode is now "online".

110005 An attempt was made to use the system function Switch the complete system to "online" mode, then
SetConnectionMode to switch the specified PLC to execute the system function again.

"online" mode, although the entire system is in
"offline" mode. This changeover is not allowed. The
PLC remains in "offline" mode.

110006 The content of the "project version" area pointer does | Check:

not match the user version configured in WinCC
flexible. WinCC flexible Runtime is therefore closed.

e The project ID entered on the PLC.
e The project ID entered in WinCC flexible.
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A.2 System alarms

Table A-11 120000 - Trend alarms
Number Effect/causes Remedy
120000 The trend is not displayed because you configured an | Change the configuration.
incorrect axis to the trend or an incorrect trend.
120001 The trend is not displayed because you configured an | Change the configuration.
incorrect axis to the trend or an incorrect trend.
120002 The trend is not displayed because the tag assigned | Check whether the data area for the tag exists in the
attempts to access an invalid PLC address. PLC, the configured address is correct and the value
range for the tag is correct.
Table A-12 130000 - System information alarms
Number Effect/causes Remedy
130000 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130001 The action was not executed. Delete files no longer required from the hard disk.
130002 The action was not executed. Close all other programs.
Delete files no longer required from the hard disk.
130003 No data medium found. The operation is canceled. Check, for example, if
e The correct data medium is being accessed
e The data medium is inserted
130004 The data medium is write-protected. The operation is | Check whether access has been made to the correct
canceled. data carrier. Remove the write protection.
130005 The file is read only. The operation is canceled. Check whether access has been made to the correct
file. Edit the file attributes if necessary.
130006 Access to file failed. The operation is canceled. Check, for example, if
e The correct file is being accessed
e The file exists
¢ another action is preventing simultaneous access
to the file
130007 The network connection is interrupted. Check the network connection and eliminate the
Records cannot be saved or read over the network cause of error.
connection.
130008 The storage card is not available. Insert the storage card.
Records cannot be saved to / read from the storage
card.
130009 The specified folder does not exist on the storage Insert the storage card.
card.
Any files saved to this directory are not backed up
when you switch off the HMI device.
130010 The maximum nesting depth can be exhausted when, | Check the configuration.
for example, a value change in a script results in the
call of another script and the second script in turn has
a value change that results in the call of yet a further
script etc.
The configured functionality is not supported.
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Appendix

A.2 System alarms

Table A-13 140000 - Connection alarms chns7: Connection + device

Number Effect/causes Remedy

140000 An online connection to the PLC is established. --

140001 The online connection to the PLC was shut down. --

140003 No tag updating or writing is executed. Check the connection and if the PLC is switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".

Restart the system.
140004 No tag update or write operations are executed Verify the connection and check whether the PLC is
because the access point or the module configuration | switched on.
is faulty. Check the access point or the module configuration
(MPI, PPI, PROFIBUS) in the Control Panel with "Set
PG/PC interface".
Restart the system.

140005 No tag updating or writing is executed because the Use a different HMI device address.

HMI device address is incorrect (possibly too high). Verify the connection and check whether the PLC is
switched on.
Check the parameter definitions in the Control Panel
using "Set PG/PC interface".
Restart the system.

140006 No tag updating or writing is executed because the Select a different baud rate in WinCC flexible

baud rate is incorrect. (according to module, profile, communication peer,
etc.).

140007 Tag are not updated or written because the bus Check the user-defined bus profile.

profile is incorrect (see %1). Check the connection and if the PLC is switched on.
The following parameter could not be written to the Check the parameter definitions in the Control Panel
registry:: using "Set PG/PC interface".
1: Tslot Restart the system.
2: Tqui
3: Tset
4: MinTsdr
5: MaxTsdr
6: Trdy
7: Tid1
8: Tid2
9: Gap Factor
10: Retry Limit
140008 No tag updating or writing is executed because baud | Check the connection and if the PLC is switched on.
rate is incorrect. The following parameters could not | Check the parameter definitions in the Control Panel
be written to the registry: using "Set PG/PC interface".
0: General error Restart the system.
1: Wrong version
2: Profile cannot be written to the registry.
3: The subnet type cannot be written to the registry.
4: The Target Rotation Time cannot be written to the
registry.
5: Faulty Highest Address (HSA).
140009 Tags are not updated or written because the module | Reinstall the module in the Control Panel using "Set

for S7 communication was not found.

PG/PC interface".
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Appendix

A.2 System alarms

Number Effect/causes Remedy
140010 No S7 communication partner found because the Switch the PLC on.
PLC is shut down. DP/T:
DP/T: If only one master is connected to the network,
The option “PG/PC is the only master” is not set in disable "PG/PC is the only master" in "Set PG/PC
the Control Panel under “Set PG/PC interface.” interface".
If several masters are connected to the network,
enable these. Do not change any settings, for this will
cause bus errors.
140011 No tag updating or writing is executed because Check the connection and that the communication
communication is down. partner is switched on.
140012 There is an initialization problem (e.g. when WinCC Restart the HMI device.
flexible Runtime was closed in Task Manager). Or:
Or: Run WinCC flexible Runtime, then start your other
Another application (e.g.STEP7) with different bus applications.
parameters is active and the driver cannot be started
with the new bus parameters (transmission rate, for
example).
140013 The MPI cable is disconnected and, thus, there is no | Check the connections.
power supply.
140014 The configured bus address is in already in use by Edit the HMI device address in the PLC configuration.
another application.
140015 Wrong transmission rate Correct the relevant parameters.
Or:
Faulty bus parameters (e.g. HSA)
Or:
OP address > HSA or: Wrong interrupt vector
(interrupt does not arrive at the driver)
140016 The hardware does not support the configured Change the interrupt number.
interrupt.
140017 The set interrupt is in use by another driver. Change the interrupt number.
140018 The consistency check was disabled by SIMOTION Enable the consistency check with SIMOTION Scout
Scout. Only a corresponding note appears. and once again download the project to the PLC.
140019 SIMOTION Scout is downloading a new project to the | Wait until the end of the reconfiguration.
PLC. Connection to the PLC is canceled.
140020 The version in the PLC and that of the project (FWX | The following remedies are available:
file) do not match. Download the current version to the PLC using
Connection to the PLC is canceled SIMOTION Scout.
Regenerate the project using WinCC flexible ES,
close WinCC flexible Runtime and restart with a new
configuration.
Table A-14 150000 - Connection alarms chnAS511: Connection
Number Effect/causes Remedy
150000 No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload
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Appendix

A.2 System alarms

Number Effect/causes Remedy
150001 Connection is up because the cause of the -
interruption has been eliminated.
Table A-15 160000 - Connection alarms IVar (WinLC) / OPC: Connection
Number Effect/causes Remedy
160000 No more data is read or written. Possible causes: Ensure that the cable is plugged in, the PLC is
e The cable is defective operational, the correct port is being used.
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e The wrong port is used for the connection
e System overload
160001 Connection is up because the cause of the --
interruption has been eliminated.
160010 No connection to the server because the server Check access rights.
identification (CLS-ID) cannot be determined.
Values cannot be read or written.
160011 No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e the server name is correct.
Values cannot be read or written. o the computer name is correct.
o the server is registered.
160012 No connection to the server because the server Check, for example, if
identification (CLS-ID) cannot be determined. e the server name is correct.
Values cannot be read or written. « the computer name is correct.
o the server is registered.
Note for advanced users:
Interpret the value from HRESULT.
160013 The specified server was started as InProc server. Configure the server as OutProc Server or Local
This has not been released and may possibly lead to | Server.
incorrect behavior because the server is running in
the same process area as the WinCC flexible
Runtime software.
160014 Only one OPC server project can be started on a Do not start a second project with OPC server
PC/MP. An alarm is output when an attempt is made | functionality on the computer.
to start a second project.
The second project has no OPC server functionality
and cannot be located as an OPC server by external
sources.
Table A-16 170000 - S7 dialog alarms
Number Effect/causes Remedy
170000 S7 diagnostics events are not indicated because itis | --
not possible to log on to the S7 diagnostics functions
at this device. The service is not supported.
170001 The S7 diagnostics buffer cannot be viewed because | Set the PLC to online mode.

communication with the PLC is shut down.
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A.2 System alarms

Number Effect/causes Remedy
170002 The S7 diagnostics buffer cannot be viewed because | --
reading of the diagnostics buffer (SSL) was canceled
with error.
170003 An S7 diagnostics event cannot be visualized. The --
system returns internal error %2.
170004 An S7 diagnostics event cannot be visualized. The -
system returns an internal error of error class %2,
error number %3.
170007 It is not possible to read the S7 diagnostics buffer --
(SSL) because this operation was canceled with an
internal error of class %2 and error code %3.
Table A-17 180000 - Misc/common alarms
Number Effect/causes Remedy
180000 A component/OCX received configuration data with a | Install a newer component.
version ID which is not supported.
180001 System overload because too many actions running | Several remedies are available:
in parallel. Not all the actions can be executed, some |4 Generate the alarms at a slower rate (polling)
are rejected. ¢ Initiate scripts and functions at greater intervals
If the alarm appears more frequently:
Restart the HMI device.
180002 The screen keyboard could not be activated. Possible | Reinstall WinCC flexible Runtime.
causes:
"TouchlnputPC.exe" was not registered due to a
faulty Setup.
Table A-18 190000 - Tag alarms
Number Effect/causes Remedy
190000 It is possible that the tag is not updated. --
190001 The tag is updated after the cause of the last error --
state has been eliminated (return to normal
operation).
190002 The tag is not updated because communication with | Select the system function "SetOnline" to go online.
the PLC is down.
190004 The tag is not updated because the configured tag Check the configuration.
address does not exist.
190005 The tag is not updated because the configured PLC | Check the configuration.
type does not exist for this tag.
190006 The tag is not updated because it is not possible to Check the configuration.
map the PLC type in the data type of the tag.
190007 The tag value is not modified because the connection | Set online mode or reconnect to the PLC.
to the PLC is interrupted or the tag is offline.
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A.2 System alarms

Number Effect/causes Remedy
190008 The threshold values configured for the tag have Observe the configured or current threshold values of
been violated, for example, by the tag.
e Avalue entered
e A system function
e A script
190009 An attempt has been made to assign the tag a value | Observe the range of values for the data type of the
which is outside the permitted range of values for this | tags.
data type.
For example, a value of 260 was entered for a byte
tag or a value of -3 for an unsigned word tag.
190010 Too many values are written to the tag (for example, | The following remedies are available:
in a loop triggered by a script). ¢ Increase the time interval between multiple write
Values are lost because only up to 100 actions are actions.
saved to the buffer. e Do not use an array tag longer than 6 words when
you configure an acknowledgment on the HMI
device using "Acknowledgment HMI".
190011 Possible cause 1:
The value entered could not be written to the Make sure that the value entered lies within the range
configured PLC tag because the high or low limit was | of values of the control tags.
exceeded.
The system discards the entry and restores the
original value.
Possible cause 2:
The connection to the PLC was interrupted. Check the connection to the PLC.
190012 It is not possible to convert a value from a source Check the range of values or the data type of the
format to a target format, for example: tags.
An attempt is being made to assign a value to a
counter that is outside the valid, PLC-specific value
range.
A tag of the type Integer should be assigned a value
of the type String.
190013 The user has entered a string that is longer than the | Only enter strings that do not exceed the permitted

tag. The string is automatically shortened to the
permitted length.

tag length.
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A.2 System alarms

Table A-19

190100 - Area pointer alarms

Number

Effect/causes

Remedy

190100

The area pointer is not updated because the address
configured for this pointer does not exist.

Type

Warnings

Errors

PLC acknowledgment

HMI device acknowledgment

LED mapping

Trend request

Trend transfer 1

Trend transfer 2

No.:

Consecutive number displayed in WinCC flexible ES.

O~NOO OB~ WN -

Check the configuration.

190101

The area pointer is not updated because it is not
possible to map the PLC type to the area pointer
type.

Parameter type and no.:

see alarm 190100

190102

The area pointer is updated after the cause of the last
error state has been eliminated (return to normal
operation). Parameter type and no.: See alarm
190100.

Table A-20

200000 - PLC coordination alarms

Number

Effect/causes

Remedy

200000

Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the
PLC.

200001

Coordination is canceled because the write access to
the address configured in the PLC is not possible.

Change the address or set the address in the PLC at
an area which allows write access.

200002

Coordination is not carried out at the moment
because the address format of the area pointer does
not match the internal storage format.

Internal error

200003

Coordination can be executed again because the last
error state is eliminated (return to normal operation).

200004

The coordination may not be executed.

200005

No more data is read or written. Possible causes:
o The cable is defective

e The PLC does not respond, is defective, etc.
e System overload

Ensure that the cable is plugged in and the PLC is
operational.
Restart the system if the system alarm persists.

Table A-21

200100 - PLC user version alarms

Number

Effect/causes

Remedy

200100

Coordination is not executed because the address
configured in the PLC does not exist/is not set.

Change the address or set up the address in the
PLC.

200101

Coordination is canceled because the write access to
the address configured in the PLC is not possible.

Change the address or set the address in the PLC at
an area which allows write access.
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A.2 System alarms

Number Effect/causes Remedy

200102 Coordination is not carried out at the moment Internal error
because the address format of the area pointer does
not match the internal storage format.

200103 Coordination can be executed again because the last | --
error state is eliminated (return to normal operation).

200104 The coordination may not be executed. -

200105 No more data is read or written. Possible causes: Ensure that the cable is plugged in and the PLC is
 The cable is defective operational. _ _
« The PLC does not respond, is defective, etc. Restart the system if the system alarm persists.
e System overload

Table A-22 210000 - PLC job alarms

Number Effect/causes Remedy

210000 Jobs are not processed because the address Change the address or set up the address in the
configured in the PLC does not exist/has not been set | PLC.
up.

210001 Jobs are not processed because read/write access to | Change the address or set up the address in the PLC
the address configured in the PLC is not possible. in an area which allows read/write access.

210002 Jobs are not executed because the address format of | Internal error
the area pointer does not match the internal storage
format.

210003 The job buffer is processed again because the last -
error status has been eliminated (return to normal
operation).

210004 It is possible that the job buffer will not be processed. |--

210005 A control request with an illegal number was initiated. | Check the PLC program.

210006 An error occurred while attempting to execute the Check the parameters of the control request.
control request. As a result, the control request is not | Recompile the configuration.
executed. Observe the next/previous system alarms.

Table A-23 220000 - WinCC channel adapter alarms

Number Effect/causes Remedy

220001 The tag is not downloaded because the associated Change the configuration.
communication driver / HMI device does not support
the download of Boolean/discrete data types.

220002 The tag is not downloaded because the associated Change the configuration.
communication driver / HMI device does not support
write access to the data type BYTE.

220003 The communication driver cannot be loaded. The Install the driver by reinstalling WinCC flexible
driver may not be installed. Runtime.

220004 Communication is down and no update data is Check the connection.
transferred because the cable is not connected or
defective etc.

220005 Communication is up. -

220006 The connection between the specified PLC and the --

specified port is active.
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A.2 System alarms

Number Effect/causes Remedy
220007 The connection to the specified PLC is interrupted at | Check whether
the specified port. e The cable is plugged in
e The PLCis OK
e The correct port is used
e Your configuration is OK (port parameters,
protocol settings, PLC address)
Restart the system if the system alarm persists.
220008 The communication driver cannot access or open the | Close all the applications which access this port and
specified port. The port may be in use by another restart the computer.
application or the port used is not available on the Use another port of the system.
destination device.
There is no communication with the PLC.
Table A-24 230000 - View alarms
Number Effect/causes Remedy
230000 The value entered could not be accepted. The Enter a practical value or delete any unneeded users.
system discards the entry and restores the previous
value.
Either
e The value range has been exceeded
o lllegal characters have been entered
e The maximum permitted number of users has
been exceeded
230002 The currently logged in user has not the required Log on as a user with appropriate authorization.
authorization. The system therefore discards the
input and restored the previous value.
230003 Changeover to the specified screen failed because Configure the screen and check the screen selection
the screen is not available/configured. The current function.
screen remains selected.
230005 The value range of the tag has been exceeded in the | Observe the range of values for the tag when
I/O field. entering a value.
The original value of the tag is retained.
230100 During navigation in the web browser, the system Navigate to another page.
returned a message which may be of interest to the
user.
The web browser continues to run but may not (fully)
show the new page.
230200 The connection to the HTTP channel was interrupted | Check the network connection.
due to an error. This error is explained in detail by Check the server configuration.
another system alarm.
Data is no longer exchanged.
230201 The connection to HTTP channel was established. -
Data is exchanged.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
230202 WININET.DLL has detected an error. This error Depending on the cause:
usually occurs when an attempt to connect to the When an attempt to connect fails or a timeout error
server fails or the server refuses to connect because | gccurs:
the client lacks the proper authorization. e Check the network connection and the network
An unknown server certificate may also be the cause
if the connection is encrypted by means of SSL. e Check the server address
The alarm text provides details. e Check whether the WebServer is actually running
This text is always in the language of the Windows on the destination station.
installation because it is returned by the Windows Faulty authorization:
Os. e The configured user name and/or password do
Process values are no longer exchanged. not match those on the server. Establish
consistency
When the server certificate is rejected:
Certificate signed by an unknown CA ():
o Either ignore this item in your project, or
¢ Install a certificate that has been signed with a
root certificate known to the client computer
The date of the certificate is invalid:
o Either ignore this item in your project, or
¢ Install a certificate with a valid date on the server
Invalid CN (Common Name or Computer Name):
o Either ignore this item in your project, or
e Install a certificate with a name that corresponds
to that of the server address
230203 Although a connection can be made to the server, the | Error 503 Service unavailable:
HTTP server refuses to connect because Check that WinCC flexible Runtime is running on the
o WinCC flexible Runtime is not running on the server and the HTTP channel is supported.
server, or
e The HTTP channel is not supported (503 Service
unavailable)
Other errors can only occur if the Webserver does not
support the HTTP channel. The language of the
alarm text depends on the Webserver.
Data is not exchanged.
230301 An internal error has occurred. An English text --
explains the error in more detail. This may be caused
by insufficient memory.
OCX does not work.
230302 The name of the remote server cannot be resolved. Check the configured server address.
The attempt to connect failed. Check whether the DNS service is available on the
network.
230303 The remote server is not running on the addressed Check the configured server address.
computer. Check whether the remote server is running on the
Wrong server address. target computer.
The attempt to connect failed
230304 The remote server on the addressed computer is Use a compatible remote server.
incompatible with VNCOCX.
The attempt to connect failed.
230305 The authentication has failed because the password | Configure the correct password.

is incorrect.
The attempt to connect failed.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
230306 Error in the connection to the remote server. This Check whether
may occur as a result of network problems. e The bus cable is plugged in
The attempt to connect failed. « There are network problems
230307 The connection to the remote server was shut down | --
because
e The remote server was shut down, or
e The user instructed the server to close all
connections
The connection is closed.
230308 This alarm provides information on the connection --
status.
An attempt is made to connect.
Table A-25 240000 - Authorization alarms
Number Effect/causes Remedy
240000 WinCC flexible Runtime is operating in demo mode. | Install the authorization.
You have no authorization or your authorization is
corrupted.
240001 WinCC flexible Runtime is operating in demo mode. | Load an adequate authorization / powerpack.
Too many tags are configured for the installed
version.
240002 WinCC flexible Runtime is operating with a time- Restore the full authorization.
limited emergency authorization.
240004 Error while reading the emergency authorization. Restart WinCC flexible Runtime, install the
WinCC flexible Runtime is operating in demo mode. | authorization or repair the authorization (see
Commissioning Instructions Software Protection).
240005 The Automation License Manager has detected an Reboot the HMI device or PC. If this does not solve
internal system fault. the problem, remove the Automation License
Possible causes: Manager and install it again.
e A corrupt file
o A defective installation
* No free space for the Automation License
Manager etc.
Table A-26 250000 - S7 Force alarms
Number Effect/causes Remedy
250000 The tag in the specified line in "Status Force" is not Check the set address and then verify that the
updated because the address configured for this tag | address is set up in the PLC.
is not available.
250001 The tag in the specified line in "Status Force" is not Check the set address.
updated because the PLC type configured for this tag
does not exist.
250002 The tag in the specified line in "Status Force" is not Check the set address.
updated because it is not possible to map the PLC
type in the tag type.
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Appendix

A.2 System alarms

Number Effect/causes Remedy

250003 An attempt to connect to the PLC failed. The tags are | Check the connection to the PLC. Check that the
not updated. PLC is switched on and is online.

Table A-27 260000 - Password system alarms

Number Effect/causes Remedy

260000 An unknown user or an unknown password has been | Log on to the system as a user with a valid password.
entered in the system.

The current user is logged off from the system.

260001 The logged in user does not have sufficient Log on to the system as a user with sufficient
authorization to execute the protected functions on authorization.
the system.

260002 This alarm is triggered by the system function --

"TrackUserChange".

260003 The user has logged off from the system. --

260004 The user name entered into the user view already Select another user name because user names have
exists in the user management. to be unique in the user management.

260005 The entry is discarded. Enter a shorter user name.

260006 The entry is discarded. Use a shorter or longer password.

260007 The logon timeout value entered is outside the valid Enter a logon timeout value between 0 and 60
range of 0 to 60 minutes. minutes.

The new value is discarded and the original value is
retained.

260008 An attempt was made to read a PTProRun.pwil file --
created with ProTool V 6.0 in WinCC flexible.
Reading the file was canceled due to incompatibility
of the format.

260009 You have attempted to delete the user "Admin" or If you need to delete a user, because perhaps you
"PLC User". These users are fixed components of the | have exceeded the maximum number permitted,
user management and cannot be deleted. delete another user.

260012 The passwords entered in the "Change Password" You have to log on to the system again. Then enter
dialog and the confirmation field are not identical. the identical password twice to be able to change the
The password has not been changed. User will be password.
logged off.

260013 The password entered in the "Change Password" You have to log on to the system again. Then enter a
dialog is invalid because it is already in use. new password that has not been used before.

The password has not been changed. User will be
logged off.

260014 You have tried unsuccessfully to log on 3 times in You can log on to the system with your correct
succession. password. Only an administrator can change the
You will be locked out and assigned to group no. 0. assignment to a group.

260023 The password you entered does not meet the Enter a password that contains at least one number.
necessary security guidelines.

260024 The password you entered does not meet the Enter a password that contains at least one
necessary security guidelines. character.

260025 The password you entered does not meet the Enter a password that contains at least one special

necessary security guidelines.

character.
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A.2 System alarms

Number Effect/causes Remedy

260028 Upon system start-up, an attempt to log on, or when | Check the connection to the SIMATIC Logon Server
trying to change the password of a SIMATIC log-on and its configuration; for example:
user, the system attempts to access the SIMATIC 1. Port number
Logon Server. 2. IP address
If attempting to log on, the new user is not logged in. 3s
If a different user was logged on before, then this - Servername
user is |ogged off. 4. Functional transfer cable

Or use a local user.

260029 The SIMATIC Logon user is not associated to any or | Check the user data on the SIMATIC Logon Server
several groups. and the configuration in your WinCC flexible project.
The new user is not logged in. If a different user was | A User may only be assigned to one group.
logged on before, then this user is logged off.

260030 The SIMATIC Logon user could not change his Log in again and choose a different password. Check
password on the SIMATIC Logon Server. The new the password rules on the SIMATIC Logon Server.
password may not comply with the password
regulations on the server or the user does not have
the right to change his password.

The old password remains and the user is logged off.

260031 It was not possible to log the user on to the SIMATIC | Try again. If necessary, check the password data on
Logon Server. The user name or the password could | the SIMATIC Logon Server.
be incorrect or the user does not have sufficient rights
to log on.

The new user is not logged in. If a different user was
logged on before, then this user is logged off.

260032 It was not possible to log the user on to the SIMATIC | Check the user data on the SIMATIC Logon Server.
Logon Server as his account is blocked.

The new user is not logged in. If a different user was
logged on before, then this user is logged off.

260033 The action change password or log on user could not | Check the configuration of the SIMATIC Logon
be carried out. Server.

260034 The last logon operation has not yet ended. A user Wait until the logon operation is complete.
action or a logon dialog can therefore not be called.

The logon dialog is not opened. The user action is not
executed.

260035 The last attempt to change the password was not Wait until the procedure is complete.
completed. A user action or a logon dialog can
therefore not be called.

The logon dialog is not opened. The user action is not
executed.

260036 There are insufficient licenses on the SIMATIC Logon | Check the licensing on the SIMATIC Logon Server.
Sever. The logon is not authorized.

260037 There is no license on the SIMATIC Logon Sever. A | Check the licensing on the SIMATIC Logon Server.
logon is not possible.

It is not possible to log on via the SIMATIC Logon
Server, only via a local user.
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Appendix

A.2 System alarms

Table A-28 270000 - System alarms

Number Effect/causes Remedy

270000 A tag is not indicated in the alarm because it attempts | Check whether the data area for the tag exists in the
to access an invalid address in the PLC. PLC, the configured address is correct and the value

range for the tag is correct.

270001 There is a device-specific limit as to how many --
alarms may be queued for output (see the operating
instructions). This limit has been exceeded.
The view no longer contains all the alarms.
However, all alarms are written to the alarm buffer.

270002 The view shows alarms of a log for which there is no | Delete older log data if necessary.
data in the current project.
Wildcards are output for the alarms.

270003 The service cannot be set up because too many Reduce the number of HMI devices which want to
devices want to use this service. use the service.
A maximum of four devices may execute this action.

270004 Access to persistent buffer is not possible. Alarms If the problems persist at the next startup, contact
cannot be restored or saved. Customer Support (delete Flash).

270005 Persistent buffer damaged: Alarms cannot be If the problems persist at the next startup, contact
restored. Customer Support (delete Flash).

270006 Project modified: Alarms cannot be restored from the | The project was generated and transferred new to the
persistent buffer. HMI device; The error should no longer occur when

the device starts again.

270007 A configuration problem is preventing the restore Update the operating system and then transfer your

(a DLL is missing, a directory is unknown, etc.). project again to the HMI device.
Table A-29 280000 - DPHMI alarms Connection

Number Effect/causes Remedy

280000 Connection is up because the cause of the --
interruption has been eliminated.

280001 No more data is read or written. Possible causes: Check whether
e The cable is defective e The cable is plugged in
e The PLC does not respond, is defective, etc. ¢ The PLCis OK
e The wrong port is used for the connection e The correct port is used
e System overload Restart the system if the system alarm persists.

280002 The connection used requires a function block in the | --

PLC.
The function block has responded. Communication is
now enabled.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
280003 The connection used requires a function block in the | Check whether
PLC. . e The cable is plugged in
The function block has not responded. e The PLC is OK
e The correct port is used
Restart the system if the system alarm persists.
Remedy depends on the error code:
1: The function block must set the COM bit in the
response container.
2: The function block must not set the ERROR bit in
the response container.
3: The function block must respond within the
specified time (timeout).
4: Go online to the PLC.
280004 The connection to the PLC is interrupted. There is no | Check the connection parameters in WinCC flexible.
data exchange at present. Ensure that the cable is plugged in, the PLC is
operational, the correct port is being used.
Restart the system if the system alarm persists.
Table A-30 290000 - Recipe system alarms
Number Effect/causes Remedy
290000 The recipe tag could not be read or written. It is Check in the configuration that the address has been
assigned the start value. set up in the PLC.
The alarm can be entered in the alarm buffer for up to
four more failed tags if necessary. After that, alarm
290003 is output.
290001 An attempt has been made to assign a value to a Observe the value range for the tag type.
recipe tag which is outside the value range permitted
for this type.
The alarm can be entered in the alarm buffer for up to
four more failed tags if necessary. After that, alarm
290004 is output.
290002 It is not possible to convert a value from a source Check the value range or type of the tag.
format to a target format.
The alarm can be entered in the alarm buffer for up to
four more failed recipe tags if necessary. After that,
alarm 290005 is output.
290003 This alarm is output when alarm number 290000 is Check in the configuration that the tag addresses
triggered more than five times. have been set up in the PLC.
In this case, no further separate alarms are
generated.
290004 This alarm is output when alarm number 290001 is Observe the value range for the tag type.
triggered more than five times.
In this case, no further separate alarms are
generated.
290005 This alarm is output when alarm number 290002 is Check the value range or type of the tag.
triggered more than five times.
In this case, no further separate alarms are
generated.
290006 The threshold values configured for the tag have Observe the configured or current threshold values of
been violated by values entered. the tag.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
290007 There is a difference between the source and target | Insert the specified data recipe tag in the source
structure of the recipe currently being processed. The | structure.
target structure contains an additional data recipe tag
which is not available in the source structure.
The data recipe tag specified is assigned its start
value.
290008 There is a difference between the source and target | Remove the specified data recipe tag in the specified
structure of the recipe currently being processed. The | recipe from the project.
source structure contains an additional data recipe
tag which is not available in the target structure and
therefore cannot be assigned.
The value is rejected.
290010 The storage location configured for the recipe is not | Check the configured storage location.
permitted.
Possible causes:
lllegal characters, write protection, data carrier out of
space or does not exist.
290011 The record with the specified number does not exist. | Check the source for the number (constant or tag
value)
290012 The recipe with the specified number does not exist. | Check the source for the number (constant or tag
value)
290013 An attempt was made to save a record under a The following remedies are available:
record number which already exists. e Check the source for the number (constant or tag
The action is not executed. value)
e First, delete the record
e Change the "Overwrite" function parameter
290014 The file specified to be imported could not be found. | Check:
e The file name
e Ensure that the file is in the specified directory
290020 Alarm reporting that the download of records from the | --
HMI device to the PLC has started.
290021 Alarm reporting that the download of records from the | --
HMI device to the PLC was completed.
290022 Alarm reporting that the download of records from the | Check in the configuration whether:
HMI device to the PLC was canceled due to an error. | 4  The tag addresses are configured in the PLC
e The recipe number exists
e The record number exist
e The "Overwrite" function parameter is set
290023 Alarm reporting that the download of records from the | --
PLC to the HMI device has started.
290024 Alarm reporting that the download of records from the | ---
PLC to the HMI device was completed.
290025 Alarm reporting that the download of records from the | Check in the configuration whether:

PLC to the HMI device was canceled due to an error.

e The tag addresses are configured in the PLC
e The recipe number exists

e The record number exist

e The "Overwrite" function parameter is set
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A.2 System alarms

Number Effect/causes Remedy
290026 An attempt has been made to read/write a record Set the record status to zero.
although the record is not free at present.
This error may occur in the case of recipes for which
downloading with synchronization has been
configured.
290027 Unable to connect to the PLC at present. As a result, | Check the connection to the PLC.
the record can neither be read nor written.
Possible causes:
No physical connection to the PLC (no cable plugged
in, cable is defect) or the PLC is switched off.
290030 This alarm is output after you selected screen which | Reload the record from the storage location or retain
contains a recipe view in which a record is already the current values.
selected.
290031 While saving, it was detected that a record with the Overwrite the record or cancel the action.
specified number already exists.
290032 While exporting records it was detected that a file Overwrite the file or cancel the process.
with the specified name already exists.
290033 Confirmation request before deleting records. --
290040 A record error with error code %1 that cannot be Check the storage location, the record, the "Data
described in more detail occurred. record" area pointer and if necessary, the connection
The action is canceled. to the PLC.
It is possible that the record was not installed Restart the action after a short time.
correctly on the PLC. If the error persists, contact Customer Support.
Forward the relevant error code to Customer Support.
290041 A record or file cannot be saved because the storage | Delete files no longer required.
location is full.
290042 An attempt was made to execute several recipe Trigger the action again after waiting a short period.
actions simultaneously. The last action was not
executed.
290043 Confirmation request before storing records. --
290044 The data store for the recipe has been destroyed and | --
is deleted.
290050 Alarm reporting that the export of records has started. | --
290051 Alarm reporting that the export of records was -
completed.
290052 Alarm reporting that the export of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
290053 Alarm reporting that the import of records has started. | --
290054 Alarm reporting that the import of records was -
completed.
290055 Alarm reporting that the import of records was Ensure that the structure of the records at the storage
canceled due to an error. location and the current recipe structure on the HMI
device are identical.
290056 Error when reading/writing the value in the specified | Check the specified line/column.
line/column.
The action was canceled.
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A.2 System alarms

Number

Effect/causes

Remedy

290057

The tags of the recipe specified were toggled from
"offline" to "online" mode.

Each change of a tag in this recipe is now
immediately downloaded to the PLC.

290058

The tags of the specified recipe were toggled from
"offline" to "online" mode.

Modifications to tags in this recipe are no longer
immediately transferred to the PLC but must be
transferred there explicitly by downloading a record.

290059

Alarm reporting that the specified record was saved.

290060

Alarm reporting that the specified record memory was
cleared.

290061

Alarm reporting that clearing of record memory was
canceled due to an error.

290062

The record number is above the maximum of 65536.
This record cannot be created.

Select another number.

290063

This occurs with the system function
"ExportDataRecords" when the parameter
"Overwrite" is set to No.

An attempt has been made to save a recipe under a
file name which already exists.

The export is canceled.

Check the "ExportDataRecords" system function.

290064

Alarm reporting that the deletion of records has
started.

290065

Alarm reporting that the deletion of records has
successfully completed.

290066

Confirmation request before deleting records.

290068

Security request to confirm if all records in the recipe
should be deleted.

290069

Security request to confirm if all records in the recipe
should be deleted.

290070

The record specified is not in the import file.

Check the source of the record number or record
name (constant or tag value).

290071

During the editing of record values, a value was
entered which exceeded the low limit of the recipe
tag.

The entry is discarded.

Enter a value within the limits of the recipe tag.

290072

When editing record values, a value was entered
which exceeds the high limit of the recipe tag.
The entry is discarded.

Enter a value within the limits of the recipe tag.

290073

An action (e.g. saving a record) failed due to an
unknown error.

The error corresponds to the status alarm
IDS_OUT_CMD_EXE_ERR in the large recipe view.

290074

While saving, it was detected that a record with the
specified number already exists but under another
name.

Overwrite the record, change the record number or
cancel the action.

290075

A record with this name already exists.
The record is not saved.

Please select a different record name.

290110

The default values could not be set due to an error.
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A.2 System alarms

Number Effect/causes Remedy
290111 The Recipes subsystem cannot be used. Recipe Transfer the project to the device again, together with
views have no content and recipe-specific functions | the recipes (the corresponding check box in the
will not be performed. Transfer dialog must be checked).
Possible causes:
¢ An error occurred while transferring the recipes.
e The recipe structure was changed in ES. When
the project was downloaded again, the recipes
were not transferred with it. This means that the
new configuration data is not being transferred to
the old recipes on the device.
Table A-31 300000 - Alarm_S alarms
Number Effect/causes Remedy
300000 Faulty configuration of process monitoring (e.g. using | Change the PLC configuration.
PDiag or S7-Graph): More alarms are queued than
specified in the specifications of the CPU. No further
ALARM_S alarms can be managed by the PLC and
reported to the HMI devices.
300001 ALARM_S is not registered on this PLC. Select a controller that supports the ALARM_S
service.
Table A-32 310000 - Report system alarms
Number Effect/causes Remedy
310000 An attempt is being made to print too many reports in | Wait until the previous active log was printed.
parallel. Repeat the print job if necessary.
Only one log file can be output to the printer at a
given time; the print job is therefore rejected.
310001 An error occurred on triggering the printer. The report | Evaluate the additional system alarms related to this
is either not printed or printed with errors. alarm.
Repeat the print job if necessary.
Table A-33 320000 - Alarms
Number Effect/causes Remedy
320000 The movements have already been indicated by Deselect the movements on the other display units
another device. and select the motion control screen on the required
The movements can no longer be controlled. display unit.
320001 The network is too complex. View the network in STL.
The faulty addresses cannot be indicated.
320002 No diagnosable alarm message (error) selected. Select a diagnostics alarm from the ZP_ALARM
The unit associated with the alarm message could alarm screen.
not be selected.
320003 No alarm message (error) exists for the selected unit. | Select the defective unit from the overview screen.
The detail view cannot visualize any networks.
320004 The required signal states could not be read by the Check the consistency between the configuration on
PLC. The faulty addresses cannot be found. the display unit and the PLC program.
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Appendix

A.2 System alarms

Number Effect/causes Remedy
320005 The project contains ProAgent elements which are In order to run the project, install the optional
not installed. ProAgent diagnostic functions cannot be | ProAgent package.
performed
320006 You have attempted to execute a function which is Check the type of the selected unit.
not supported in the current constellation.
320007 No error-triggering addresses were found on the Switch the detail screen to STL layout mode and
networks. check the status of the addresses and exclusion
ProAgent cannot indicate any faulty addresses. addresses.
320008 The diagnostic data stored in the configuration are Transfer the project to the HMI device again.
not synchronized with those in the PLC.
ProAgent can only indicate the diagnostic units.
320009 The diagnostic data stored in the configuration are Transfer the project to the HMI device again.
not synchronized with those in the PLC. The
diagnostic screens can be operated as usual.
ProAgent may be unable to show all diagnostic texts.
320010 The diagnostic data stored in the configuration are Transfer the project to the HMI device again.
not synchronized with those in STEP7.
The ProAgent diagnostics data is not up-to-date.
320011 A unit with the corresponding DB number and FB Check the parameters of the "SelectUnit" function
number does not exist. and the units selected in the project.
The function cannot be executed.
320012 The "Step sequence mode" dialog is no longer Use the ZP_STEP step sequence screen from the
supported. corresponding standard project for your project.
Instead of calling the
Overview_Step_Sequence_Mode function, call the
"FixedScreenSelection" function using ZP_STEP as
the screen name.
320014 The selected PLC cannot be evaluated for ProAgent. | Check the parameters of the
The Alarm view assigned to the "EvaluateAlarmDisplayFault" system function.
"EvaluateAlarmDisplayFault" system function could
not be found.
Table A-34 330000 - GUI alarms
Number Effect/causes Remedy
330022 Too many dialogs are open on the HMI device. Close all dialogs you do not require on the HMI
device.
330026 The password will expire after the number of days Enter a new password.
shown.
Table A-35 350000 - GUI alarms
Number Effect/causes Remedy
350000 PROFIsafe packages have not arrived within the Check the WLAN connection.

necessary period.
There is a communication problem with the F-CPU.

RT is terminated
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A.2 System alarms

Number Effect/causes Remedy

350001 PROFIsafe packages have not arrived within the Check the WLAN connection.
necessary period.

There is a communication problem with the F-CPU.
The PROFIsafe connection is re-established.

350002 An internal error has occurred. Internal error
Runtime is terminated

350003 Feedback concerning the connection established with | --
the F-CPU.

The Emergency-Off buttons are active immediately.

350004 PROFIsafe communication was set and the -

connection was cleared.

The Runtime can be terminated.

The Emergency-Off buttons are deactivated
immediately.

350005 Incorrect address configured for the F-slave. Check and modify the address of the F slave in
No PROFIsafe connection. WinCC flexible ES.

350006 The acknowledgement buttons in the Press the two acknowledgement buttons one after
"Acknowledgement" and "Panic" functions were not another in the "Acknowledgement" and "Panic"
tested before logging on. positions.

It is not possible to log onto the effective range.

350008 The wrong number of failsafe buttons was configured. | Change the number of failsafe buttons in the project.
No PROFIsafe connection.

350009 The device is in Override mode. Exit Override mode.

It may no longer be possible to detect the location
because transponder detection fails.
350010 Internal error: The device has no failsafe buttons. Send the device back.
Worldwide contact person
MP 377 (WinCC flexible)
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Abbreviations

ANS|
CPU
Csv
CTS
DC
DCD
DHCP
DIL
DNS
DP
DSN
DSR
DTR
EMC

PELV
PG
PLC
PPI

MP 377 (WIinCC flexible)

American National Standards Institution
Central Processing Unit

Comma Separated Values

Clear To Send

Direct Current

Data Carrier Detect

Dynamic Host Configuration Protocol
Dual-in-Line (electronic chip housing design)
Domain Name System

Distributed 1/O

Data Source Name

Data Set Ready

Data Terminal Ready

Electromagnetic Compatibility
European standard

Engineering System

Components and modules endangered by electrostatic discharge
Components and modules endangered by electrostatic discharge
Ground

High Frequency

Human Machine Interface

International Electronic Commission
Interface

Input and Output

Internet Protocol

Light Emitting Diode

Media Access Control

Metal Oxide Semiconductor

Multipoint Interface (SIMATIC S7)
Microsoft

Mean Time Between Failures

Not connected

Operator Panel

Personal Computer

Protective Extra Low Voltage
Programming device

Programmable Logic Controller
Point-to-Point Interface (SIMATIC S7)
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Abbreviations

RAM Random Access Memory

RJ45 Registered Jack Type 45

RTS Request to send

RxD Receive Data

SD Card Security Digital Card

SELV Safety Extra Low Voltage

SP Service Pack

STN Super Twisted Nematic

Sub-D Subminiature D (plug)

TAB Tabulator

TCP/IP Transmission Control Protocol/Internet Protocol
TFT Thin Film Transistor

TTY Teletype

TxD Transmit Data

UL Underwriter’'s Laboratory

UPS Uninterruptible power supply

USB Universal Serial Bus

WINS Windows Internet Naming Service

MP 377 (WIinCC flexible)
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Glossary

Acknowledge
Acknowledgment of an alarm confirms that it has been noted.

Alarm logging

Output of user-specific alarms to a printer, in parallel to their output to the HMI device
screen.

Alarm, acknowledging
Acknowledgment of an alarm confirms that it has been noted.

Alarm, activated
Moment at which an alarm is triggered by the PLC or HMI device.

Alarm, deactivated
Moment at which the initiation of an alarm is reset by the PLC.

Alarm, user-specific

A user-specific alarm designates a certain operating status of the plant connected to the HMI
device via the PLC.

Automation device
PLC of the SIMATIC S5 series, for example the AG S5-115U

Automation system
Controller of the SIMATIC S7 series, for example a SIMATIC S7-300

Bootloader

Used to start the operating system. Automatically started when the HMI device is switched
on. After the operating system has been loaded, the Loader opens.

MP 377 (WIinCC flexible)
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Glossary

Configuration software

Configuring PC

Display duration

EMC

Event

Field array

Flash memory

Function keys

Software used to generate projects used for the purpose of process visualization. An
example of configuring software is WinCC flexible.

A configuring PC is a programming device or PC on which plant projects are created using
an engineering software.

Defines whether a system alarm is displayed on the HMI device and the duration of the
display.

Electromagnetic compatibility is the ability of electrical equipment to function properly in its
electromagnetic environment without influencing this environment.

Functions are triggered by defined incoming events. Events can be configured. Events which
can be assigned to a button include "Press" and "Release", for example.

Area reserved in configured screens for the input and output of values.

Non-volatile memory with EEPROM chips, used as mobile storage medium or as memory
module installed permanently on the motherboard.

Key on the HMI device which supports user-specific functions. A function is assigned to the
key in the configuration. The assignment of the keys may be specific to an active screen or
not.

Half Brightness Life Time

Hardcopy

296

Time period after which the brightness reaches 50% of the original value. The specified
value is dependent on the operating temperature.

Output of the screen content to a printer.

MP 377 (WIinCC flexible)
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Glossary

HMI device

An HMI device is a device used for the operation and monitoring of machines and plants.
The statuses of the machine or plant are indicated by means of graphic elements or by
indicator lamps on the HMI device. The operating elements of the HMI device allow the
operator to interact with the processes of the machine or plant.

HMI device image

A file that can be transferred from the configuring PC to the HMI device. The HMI device
image contains the operating system and elements of the runtime software required to run a
project.

I/O field
An 1/O field enables the input or output of values on the HMI device which are transferred to
the PLC.
Infotext
An infotext is a configured information on objects within a project. Infotext for an alarm, for
example, may contain information on the cause of the fault and troubleshooting routines.
Object

An object is a component of a project. Example: screen or alarm. Objects are used to view or
enter texts and values on the HMI device.

Operating element

Component of a project used to enter values and trigger functions. A button, for example, is
an operating element.

Plant
General term referring to machines, processing centers, systems, plants and processes
which are operated and monitored on an HMI device.

PLC
A PLC is a general term for devices and systems with which the HMI device communicates,
e.g. SIMATIC S7.

PLC job

A PLC job triggers a function for the PLC at the HMI device.

MP 377 (WIinCC flexible)
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Glossary

Process visualization

Visualization of technical processes by means of text and graphic elements. Configured
plant screens allow operator intervention in active plant processes by means of the input and
output data.

Project

Result of a configuration using a configuration software. The project normally contains
several screens with embedded system-specific objects, basic settings and alarms. The
project file of a project configured in WinCC flexible is saved under the file name extension
*.hmi.

You need to distinguish between a project on the configuring PC and that on an HMI device.
A project may be available in more languages on the configuring PC than can be managed
on the HMI device. The project on the configuring PC can also be set up for different HMI
devices. Only the runtime project that has been generated for the respective HMI device can
be transferred to it.

Project file

File generated from the runtime project file for use on the HMI device. The project file is
normally not transferred and remains on the configuring PC.

The file name extension of a source file is *.hmi.

Project file, compressed

Compressed format of the project file. The compressed project file can be transferred
together with the runtime project file to the respective HMI device. For this purpose,
backtransfer must be enabled in the project on the configuring PC. The compressed project
file is normally stored on an external memory card.

The file extension of a compressed file is *.pdz.

Recipe

Combination of tags forming a fixed data structure. The data structure configured can be
assigned data on the HMI device and is then referred to as a record. The use of recipes
ensures that all the assigned data is transferred synchronously to the PLC during the
transfer of a record.

Runtime project file

File generated from the project file for a specific HMI device. The runtime project file is
transferred to the corresponding HMI device and used to operate and monitor plants.

The extension of a compressed file is *.pdz.

Runtime software

The runtime software is a process visualization software used to test a project on a
configuring PC.

MP 377 (WIinCC flexible)
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Glossary

Screen

Screen object

Form of the visualization of all logically related process data for a plant. The visualization of
the process data can be supported by graphic objects.

Configured object used to display or operate the plant, e.g. rectangle, I/O field or alarm view.

STEP 7
STEP 7 is the programming software for SIMATIC S7, SIMATIC C7 and SIMATIC WinAC
PLCs.

STEP 7 Micro/WIN

STEP 7 Micro/WIN is the programming software for SIMATIC S7-200 PLCs.

Symbolic 1/O field

System alarm

Tab sequence

Tag

Transfer

"Transfer" mode

A symbolic I/O field is a field for the input and output of the value. Contains a list of default
entries from which one can be selected.

A system alarm is assigned to the "System" alarm class. A system alarm refers to internal
states on the HMI device and the PLC.

During configuration, this defines the sequence in which objects are activated on pressing
the <TAB> key.

Defined memory location to which values can be written to and read from. This can be done
from the PLC or the HMI device. Based on whether the tag is interconnected with the PLC or
not, we distinguish between "external" tags (process tags) and "internal" tags.

Transfer of a runtime project from the configuring PC to the HMI device.

An operating mode of the HMI device in which an executable project is transferred from the
configuring PC to an HMI device.

MP 377 (WIinCC flexible)
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/
/Audit, 29

A

Accessory kit, 24

ACK, 213

ACK key, 178

Acknowledge
Alarm, 178, 217
Error alarm, 217

Acknowledge key, 178

Acoustic feedback, 167

Acoustic signal, 172
For inadvertent operation, 167
with inadvertent operation, 83

Acoustics
Feedback, 105, 106

Address assignment
TCP/IP network, 126

Addressing, 123

Admin, 207, 208, 209

Alarm, 211
Acknowledge, 178, 217
Editing, 218
Functional scope, 26
LED, 214

Alarm buffer, 212
Functional scope, 26

Alarm class, 212, 215

Alarm event, 211

Alarm group, 212

Alarm indicator, 213

Alarm line, 214

Alarm log, 212

Alarm report, 212

Alarm view, 214
Expanded, 215
Simple, 214

Alarm window, 216

ALARM_S, 26

Alphanumerical

MP 377 (WIinCC flexible)
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Key assignment, 89, 178
Screen keyboard, 173
Alphanumerical value
Changing, 174, 182
Entering, 174, 182
ALT key, 89,178
Ambient conditions
Climatic, 40
Mechanical, 39
Test, 40
Ambient temperature, 41
Authorization, 199
Automatic
Transfer, 144
Automation License Manager, 163
A-Z key, 89,178

B

Backlighting
Reducing, 102
Setting, 83
Backspace key, 88, 178
Backtransfer, 142, 146
Backup, 82, 135, 141, 148, 149, 151, 200
Registry Information, 83, 100
Temporary files, 100
to external storage device, 82, 133
With ProSave, 151
With WinCC flexible, 149
Bar, 185
Basic knowledge
Required, 3
Booting, 107
Bottom view, 16, 18, 20, 22
Brightness
Changing, 102
Browser
Home page, 82
Setting, 82
Bus connection, 30
Bus parameters
Profile, 122
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C

Cable
Connecting, 50
Data exchange, 64
Cable cross-section, 54
Equipotential bonding, 52
Calibrating
Touch screen, 83, 94
Cancel
Password protection, 97
Cancel key, 88, 178
Care, 247
CE approval, 34
Certificate
Delete, 82, 132
Importing, 82, 132
LED, 82
Certifications, 34
Changing
Brightness, 102
User data, 207, 208
Character repeat, 82
Screen keyboard, 91
Clean screen, 248
Clearance
MP 377, 43
Climatic
Shipping conditions, 38
Storage conditions, 38
Closing
Project, 209
Column sequence
Alarm view, 215
Compatibility conflict, 148
Configuration phase, 139
Configure
Network, 124
Operating system, 75
PC/PPI cable, 61
RS-422/RS-485 port, 59
Screen keyboard, 82, 90
Configuring PC, 139
Connecting, 60
Connection graphic, 60
Connecting
Configuring PC, 60
Equipotential bonding, 52
PLC, 57
Plug-in terminal strip, 55
Power supply, 54, 55
Printer, 63
PROFINET, 58

302

UPS, 56
USB device, 62
Connection, 30
Connection graphic
Configuring PC, 60
Equipotential bonding, 53
PLC, 57
Power supply, 54
Printer, 63
UPS, 56
Connection sequence, 50
Connections to PLC
Number, 30
Contacts, 6
Control key, 68
Keyboard unit, 88
Control Panel, 81
MPI, 121
Open, 82
Operating, 84, 86
Password protection, [77
PROFIBUS, 121
Screen keyboard, 85
Cookies, 82, 130
Creating
Recipe data record, 229, 238
Users, 205
C-Tick mark (Australia), 35
CTRL key, 89,178
Currency, 83
Cursor key, 68, 88, 177

D

Data channel

Enabling, 117

Locking, 117

Parameter assignment, 83, 117
Data flow, 223

Date, 82
Entering, 175, 183
Setting, 97

Synchronizing, 99
Date format, 83, 100
Date/time properties, 82, 98
Decimal, 171
Default gateway, 126
Degree of protection, 42
Protection against ingress of solid foreign
bodies, 44
Protection against water, 44
Delay time
Setting, 83, 112

MP 377 (WIinCC flexible)
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Delete
Certificate, 82, 132
Recipe data record, 232, 240
Users, 209
Delete key, 88,178
Device name
For network operation, 125
Setting, 83
DHCP, 126
DIP switch
Setting, 59
Direct key, 168
Bit assignment, 257
Functional scope, 28
Display
MP 377, 255
Display format, 181
Displaying
Infotext, 179
Memory information, 111
System information, 110
Disposal, [7
Disturbance
Pulse-shaped, 36
Sinusoidal, 37
DNS, 126
Server, 123
Documentation
Conventions, 5
Enclosed, 45
Getting Started, 5
Operating instructions, 4
User manual, 3
Double-click, 82
Setting, 93
Drop down list box, 175, 183
Open, 88, 178

E

EC Declaration of Conformity, 34
Editing
Alarm, 218
Recipe data record, 231, 239
Elbow adapter, 24
Electrical potential difference, 52
Electrical separation
Safe, 55
Electrostatic charging, 261
Electrostatic discharge
Electrostatic, 261
Precautions, 262

MP 377 (WIinCC flexible)
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Element list, 225, 236
E-Mail
Setting, 83, 128
EMC directive, 34
Emission, 36, 37
Encryption, 130
END key, 88, 177
Enhanced alarm view, 215
Enhanced recipe view, 224
Enhanced user view, 201
Enter key, 177
ENTER key, 88, 177
Entering
Alphanumerical value, 174, 182
Date, 175, 183
Key combination, 89, 178
Numerical value, 172, 181
Recipe data record, 244
Symbolic value, 175
Text box, 170
Time, 175, 183
Entry on the HMI device
By means of function key, 180
Using operating elements, 165
Equipotential bonding
Cable, 52
Connecting, 52
Connection graphic, 53
Requirements, 52
Error alarm
Acknowledge, 217
ESC key, 88,178
ESD
Abbreviations, 261
Labeling, 261
Ethernet settings
IP address, 126
Excel Viewer, 29
Explorer
Operating, 77
Exporting
Recipe data record, 243
External
Keyboard, 84
Mouse, 84

F

Factory setting

With ProSave, 158

With WinCC flexible, 156
Factory settings, 62
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Feedback
Acoustic, 105, 106, 167
Optical, 167

FM Approval, 35
FN key, 89, 178
Front view, 16, 18, 20, 22
Function keys, 68
Global assignment, 180
Labeling, 72
Local assignment, 180
Function test, 66
Functional scope
Alarm buffer, 26
ALARM_S, 26
Alarms, 26
Graphics list, 26
Infotext, 28
Limit value monitoring, 26
Log, 27
Recipe, 27
Safety, 28
Scaling, 26
screen, 27
Tag, 26
Text list, 26
Functions
Additional, 28

G

Gauge, 185
Graphics list

Functional scope, 26
Group acknowledgement, 178

H

High frequency radiation, 33
HMI device
Cold restart, 107
EMC-compliant installation, 36
Information, 83
Mounting, 49
Ports, 51
Restarting, 83
Specifications, 255
Switch off, 66
Switching on, 65
Testing, 65
HMI Input Panel
Options, 90
HOME key, 88, 177
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Home page
Internet, 129
Host cable
Safety instruction, 62

Identification, 127
Importing
Certificate, 82, 132
Recipe data record, 242
Inadvertent operation
Acoustic signal, 83, 167
Information
for the HMI device, 109
Infotext
Displaying, 179
Functional scope, 28
Key, 179
LED, 176, 184, 216
Initial startup, 139
Input Panel, 82
Input unit
MP 377, 255
Installing
Option, 142, 160, 162
Instructions
General, 36
Insulation test
Test voltage, 44
Interface
Rated load, 62
Internal clock, 99
Internet
Browser, 78
Explorer, 78
Home page, 129
Options, 82
Search engine, 129
Security settings, 82
Service, 249
Settings, 83, 128
Support, 249
Internet options
Privacy, 131
IP address
Ethernet, 126
Setting, 82
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Key
ACK, 178
ALT, 89,178
A-Z, 89,178
Backspace, 178
Cancel, 88
CTRL, 89,178
Cursor, 88, 177
Delete, 88,178
END, 88, 177
ENTER, 88, 177
ESC, 88,178
FN, 89, 178
HOME, 88, 177
Infotext, 179
Scroll back, 88, 177
Scroll forward, 88, 177
SHIFT, 89, 178
TAB, 88, 177
Tabulator, 88
Key combination
Entering, 89, 178
Key control, 177, 180
Trend view, 189
Keyboard
External, 84
Safety instruction, 68
Keyboard properties, 82

L

Labeling
Certifications, 34
EC Declaration of Conformity, 34
Function keys, 72
Labeling strips
Attaching, 73
Dimensions, 72
Printing, 72
LAN connection, 82
Language change
Functional scope, 28
Layout
Slider control, 189
Sm@rtClient view, 195
Trend view, 187
LED
Alarm, 214
Certificate, 82
HMI device information, 83
Information on the MP 377, 109

MP 377 (WIinCC flexible)
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Infotext, 176, 184, 216
Memory information, 110
System information, 110
LED ACK, 213
License key, 163
Transferring, 142, 163
Transferring back, 142, 164
Limit value
For password, 200
For user, 200
For user view, 200
Limit value monitoring
Functional scope, 26
Limit value test, 171|, 181
List of abbreviations, 293
Loader, [75
Open, 76
Operating, 76
Log
Functional scope, 27
Logoff
Users, 203
Logoff time, 199
Logon
Users, 201
Logon data, 127

M

MAC address, 116
Maintenance, 247, 249
Manual
Production sequence, 245
Transfer, 143
Mechanical
Shipping conditions, 38
Storage conditions, 38
Media Player, 79
Memory
MP 377, 255
Memory card, 24
Backup, 70
First use, 133
Inserting, 69
Restoring file system, 100
Unplug, 71
Memory information, 83
Displaying, 111
LED, 110
Memory management, 83, 137
Menu command
Simple recipe view, 237
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Microsoft Excel Viewer, 29
Microsoft PDF Viewer, 29
Microsoft Word Viewer, 29
Monitoring mode
Sm@rtClient view, 195
Mounting, 41
EMC-compliant, 36
HMI device, 49
Mounting clamp, 48
Mounting clamp
Mounting, 47, 48
Mounting cut-out
Dimensions, 42
Preparing, 42
Mounting location, 42
Mounting position, 41
Mouse
External, 84
Mouse properties, 82
MP 377
Clearance, 43
Display, 255

Displaying information, 109

Input unit, 255
Memory, 255
Operating element, 67
Ports, 51, 255
Weight, 255
MP 377 12" Key
Bottom view, 18
Front view, 18
Overall dimensions, 252
Rear view, 19
Side view, 18
MP 377 12" Touch
Bottom view, 16
Front view, 16
Overall dimensions, 251
Rear view, 17
Side view, 16
MP 377 15" Touch
Bottom view, 20
Front view, 20
Overall dimensions, 253
Rear view, 21
Side view, 20
MP 377 19" Touch
Bottom view, 22
Front view, 22
Overall dimensions, 254
Rear view, 23
Side view, 22
MPI

306

Setting, 83, 121
Multi-key operation, 166, 179
Multimedia card, 69

N

Name server, 126
Network
Configure, 124
Logon data, 83
Set up, 123
Setting, 126
Network & dial-up connections, 82
Network ID, 83
Network operation
Device name, 125
Options, 83
Nominal voltage, 44
Non-isolated system configuration, 55
Notice of protected rights, 6
Number format, 83, 100
Numerical
Key assignment, 89, 178
Screen keyboard, 171
Numerical value
Changing, 172, 181
Decimal places, 171
Display format, 181
Entering, 172, 181
Limit value test, 171, 181

O

Offices of Siemens AG, 6
Offline
Operating mode, 140
Recipe tag, 228
Test, 147
Online
Operating mode, 140
Recipe tag, 228
Test, 147
OP properties, 83
Device, 109
Memory monitoring, 138
Persistent storage, 101
Touch, 94
OPC server, 29
Open
Control Panel, 82
Drop down list box, 88, 178
Loader, 76
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Operating
Control Panel, 84, 86
Explorer, 77
Feedback, 166
Key, 177, 180
Loader, 76
Operating element, 88, 177
Project, 165
Recipe screen, 229, 238
Slider control, 190
Switches, 186
Trend view, 188
Windows CE interface, [77
With external keyboard, 166
With external mouse, 166
Operating element
Operating, 88, 177
Recipe view, 229
Selecting, 88
Simple recipe view, 236
Operating instructions
Purpose of, 3
Scope, 3
Operating mode, 140
Changing, 140
Offline, 140
Online, 140
Transfer, 65, 140
Operating system
Configure, 75
Update via ProSave, 155
Updating, 153
Updating using WinCC flexible, 154
Operation feedback, 166
Setting, 83
Operator control options, 84
Optical feedback, 167
Option
Installing, 142, 160
Installing with ProSave, 162
Installing with WinCC flexible, 160
Removing, 142, 160
Removing with ProSave, 162
Removing with WinCC flexible, 161
Options, 29
Network operation, 83
Overall dimensions
MP 377 12" Key, 252
MP 377 12" Touch, 251
MP 377 15" Touch, 253
MP 377 19" Touch, 254

MP 377 (WIinCC flexible)
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Parameter assignment
Data channel, 83, 117
Password, 199
Backup, 200
Restoring, 200
Specifying, 96
Password list, 199
Password properties, 83, 96, 97
Password protection, 77, 83
Cancel, 97
Set up, 96
Windows CE taskbar, 77
PC/PPI
Configuring the cable, 61
Setting the adapter, 61
PDF Viewer, 29
PELV, 55
Permissions in remote control, 196, 198
Pin assignment
Power supply, 258
RJ45 plug connector, 259
USB socket, 259
X10/IF-1B interface, 258
X40 connector, 260
PLC
Configuring the port, 59
Connecting, 57
Connection graphic, 57
Number of connectable, 30
Protocol, 30
Reading recipe data record, 234, 240

Transferring recipe data record, 235, 241

PLC_User, 207, 208, 209
Plug-in terminal strip
Connecting, 55
Ports
MP 377, 255
Power failure, 148
Power supply
Connecting, 54, 55
Connection graphic, 54
Pin assignment, 258
Setting, 83
State, 83
Precautions
Electrostatic discharge, 262
Printer
Connecting, 63
Connection graphic, 63
Setting properties, 83
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Printer connection Recipe, 220
Setting, 104 Control, 221
Printer properties, 83, 104 Data flow, 223
Printing Data record, 221
Labeling strips, 72 Field of application, 219
Via network printer, 124 Functional scope, 27
ProAgent, 29 Recipe screen, 224
Process control phase, 139 Recipe view, 224
Production sequence Synchronizing tags, 233
Manual, 245 Recipe data record
PROFIBUS DP Creating, 229, 238
Setting, 83, 121 Delete, 232, 240
PROFINET, 123 Editing, 231, 239
Addressing, 123 Entering, 244
Connecting, 58 Exporting, 243
PROFINET IO Importing, 242
Communication fault, 30 Reading from PLC, 234, 240
Direct keys, 58 Synchronize with PLC, 231
Disabling direct keys, 116 Transferring to PLC, 235, 241
Enabling direct keys, 116 Recipe list, 225, 236
Setting, 83 Recipe screen, 226
Project Operating, 229, 238
Closing, 209 Overview, 226
in ProTool, 141 Recipe tag
In WinCC flexible, 141 Offline, 228
Offline testing, 147 Online, 228
Operating, 165 Synchronizing, 227, 233
Reuse, 141 Recipe view, 224
Testing online, 147 Expanded, 224
Transferring, 139, 142 Operating element, 229
Proper use, 33 Simple, 225
Protected trademark, 6 Recommissioning, 139
Protection class, 44 Record list, 225, 236
Protective foil, 24, 248 Recycling, 7
Protocol Regional and language settings, 83, 99
PLC, 30 Regional settings, 100
Proxy Registered trademark, 6
Server, 82, 128, 130 Registry Information
Setting, 82 Backup, 83, 100
Regulations for the prevention of accidents, 33
R Remote control
Forcing permission, 196, 198
Radiation Start, 196, 197
High frequency, 33 Removing
Radio interference, 36 Option, 142, 160, 161, 162
Emission, 37 Repairs, 249
Rated load Reset to factory setting, 141
Interface, 62 Restore, 82, 133
Reading out Restoring, 141, 148, 150, 152, 200
Recipe data record, 234, 240 from external storage device, 82, 135
Real-time clock From memory card, 100
Internal, 99 With ProSave, 152
Rear view, 17, 19, 21|, 23 With WinCC flexible, 150

MP 377 (WIinCC flexible)
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Restoring factory settings, 62
Return Center, 249
Reverse polarity protection, 55
RJ45 plug connector
Pin assignment, 259
RS 422-RS 232 converter, 24
RS-422/RS-485 port
Configure, 59
Ruler
Trend view, 188

S

S7 transfer settings, 83

Safe electrical separation, 55

Safety
Functional scope, 28
Standards, 34

Safety instruction
Backlighting, 103
Changed tag name, 233
Cold restart, 107
Compeatibility conflict, 148
Compressed project file, 143
Connection sequence, 50
Data channel, 154
Data loss, 133, 153
Device name, 116
Direct key, 168
Electrostatic charging, 261
Equipotential bonding conductor, 52
Functional problem, 62
High frequency radiation, 33
Keyboard, 68
License key, 153, 160
Loss of data possible, 135
Memory card, 71
Memory distribution, 110
Multi-key operation, 166
Observe grounding measures, 262
Path, 112, 113
Power failure, 148
Preventing inadvertent operation, 247, 248
Project file, 112, 113
Recipe data record in background, 225
Remote control for channel 1, 118
Storage, 38
Switching infotext, 176, 184
Time-dependent reactions, 99
Touch screen, 67
Transfer mode, 120
Transfer mode channel 2, 118

MP 377 (WIinCC flexible)

Transport, 38
unauthorized cleaning products, 247
Unintentional action, 67, 68, 179
Unintentional response, 247, 248
Unintentional transfer mode, 118
USB connection sequence, 62
USB Host-to-Host cable, 62
USB port, 62
Working on the control cabinet, 33
Safety regulations, 33
Scaling
Functional scope, 26
screen
Functional scope, 27
Screen keyboard, 82, 169
Alphanumerical, 173
Change layout, 86
Character repeat, 91
Configure, 90
For Control Panel, 85
Keyboard level, 173
Language change, 173
Numerical, 171
Representation types, 85
Screen saver, 83, 103
Setting, 102
Screen settings
Changing, 83
Scroll back key, 88, 177
Scroll forward key, 88, 177
Search engine
Internet, 129
Security settings, 82
Security system, 199
Selecting
Operating element, 88
Service
On the Internet, 249
Service pack, 249
Set up
Network, 123
Password protection, 96
Setting
Backlighting, 83
Browser, 82
Date, 97
Date format, 100
Date/Time, 82
Delay time, 83, 112
Device name, 83
DIP switch, 59
Double-click, 93
E-Mail, 83
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E-mail connection, 128
IP address, 82
Language, 169
MPI, 83, 121
Name server, 82
Network, 126
Number format, 100
Operation feedback, 83
PC/PPI adapter, 61
Power supply, 83
Printer connection, 104
Printer properties, 83
PROFIBUS, 121
PROFIBUS DP, 83
PROFINET IO, 83
Proxy, 82
Regional data, 100
Screen saver, 102
Sound, 106
Storage location, 111
Time, 97
Time format, 100
UPS, 113
Setting language, 169
Settings
Internet, 83
Language, 83
Regional, 83
S7-Transfer, 83
Shift key, 89
SHIFT key, 89,178
Shipping conditions, 38
Side view, (16, 18, 20, 22
Siemens HMI input panel options, 82
Siemens offices, 6
Simple alarm view, 214
Simple recipe view, 225
Menu command, 237
Operating element, 236
Simple user view, 201
Slider control, 189
Sm@rtAccess, 29
Sm@rtClient view, 195, 196
Monitoring mode, 195
Usage, 195
Sm@rtService, 29
SMTP server, 128
Software options, 29
Sort order
Alarm view, 215
Sound
Setting, 83, 106
Setting event, 106
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Specifications
Display, 255
Input unit, 255
Memory, 255
MP 377, 255
Ports, 255
Power supply, 258
RJ45 port, 259
Supply voltage, 256
X10/IF-1B interface, 258
X40 port, 260
Start
HMI device, 83, 107
Status Force, 191
Key control, 193
Touch operation, 192
Storage conditions, 38
storage device
Restoring from external, 135
Storage device
Saving to external, 133
Storage location
Setting, 111
Subnet mask, 126
Supply voltage
MP 377, 256
Support
Hotline, 7
On the Internet, 7, 249
Switch off
HMI device, 66
Switches, 186
Switching cabinet
Working on, 33
Switching on
MP 377, 65
Symbolic value
Changing, 175
Entering, 175
Synchronizing
Date and time, 99
Recipe tag, 227, 233
System alarm
Meaning, 263
Parameters, 263
System configuration
Non-insolated, 55
System information, 83
Displaying, 110
LED, 110
System key, 68
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System properties, 83
Device name, 125
General, 110
Memory, 111

T

TAB key, 88, 177
Tabulator key, 88, 177
Tag
Functional scope, 26
Task planner
Functional scope, 28
Taskbar, 76
TCP/IP address, 126
Technical support, 7
Temporary files
Backup, 100
Test
For ambient conditions, 40
Testing
MP 377, 65
Text box, 170
Character mode, 177
Normal mode, 177
Text list
Functional scope, 26
Time, 82
Entering, 175, 183
Setting, 97
Synchronizing, 99
Time format, 83, 100
Time zone
Setting, 97
Time-dependent reactions, 99
Touch operation
Trend view, 189
Touch screen
Calibrating, 83, 94
Safety instruction, 67
Trademark, 6
Training center, 6
Transfer, 139, 140, 142
Automatic, 144
Cancel, 65
Manual, 143
Transfer mode
Unintentional, 118
Via MPI, 120
Via PROFIBUS DP, 120
Transfer settings, 83, 117
Channel, 118

MP 377 (WIinCC flexible)
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Directories, 111|, 112
Transferring

License key, 142, 163

Project, 139, 142

Recipe data record, 235, 241

Transferring back
License key, 142, 164
Transport damage, 45
Trend view, 187
Key control, 189
Touch operation, 189
Trends
Functional scope, 28
Limit violation, 187

U
UL approval, 34

Unintentional action, 67, 68, 166
Unintentional transfer mode, 118

Updating
About ProSave, 155
Operating system, 153

using WinCC flexible, 154
Updating the operating system, 141

UPS
Connecting, 56

Connection graphic, 56

Setting, 113
UPS properties
Configuration, 114
Current status, 115
Usage
Conditions, 39
In industry, 36
In residential areas, 36

With additional measures, 39

USB

Connection sequence, 62
USB connection sequence

Safety instruction, 62
USB device

Connecting, 62
USB FlashDrive, 24
USB memory stick, 24
USB socket

Pin assignment, 259
User data

Backup, 200

Changing, 207, 208

Restoring, 200
User group, 199
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User manual, 3

User name, 127

User view, 200
Expanded, 201
Simple, 201

Users, 199
Admin, 207, 208, 209
Changing, 203
Creating, key control, 205
Delete, 209
Logoff, 203
Logon, 201
PLC_User, 207, 208, 209

\Y

Value table
Trend view, 188
VBScript
Functional scope, 28
Volume, 105
Setting, 83
Volume & Sounds Properties, 83

w

Weight
MP 377, 255

WinCC flexible internet settings
E-mail, 128
E-Mail, 83

Windows CE interface
Operating, 77

Windows CE taskbar, 76
Password protection, 77

WINS, 126
Server, 123

Word Viewer, 29

Working on the control cabinet, 33

X

X10/IF-1B interface

Pin assignment, 258
X40 connector

Pin assignment, 260
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